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Chapter 1 
Introduction 

 
Welcome to Spartan Dairy 3 
Spartan Dairy 3 is a tool to help you design and evaluate diets for dairy cattle. You can use the 
program to formulate new rations based on available feeds to meet the nutritional guidelines for a 
group of animals. You can also evaluate rations after they have been fed to help understand why 
performance goals were or were not met. You can compare rations options to see which feeds can 
help lower feed costs or nutrient excretion. Finally, you can use the program to design custom feed 
premixes to prepare yourself, order from a feed mill, or send out for bid. 
 
The program has been designed for use by dairy farmers, nutritional consultants, extension agents, 
and university researchers. Spartan Dairy 3 can also be a valuable tool for teaching dairy nutrition, 
and special features are included to enhance its use in teaching nutrition concepts. 
 
Spartan Dairy 3 is a 32-bit Windows application designed for computers running the Microsoft 
(MS) Windows 2000, XP, Vista, and Windows 7 operating systems. Since the program follows 
Windows XP and Vista user interface guidelines, it operates like many other Windows applications 
you already use. 
 
The program includes sample ration files for lactating cows, dry cows, and heifers. It also includes a 
master feed library with book values for over 140 feeds. Data for each ration and feed library is 
stored in a separate Microsoft Access data file. You can work with multiple feed libraries and 
rations at the same time. Multiple instances of the program also can be run simultaneously. 
 
The nutritional model used in Spartan Dairy 3 is based on the National Research Council's 2001 
Nutrient Requirements of Dairy Cattle (hereafter NRC 01) but includes modifications, which are 
explained in this help system in the section on the Nutritional Model. 
 
What is a Dairy Cattle Ration? 
A dairy cattle ration is a set of feedstuffs, each included at a specific amount, to be fed to a group of 
dairy cattle to meet a set of production goals. Planning a ration involves four main steps.  

1. Describe a target animal that best characterizes the nutritional needs of the group. This 
description includes information such as breed, age, developmental stage, weight, daily 
weight gain/loss targets, pregnancy status, production targets, and environmental parameters 
such as activity level and temperature stress. The program uses these inputs to define the 
target animal's feed intake and estimate its requirements for fiber, energy, protein, minerals, 
vitamins, and amino acids.  

 
2. Add feeds from an existing library or ration that will be used to construct the ration. The 

program supports several methods for adding feeds to a ration including selecting them 
using a dialog, copying and pasting feeds directly from another library or ration, and even 
importing them from an Excel file.  

 
3. Adjust the amounts of each feed to meet the nutritional requirements without exceeding the 

predicted feed intake. Insufficient nutrients will limit daily gain or milk production. Excess 
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nutrients will reduce the efficiency and profitability of your dairy operation. Overfeeding 
some feeds, such as fiber or lipid, will reduce the animal's feed intake. This can make it 
more difficult to meet nutritional requirements. Overfeeding other feeds, such as minerals 
and vitamins, can lead to toxicity problems that impact an animal's health. 
 
When the supply of a nutrient in the ration exactly matches the requirement for that nutrient, 
the ration is balanced for that nutrient. In Spartan Dairy 3 ration balancing can be 
accomplished by manually adjusting the as fed or dry matter amounts for specific feeds, or 
the program's optimization features to automatically balance the ration.  

 
4. Customize and print reports used to mix the ration, order custom premixes from a feed mill, 

or archive a summary of the feed management plan. 
 
What is New in Spartan Dairy 3? 
Spartan Dairy 3 is based on the NRC 2001 model and includes improvements to it.  For the energy 
and protein systems, you can use the NRC 2001 model, the Spartan 3 model, or even fixed values 
that are based on NRC 1989.  The differences in the Spartan 3 and NRC 2001 models are briefly 
discussed in Chapter 12, The Nutritional Model.   
 
Spartan 3 Updates and Future Development 
Future updates designed to fix problems in the program are ongoing and will be provided free, at 
least through 2011.  Updates after 2012 may require a fee.  At present, the program does not include 
a automatic ration optimizer.  Although we have developed a new optimizer that works well in MS 
Excel to balance available feeds to meet nutrient constraints, including minimizing P and N waste, 
and to give an estimate of the relative financial value of feeds, it has not been coded into the 
program yet.  We plan to code it in 2011 and 2012, but we make no guarantee about this; once 
developed, it will increase the price by 20 to 40%.   
 
Authors and Acknowledgements 
Spartan Ration Evaluator/Balancer for Dairy Cattle version 3.0 authors are: 

• Michael J. VandeHaar, PhD 
• Robert D. Kriegel, MS 
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The program is a product of the Dairy Nutrition group in the Department of Animal Science at 
Michigan State University. This program would not have been possible without support from the 
Department of Animal Science and from Michigan's Animal Agriculture Initiative. 
 
Copyright Information 
The Spartan Ration Evaluator/Balancer for Dairy Cattle program is Copyright © 2010 Michigan 
State University Board of Trustees. All Rights Reserved. 
 



Spartan Dairy Help Manual Michigan State University Page 4 

About This Document 
Using the Help System describes how to use the help system viewer to browse and print help topics, 
and how to search for information in the help system. 
Getting Started describes how to install the program onto your computer, how to register the 
product, and where to find product support. 
Guided Tour provides an overview of the program's user interface including major visual 
components, support for multiple measurement systems, sample files included with the program, 
and keyboard shortcuts. 
Working with Feeds explains program commands for working with feeds and feed mixes. These are 
accessed using the Feeds submenu. 
Feed Characteristics describes each of the 120 feed characteristic columns used to describe nutrient 
composition, cost and other feed characteristics. 
Feed Libraries explains program features for organizing collections of feedstuffs into libraries for 
use in multiple rations. 
Describing a Target Animal explains how to use features in the Animals submenu to characterize 
the animals you are feeding a ration to. The nutritional requirements for a ration are dependent on 
the type of animal you are feeding and the production goals for the group. 
Working with Rations explains program features for planning and analyzing rations, including all 
commands in the Ration submenu. 
Reports describes how to configure and print the program's Mix, Batch, Summary, and Office 
reports. 
User Settings explains how to customize program settings using dialogs accessed from the Settings 
submenu. 
Nutritional Model explains some of the major differences between Spartan Dairy 3 and the NRC 
2001 guidelines.  More information on the underlying nutritional model in the program can be 
found on our website. 
What is the Transcript Window? explains how to use the program's Transcript Window to obtain an 
audit trail of variable values and equations used throughout the program.  Further information on 
equation syntax and variable naming conventions used in the program can be found on the web site. 
Configuring the Program for Your Needs explains how to customize the program for use on your 
farm, for managing multiple farms, for use in feed mills, and for use in the classroom as a teaching 
tool. 
Troubleshooting explains some of the problems that may occur and how to deal with them. 
Tutorials provide step by step instructions on how to use the program to perform common tasks, 
such as creating a ration or feed library from scratch.  All tutorials are on the website rather than in 
this manual.   
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Chapter 2 
Using the Help System 

 
Due to budget constraints, this first version of Spartan Dairy 3 does not have a fully operating 
integrated Help System.  Rather the Help System exists as a PDF document that you access from 
the menu.  Additional details of the Help System can be accessed and downloaded from our 
website: www.spartandairy.msu.edu.   
 
The Help manual is arranged in chapters.  At the beginning of each chapter, you will find a list of 
the topics within that chapter, arranged in order of appearance.  If you experience problems or have 
questions that are not addressed in the Help manual, please consult our website.  We will 
occasionally update the website as problems or questions arise.   
 
Screenshots in this Help Manual were sometimes generated using Windows XP as the platform and 
sometimes using Windows Vista.  Thus, you will note differences in colors.  The content is 
independent of the platform.   All screenshots for the Help Manual were with Test Versions of the 
program, so they often say “Not for commercial use”.  Please ignore this.   
 
Typographical Conventions  
Most help system content is displayed using the font Verdana. However, equations and other 
Transcript excerpts are displayed in Courier New font to distinguish them from other text. User 
actions such as a commands and keyboard shortcuts are displayed in bold. The names of program 
dialogs and other user interface elements in the help system use the same capitalization as displayed 
in the program. 
 
When presenting a command in the program’s user interface, the symbol > is used to denote a 
hierarchical menu submenu relationship. For instance, the command in the Feeds submenu to copy 
a Feed or Feeds to the Windows clipboard is presented in text as Feeds > Copy. In the program this 
menu appears as follows: 
 
Similarly, the symbol | is used to separate commands in a sequence of multiple commands. For 
instance, the command sequence using the Transcript Window's Edit submenu to select all text and 
then delete it is Select All | Delete. Notice in the figure of this submenu shown below that Select 
All and Delete are separate commands to be performed in sequence. 
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Chapter 3 
Getting Started 

Installing and Running the Program 
 
System Requirements  
Spartan Dairy 3 can work with most computers that run Windows.  It runs best in Windows XP or 
later.  As of April, 2010, the program works well in Windows 7 (64-bit), Vista, and XP.   
 
Installing the Program 
Install works pretty much like any Windows Installation.  Just follow the instructions as they 
appear.  Before installing, always remove (uninstall) previous versions of Spartan 3 first.   
 
 Accepting the EULA (End User License Agreement): You must read this and click okay 

before the program will install.  Please remember that this is a test version of the program.  Be 
especially wary of any diets and check them thoroughly before feeding to a cow!  As with any 
computer program, make sure the diets seem reasonable before feeding them.     

 
 Setting Where Files are Stored: By default, the program will be stored in the Program Files 

folder and your work files will be stored in the My Documents folder.   
 
Registering the Product 
Upon purchasing the program, you will be given a serial number.  We encourage you to keep this 
number available.  You will need it if you want product support.  Any unauthorized use of the 
program will void any contractual obligation on the part of Michigan State University to provide 
customer support to you.   
 
 
Running Spartan Dairy 3 
Just look for the little green Spartan S to start the program. 
 
Product Support 
For questions regarding the program, consult our website: www.spartandairy.msu.edu or email 
us at spdairy@msu.edu.  Whenever you have questions or contact us, please have your product 
serial number handy.  The serial number entitles you to 2 hours of free support.  We make no 
guarantees of free support in subsequent years.   
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Chapter 4 
A Guided Tour 

This chapter includes: 
• Launching the Program 
• Application Window 
• Spartan Dairy Data Files 
• Feed Library Window 
• Ration Window 

• Using the Worksheet 
• Measurement Systems 
• User Input Controls 
• Sample Files 
• Keyboard Shortcuts 

 
Launching the Program 
Start Spartan Dairy 3 like any other Windows 
program—just look for the green Spartan S.  
 
 
Application Window    
 Main Menu 

Once you open the program, you will first see the 
main application window.  The main menu has 
only four choices: File, View, Window, and Help.  

     
   
 
 
  Arranging Child Windows 

A child window is any window that can be opened 
from the main application.  You can move these 
windows and resize them as with any MS Windows 
program.    

 
Application Toolbar 
The application toolbar   has two options.  These can be used to create or open a ration file. 
 Status Bar   

The status bar is at bottom of the Spartan window – if you move the mouse over a button, 
clickable object, or other field, the status bar provides information related to the mouse location.  
The status bar also tells you what the program is doing at the moment and what basis the 
program is currently working.  In the screenshot below, the mouse was over the “kg” status 
button.  Note the status bar tells you what it does.   
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Spartan Dairy Data Files  
There are two types of Spartan data files: feed libraries and rations.  To open an existing ration file, 
choose the File > Open  > Ration command, use the Open Ration button, or type Ctrl+O.  This will 
take you to a browsing window, similar to that of most Windows programs.  The look of this dialog 
will depend on which Windows platform you 
are using.   
 
 
 
In Windows XP, it looks like this.  To move to 
a higher folder, you click the yellow up arrow 
icon to the right of the box that says “Sample 
Files”.   
 
 
 
 

 
 
In Windows Vista or 
Windows 7, it looks like this.   
 
To move to a higher folder, 
you click the name of the 
folder in the hierarchy.  For 
example, click on “Spartan 
Dairy 3” to go up one level.   
 
 
 
 
 
By default, the first time you launch Spartan Dairy 3, it will open the folder where the master feed 
library is.  Within that folder, you will find a "Sample Files" folder than contains the sample feed 
library and sample rations.  The full path to this folder is different under different operating 
systems, and by default, it will be in a "Spartan Dairy 3" folder within the /All Users/My 
Documents/ folder hierarchy.  However, you have the ability to change the location of these files 
during program installation.  In any case, do not be alarmed if you don’t see Spartan dairy files in 
the Open Dairy Ration or Library window—you may have to browse to find the correct folder 
where your data files are located.     

Saving Files: Files can be saved by the File > Save or File > Save As command, the File toolbar 
button, or typing Ctrl+S.   
 
Closing Files: To close a file, choose File > Close or hit the  button.   
 
Where are Files Stored?  Files can be stored in any drive, directory, or folder.  Using a folder 
within My Documents is recommended.     
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Feed Library Window    
The window for a feed library contains a list of feeds along with nutrient characteristics organized 
into 12 tabs.  The home tab gives general for each feed and contains %DM along with duplicate 
information from some of the other tabs.  All feed characteristics that are values (not calculations) 
can be edited.  Calculated values are shown in a library using standard assumptions for a high 
producing cow so that the implications of edited feed values can be seen immediately.  For 
example, if you edit the B protein fraction, you can see impact on %RUP and %RDP.   
 
NOTE: You cannot edit any feeds in the Master Feed Library.  Copying the Master Feed Library 
using Windows will not alter this protection.  To make a new library, you can copy our Sample 
Feed Library in Windows, you can start with the Sample Library in Spartan and add to it, or you can 
start a new library from scratch.   
 
An example of a feed library—the Master Feed Library. 
 

 
 
When working in a feed library, the Spartan library menu and toolbar appear at the top of the 
Spartan window.  They contain the necessary commands for working with libraries, the most useful 
being to add new feeds, copy and paste feeds, update feeds, sort feeds, and save the revised library.   
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Ration Window    
The window for a ration contains  

1. a summary of key animal descriptors 
2. a list of feeds with the amount of each and nutrient characteristics organized into 12 tab 

sheets.   
3. a summary of the ration supply and requirements for each nutrient 
4. a graph that quickly summarizes nutritional adequacy of a ration 

 
 
When working in a ration, the Spartan ration menu and ration toolbar appear at the top of the 
Spartan window.  They contain the necessary commands for working with rations and are explained 
in chapter 9 Working with Rations.     

 
 
Using the Worksheet    
 Selecting a Tab Sheet 
 Tab sheets contain columns of feed characteristics.  These 12 tabs appear at the bottom of the 
ration worksheet window.  Simply click on the tab you want.     

 
 
You can also select tabs using the ration menu item “Tabs” or use 
shortcut keyboard commands.   
        
 

1 

2 

3 

4 
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Measurement Systems  
Three different measurement 
methods for evaluation feeds 
and rations can be used in 
Spartan Dairy 3.  These can be 
quickly switched by using the 
boxes at the bottom right of the 
Spartan window.  Occasionally 
you may notice these buttons 
disappear as you work with the 
program.  Do not be alarmed.  
Usually just resizing the 
window will make them 
appear again.   
 

Ration Summary Basis: The summary rows at the bottom of the ration worksheet can be 
viewed on a concentration or a total amount per day basis.  Find the box in the lower right corner 
of the Spartan main window to see the current basis.   indicates the program is 
currently in an amounts basis and  indicates it is currently in concentration basis.  If 
you want to switch to the other basis, just double click on this box.  It acts as a toggle switch.   
 
Energy Measures: The energy system of Spartan 3 can be examined in Megacalories (Mcal) or 
Megajoules (Mjoule).   Find the box in the lower right corner of the Spartan main window to see 
the current energy system.  It will be either  or  .  If you want to switch to the 
other system, just double click on this box.  It acts as a toggle switch.   
 
Weight Measures: Spartan 3 can work in metric or in pounds.  Even in pounds, however, 
minerals will be calculated in grams.  To see the current basis, find the box in the lower right 
corner of the Spartan main window.  indicates current weight is pounds and  
indicates metric.  If you want to switch systems, double click this box.   

 
User Input Controls – (Combo Boxes, Spin Edit Controls, Calendar Controls) 
These work just like with any Windows program, and are pretty self-explanatory.  Just try them and 
you will figure them out.   
 
Sample Files 
We have provided 4 Sample Rations and Sample Library with the 
program.       
 
Keyboard Shortcuts 
The keyboard shortcuts can be seen if you select the Tabs 
command from the worksheet menu.   
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Chapter 5 
Working with Feeds 

This chapter includes 
• Adding Feeds 
• Deleting Feeds 
• Updating a Feed in a Library 
• Selecting Feeds 
• Select All Feeds 
• Cutting, Copying and Pasting Feeds 

• Working with Mixes 
• Filtering Feeds in a Library 
• Sorting Feeds 
• Editing Nutrient Composition 
• Viewing Feed Relationships 
• Comments about Feed Tags 
• Making a new Feed 

Each ration contains a collection of feeds. You can also store collections of feeds in feed libraries to 
make it easier to reuse them. In Spartan Dairy 3 you normally work with feeds using a spreadsheet 
like user interface we call the worksheet. See Using the Worksheet for instructions on navigating 
the feed library and ration worksheets. 
 
Each row in a worksheet represents one feedstuff. Since feed library and ration data files are stored 
as MS Access databases, each feed also corresponds to a record in a database. So we refer to feed 
records and feed rows interchangeably. Each column in the worksheet represents a feed 
characteristic. See the Feed Characteristics help chapter for definitions, usage, and equations 
associated with each feed characteristic.   
 
This help chapter explains how to work with feeds using 
commands in the main menu's Feeds submenu. This menu is 
available whenever the a feed library or ration file is open. All 
Feeds commands operate on feeds in the active data file. 
 
Using these commands you can add and delete feeds from a ration 
or feed library, and cut/copy/paste feeds among data files. You can 
also change how feeds are sorted in the worksheet. Some Feeds 
commands differ depending on whether one or multiple feed 
records are selected. See Selecting Feeds in this chapter for details. 
 
Use the Nutrient Composition dialog to edit all of the non-
calculated feed characteristics for the active feed record on a 
single screen, rather than having to switch tab sheets to make multiple changes. 
 
The Update Feed and Filter Feeds commands are only available for use in Feed Libraries. Use 
Update Feed to duplicate the active feed record and set its Test Date to the current date. Filter Feeds 
allows you to restrict the view in a feed library with hundreds of feeds to a smaller subset of feeds 
with specific feed types, names, and/or test date ranges. 
 
Feeds can also be combined to form a mix. We refer to feeds within a 
mix as ingredients. The image below shows a portion of a ration 
worksheet that contains a feed mix named "Mineral mix". Notice that 
the mix appears as an embedded grid within the main worksheet grid. 
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In Spartan Dairy 2 you needed to unmix a mix to edit ingredients.  In Spartan Dairy 3 you can edit 
ingredients directly in the embedded grid and see the impact of those changes without having to 
unmix and remix a mix. See Working with Mixes for details. 
 
See also: 
Using the Worksheet 
Feed Characteristics 
 
Adding Feeds 
There are two ways to add feeds to a ration or feed library file. First, you can use Feeds > Add 
Feeds to launch the Add Feeds dialog. This dialog allows you to select feeds from a source file and 
copy them to the active ration or library. Or, you can copy and paste feeds directly from one data 
file to another. See Cutting, Copying and Pasting Feeds for details on that process. 
This help topic explains the operation of the Add Feeds 
dialog. This dialog can be launched in three ways. One way is 
to select Feeds > Add Feeds from the program’s main menu. 
   
Or you can click the Add Feeds icon on the program's toolbar. 
The third way to launch the Add Feeds dialog is to use its 
keyboard shortcut, Ctrl+F. All three options are displayed on 
the Add Feeds menu item. 
 
Once you launch the dialog, a Windows File Open dialog appears allowing you to select a feed 
library or ration file to use as the source for selecting feeds to add. After you have selected a source 
file, the Add Feeds dialog appears.   
 
Note: Closing the File Open dialog without selecting a source file cancels the Add Feeds command. 
 
Note: Adding feeds to a mix does not work well.  If you have a problem, it is better to unmix the 
mix, add the feed to the ration, and then select it along with the other desired feeds to make a new 
mix.  See Working with Mixes later in this chapter.   
 
The Add Feeds dialog has several major components: 

• The name of the source file you selected is listed on the first row of the dialog.  
• Next is a group box with several controls for setting criteria used to filter which feeds from 

the source file are displayed.  
• Below this, on the left half of the dialog is a grid showing the feeds in the source file that 

meet your filter criteria.  
• On the right half of the dialog is a grid showing the feeds you have chosen to add. These 

feeds will be added to the active file when you press the OK button.  
• Between the two grids are four command buttons used to add or remove feeds to/from the 

destination grid.  
• Between the command buttons and the destination grid is a vertical splitter.  Use this splitter 

in conjunction with the resizable window to adjust the horizontal space allotted to each grid 
and the number of feeds viewable without scrolling.  
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To see more or less of a field, such as Feed Name, just click and drag the vertical splitters between 
the headings.  You also can click and drag the vertical splitter for the dialog box as needed.   
 
Setting Criteria for Viewing Feeds in Source File 
Feed libraries can contain hundreds of feeds, far more than can be viewed in the source file grid. 
Controls in the View Feeds in Source File Matching These Criteria group box are used to set 
criteria for filtering feeds in the source file. This allows you to view a subset of feeds matching filter 
criteria for feed name, feed type, common feeds, and/or feed test dates. When the dialog opens, 
filter criteria are set so all feeds in the source file are displayed. 
 
To only view feeds with specific text in their feed name, enter the desired text into the Feed name 
box. For example, typing in "corn" will limit the visible feeds to those that include the string "corn". 
This filter string is not case sensitive, so capitalization does not matter. The Matching Feeds in 
Source File grid is updated each time you enter 
another character into the Feed name criteria box. 
When the dialog opens, feeds of all feed types in the 
source file are displayed. To limit the Matching 
Feeds in Source File grid to a single feed type, 
select a different option from the Feed type list box. 
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Similarly, to view only feeds tagged as Common Feeds, be sure the view common feeds only 
checkbox is checked. 
 
To enable filtering on test date use the Test dates list box to select an option other than View all 
test dates. Here we are choosing to restrict our view to a range of test dates. 

 
 
 
 
 

Which test date input controls are enabled depends on which option 
you select. You can enter a date directly into the Start Date and 
End Date input controls using the format m/d/yyyy, or click on ▼to 
launch a calendar input control. See the Calendar Control help topic 
for tips on using this input control. In the example below, the 
selected date in the calendar control is 8/12/2009. 
 
The program prevents you from entering calendar dates in the Start or End Date input controls that 
are earlier or later than any test date in the data file. So if all feeds have the same test date, only that 
test date can be entered. 
Note: All feeds in the master feed library have the same test date. 
 
Selecting Feeds in the Source or Destination Grids 
To select a single feed in either the source or destination grids, left click the mouse on that row. A 

 symbol appears in the record indicator column. This is the left most column in each grid. 
NOTE: In the worksheet you must click in the record indicator column to select a feed. However, in 
the Add Feeds dialog you can select a single feed row by clicking anywhere in the row. 
To select multiple contiguous rows, click on the first row in the series, then hold down the Shift 
key, click in the record indicator column on the last row you wish to select, then release the Shift 
key. All rows between the first and last rows will be selected. The example below shows five feeds 
selected, from "Barley malt sprouts" through "Chocolate byproduct". 
 
To select multiple non contiguous rows, in a grid 
hold down the Ctrl key, click in the record 
indicator column on each row you wish to select, 
then release the Ctrl key. 
 
Selected feeds are highlighted in blue and have a 
circle or arrow symbol in the record indicator 
column. 
 
Sorting Feeds in Source and Destination Grids 
You can sort feeds in either grid by feed name, 
test date, percent dry matter (DM), crude protein 
(CP), or neutral detergent fiber (NDF). Just click on the grid caption for a column. Click again to 
reverse the sort order. This is useful if you want to find a feed that is high or low in CP or NDF. 
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Adding Feeds to the Destination Grid 
After one or more feeds are selected, click Add Selected to add them to the list of feeds in the 
Feeds to Add to Active File grid. You can also add a single feed to the destination grid by double 
clicking on it in the source grid.  To add all feeds in the source file to the destination grid, press 
Add ALL.  Repeat the process of setting filter criteria, selecting feeds, and adding feeds to the 
destination grid as needed. 
 
Removing Feeds from the Destination Grid 
Sometimes you may wish to remove a feed or feeds from the Feeds to Add to Active File grid. To 
remove a single feed first select it, then press Remove Selected. If multiple feeds are selected, 
pressing this button will remove all selected feeds from the destination grid. 
To remove all feeds from the destination grid, press Remove ALL. 
 
Adding Feeds to the Active File 
Once all of the feeds you wish to add to the active file are displayed in the Feeds to Add to Active 
File grid, press OK to complete the process. Pressing Cancel will close the dialog without adding 
any feeds to the active ration or library. 
Whenever feeds are added to a feed library or ration, calculated feed characteristics are updated. If 
the active file is a ration, the ration summary and nutrient balance graph are also updated. 
 
See also: 
Deleting Feeds 
Cutting, Copying, and Pasting Feeds 
 
Deleting Feeds 
Feeds > Delete Feeds deletes one or more feed rows from a 
feed library or ration file. The keyboard shortcut for deleting 
feeds is Ctrl+Del, where Del refers to the Delete key. 
 
If no feed rows in the worksheet are selected, this command 
deletes the active feed record. The active record is indicated 
by the  symbol in the record indicator column and is 
highlighted in blue. In the example below "Cotton seed" is the 
active feed. 
 

  
 
After the command is issued, a warning dialog appears asking you 
to confirm the deletion. This action cannot be undone, so now is 
your opportunity to respond No to cancel the command. Respond 
Yes to delete the current feed from the active data file. 
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If multiple feeds are selected when the Feeds > Delete Feeds command is issued, a slightly 
different warning dialog appears. This dialog indicates the number of feeds that are selected. In the 
example below, five feeds are selected. 

 
If you answer Yes to the warning dialog, all selected feeds will be 
deleted from the data file. See Selecting Feeds for instructions on 
selecting multiple feed rows. 
 
Whenever feeds are deleted from a feed library or ration, calculated feed 
characteristics are recalculated as needed. If the active file is a ration, 

the ration summary and nutrient balance graph are also updated. 
 
Note: If you accidently delete a feed or feeds and you have not saved the file since the deletion you 
can recover the deleted record(s). Simply open another copy of the original file and copy the deleted 
feed(s) from it to your working copy before you save the working copy of your file. 
 
Updating a Feed in a Library 
Feeds > Update Feed is helpful to update a feed in a feed 
library when you get new feed test results. The keyboard 
shortcut for updating a feed is Ctrl+U. 
 
Update Feed duplicates the active feed record and changes 
the Test Date to the current calendar date. If the Common 
Feeds characteristic was checked in the original feed, it 
stays checked in the duplicate and is unchecked in the 
original. Finally, the updated feed becomes the active feed 
record. 
 
Note: The Update Feed command is only accessible in a feed library, not in a ration. 
 
Use this command if you have a new analytical result for a feed but want to keep information about 
the previous analysis for your records. For example, if a silo is sampled monthly to see if feed 
composition changes over time, the name of the silage might stay the same but the test date would 
always be the newest date from the lab. 
 
This command simplifies the process of tracking feed composition changes over time by making it 
easy to keep multiple copies of a feed in a feed library, with each record in the series representing 
the composition of that feed on a different test date. 
 
For more ideas on how to easily update feeds using lab test results, see the Spartan website.   
 
Selecting Feeds 
The leftmost column in the worksheet is called the record indicator column. This column is used to 
select feed records. It also indicates whether a worksheet row is active or inactive, and whether or 
not the row is selected. At any given time, only one row in a grid can be the active row. But none, 
one, or several feed rows can be selected. Only selected records can be cut or copied to the 
Windows clipboard. 
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The following symbols are used in the record indicator column to display the status of each record: 

 row is the active record 
 row is the active record, data in a cell is being edited 
 row is selected 
 row is selected and the active record 
 row is inactive and not selected 

 
The Active Record 
When you click on a cell in the worksheet in any column other than the record indicator column, the 
entire row is highlighted in blue and the  symbol appears in the record indicator column. That feed 
row is now the active row in the grid. Once you start editing data in a cell, the record indicator 
symbol changes to  indicating the record is in edit mode. After editing is completed, the record 
indicator changes back to . 
 
Note: See Using the Worksheet for instructions on using the arrow, tab, and ENTER keys to 
navigate feed library and ration worksheets. 
 
Selecting a Record 
When you hover the mouse over the record indicator column, the mouse cursor changes from  to 

, indicating you are in record selection mode. Left click on a row in the record ndicator column to 
select the record. The symbol for the selected record changes to  , indicating that the record is 
both selected and active. 
 
Selecting Multiple 
Records 
To select multiple 
contiguous rows, select 
the first record in the 
series, press and hold 
the Shift key, then select 
the last record in the 
series. Release the Shift 
key. All records in the 
series are selected. The 
last row selected is also 
the active record. 
 
To select multiple 
records that are not 
contiguous, select the 
first record, press and hold the Ctrl key, then select additional records. When you have finished 
selecting records, release the Ctrl key. The last row selected is also the active record. 
 



Spartan Dairy Help Manual Michigan State University Page 19 

Note: After releasing the Ctrl or Shift key, clicking on a different row will discard a multiple 
record selection. So be sure that cut or copy is the first action you perform after selecting multiple 
feeds. 
 
Select All Feeds 
Use Feeds > Select All from the program's main menu to 
select all feed rows in the active ration or feed library. 
The keyboard shortcut for Select All is Ctrl+A. 
 
 
 
Cutting, Copying and Pasting Feeds 
Use Feeds>Cut or Feeds>Copy to copy or cut selected feeds from one ration file or library and 
then Feeds>Paste to paste to another ration or library file.  You can also copy or paste to and from 
Excel.  Just paste the feed into a blank row in Excel instead of in a Spartan Dairy file.  Note that 
when feeds are pasted into Excel, the column headings and weight and energy units will also be 
pasted.  The Excel file will look like this: 
 

 
 
To move data from Excel back to Spartan Dairy 3, you must have all of the appropriate formatting.  
For example, to move the feeds from rows 4, 5 and 6 in this example, rows 1-6 must be selected and 
copied so that Spartan could detect the weight and energy units of the data and the feed 
characteristic of each column of data.  The order of the columns in excel is not important.  This 
ability can be used to automate uploading of data from feed test reports.   
 
To do this correctly be sure: 
• copy the formatting and heading rows as well as the feed row 
• make sure test date data in Excel is in a date format 
• make sure to copy the whole row, not just a few cells 
 
If information does not paste, check to make sure all the necessary data was copied.   
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Working with Mixes 

Working with Mixes  
Mixes can be created and stored in ration files and libraries and converted to regular feeds.   
 
Creating a Mix 
First select the feeds to be 
mixed.  See Selecting 
Feeds in this Chapter for 
help if you need it.  Then 
choose Feeds>Mix in the 
Ration Menu.   
 
The feeds will now be 
mixed and show up in the 
ration or library in 
minimized form as “New mix”.  Change this name by 
simply typing over it.  In this case, we will change the name 
to “Lakeview High Mineral”.     
 
Expand the mix so you can see its ingredients by clicking 
the  button.  Sometimes when you expand a mix, other 
feeds may temporarily disappear.  Clicking on any feed not 
in the mix will minimize the mix.  Mix composition can be 
edited while in the mixed state. However, changing the 
amounts of each ingredient within a mix changes the 
composition of the mix, but does not alter the total amount of the mix in the diet—so by increasing 
one ingredient, you are effectively decreasing the others in the diet.  Therefore, when developing a 
new feed mix or editing an existing one, it may work better to start with the feeds in the unmixed 
form.  First use the Unmix command, then determine how much of each mix component is needed, 
and finally use the Mix command again.     
 
You can have as many mixes as you want in a diet, but you cannot have a mix within a mix.  To do 
this, you must first convert the submix into a regular feed—see next page.  If you want to add a new 
feed to a mix, you must first unmix it and then make a new mix with all of the desired feeds.   
 
Bug Note: Sometimes if you move your cursor to the mix amount and start to edit the number, 
nothing seems to be happening.  Instead you likely altered the content of the last active cell 
unknowlingly. This is because the active cell was not updated 
correctly.  You may have to click on the new cell twice before it 
becomes active.  Make sure you see the new number displayed in the 
desired cell before hitting enter or you will have altered the wrong cell.  
If you did, you must correct it.   
 
Unmixing a Feed Mix  
Highlight the mix and choose Feeds>Unmix in the menu.  If the 
highlighted feed is not a mix, this choice will not be available.  When 
you unmix, the ingredient amounts are calculated as the total mix 
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amount times the proportion of each ingredient.  This may different than the Amount DM for each 
ingredient in the mixed state if the Amount DM for the mix was directly altered.  
 
Converting a Mix to a Regular Feed  
Once a mix has been created, and is already in its mixed form on 
the farm, you might want to give it a name that indicates its batch 
number or date and make it a 
regular feed.  In this 
example, we will choose 
“Lakeview High Mineral 
2010-2-21” to indicate the 
date that it was delivered to 
the farm.   
 
Highlight the mix and choose Feeds>Convert Mix to Feed from the menu.  The feed will now 
appear without the  button in the mix column, indicating it is no longer a mix.  The nutrient 
composition is the same as before.   
 
Note: When you convert a mix to a feed, you must change the feed type to something other than 
“Mix”.  If you leave it as a mix, some calculations may be inaccurate.  Choose whichever feedtype 
is  closest.  For a concentrate mix, choose “Grain”.  For ration TMR, the best choice is probably 
“forage” but notice that the forage NDF will be inaccurate.  See Feed Type in Chapter 6.   
 
Filtering Feeds in a Library 
The Filter Feeds function can help you find specific feeds faster in a library.  Choose Feeds>Filter 
Feeds from the feed library menu.  This function is not available in the ration worksheet menu.  You 
may also select the  button.  Conversely, if feeds are filtered, you can choose the  button to 

unfilter them.  This brings up the Filter Feeds dialog.  In this 
example, we will choose to examine only common feeds.   

 
 
Sorting Feeds 
Feeds in a library or ration can be 
sorted many ways.  One way to sort 
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is to use the Feeds>Sort Feed By command.  There are several choices.  One of the most useful is 
to sort by Feed type and name.  You can also sort feeds by clicking on a heading in Home Tab or 
Misc. Tab to arrange feeds in order of concentration of a specific nutrient or in order of feed type.  
You can even use one of the blank columns of the Misc Tab to make your own order, or you can 
insert numbers at the beginning of feeds names to make your own order.   
 
Editing Nutrient Composition 
Simply type over information in a cell to edit it.  Note that some values are calculated and thus 
cannot be manually overwritten.  Also note that there is no Undo feature in Spartan 3; if you make a 
mistake, the best option is to get the feed from the source library again and delete the one with the 
new mistake.  An easy way to change many values at once is to choose Feeds>Nutrient 
Composition in menu.  This brings up a dialog for editing nutrient composition of a feed.  

 
 
Viewing Feed Relationships 
Some simple feed relationships can be examined by choosing 
Feeds>Feed Relationships.  These include the ratio of CP to 
ME, lignin as a % of NDF, the ADF to NDF ratio, and the Cost 
per Mcal of ME. 
 
 
A comment about feed tags 
When entering information from a feed tag into Spartan 3 to use the feed in a ration, remember that 
feed tags usually have nutrient content reported on a wet-weight basis and the information in 
Spartan 3 must be on a DM basis.  For mineral feeds, this may not make much difference.  
However, most grain and protein supplements are about 10-13% moisture.  If the moisture is 12%, 
then the nutrient values must be divided by 0.88 to convert to DM basis.  One way to do this in a 
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more automated fashion is to use some of the Excel worksheets on our website and the Copy and 
Paste features of the program.   
 
Making a new feed 
When making a new feed, you should always start by using a similar feed as a template.  Starting 
with a blank row is very difficult because almost always, there are characteristics with no known 
value.  Find something that seems as close as you can get.   
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Chapter 6 
Feed Characteristics 

 
Feed characteristics include nutrients and other information specific to individual feedstuffs.  These 
characteristics are grouped into 12 broad categories which are contained within separate tabs.  The 
Mix, Feedname, and Amount DM characteristics appear on all tab sheets.  Columns can be 
reordered within a tab sheet, and number of decimal places can be changed. This information is 
specific to a file and is saved in the feed library or ration data file.   
  
This chapter includes:  
• General Characteristics Page 23 
• Home Tab Characteristics  Page 24 
• Fiber Characteristics  Page 25 
• Energy Characteristics  Page 28 
• Protein Characteristics  Page 34 
• Carbohydrate Characteristics  Page 39 
• Lipid Characteristics  Page 41 

• Macromineral Characteristics  Page 43 
• Trace Mineral Characteristics  Page 52 
• Vitamin Characteristics  Page 59 
• Mineral and Vitamin Sources Page 62 
• Amino Acid Characteristics  Page 65 
• Cost Characteristics  Page 66 
• Miscellaneous Characteristics Page 67

 
Comments about this chapter 
• A quick summary of feed characteristics can be found at the end of Chapter 4 Guided Tour. 
• More information about feed characteristics and equations can be found on our website—

www.spartandairy.msu.edu 
• Equations presented in this chapter are directly from the transcript window and use program 

formatting.  A couple examples:  1) “BW^0.75” = “BW0.75” or “BW to the 0.75 power”.            
2) “IF(X>0, A,B)” means if X is greater than 0, the formula returns A, otherwise it returns B.   

 
General Characteristics 
These are the 3 columns that are found on the left side of the worksheet and are visible in all tabs.   
 
MIX Column 
The MIX column indicates whether a row is a mix or a feed, and provides a button for expanding a 
mix to display and edit the ingredients contained in the mix. If a row is a mix, the MIX column 
displays a  or  button. See Working with Mixes for more details. 
 
Feedname 
Feedname is the descriptive name for a feed. Be specific when naming feeds. Use words that can 
help you find a feed when you search for it. Good examples are: "Cottonseeds, 9-15 delivery", 
"Haylage, east bunker" or "Mineral mix - high cows – spring 09". 
Note: A Feedname can be up to 50 characters in length. 
 
Amount Dry Matter (Amount DM)  
Amount DM is the amount of each feed for the animal being fed on a dry matter basis.  The 
summation of individual feed amounts is the DM supply of the animal.  The DM supply should be 
reasonably close to the predicted DMI of the animal.   
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The Predicted DMI for an animal is calculated as the summation of several DMI component parts, 
most of which are part of the animals energy requirement, and then adjusted to account for factors 
that alter the calculation. 
 
Predicted DM intake in the Spartan 3 system, as compared to NRC 2001. 
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Home Tab Sheet Characteristics 
 
The home tab sheet includes a summary of the most useful information for feeds and the total 
ration.  Much of the information on this tab is duplicated from other tabs.   
 
List of feeds on the home tab in their default order:As Fed, Group As Fed, %Diet, EfNDF, NEL, 
ME, NDF, CP, RUP, RUP dig, FA, Ca, P, Na, DCAD, Se, Vit E, Cost DM, Test Date  
 
Some of these are only found only on the home tab sheet.  They are As Fed, Group As Fed, %Diet, 
and EfNDFasDM 
 
Amount as Fed (As Fed) 
Amount As Fed is the amount of each feed for the animal being fed on a wet or as-fed basis.  
 
Notice when you change Amount AsFed, the Amount DM will change proportionally where, 

AmountDM = AmountAsFed * (DM/100) 
 
Notice when you change AmountDM, the Amount AsFed will change proportionally where, 

AmountAsFed = AmountDM / (DM/100) 
 
Percent Dry Matter (DM) 
DM is the percent dry matter of a feed.  Percent dry matter is used for converting feed amounts 
between a dry matter and as fed basis. 

DM = (AmountDM / AmountAsFed) * 100 
 
Group as Fed 
Group AsFed is the amount of feed for the entire group, on an as fed basis. For each feed in a ration 
GroupAsFed is calculated as, 

GroupAsFed = AmountAsFed * GroupCount  
where GroupCount is the number of animals in the group, also referred to as group size. If the group 
size is 1, then Group AsFed and Amount AsFed will be the same.  You can change number of 
animals in the group using the Group Information dialog or by changing settings for the Batch 
Report. 
 
Percent of Diet (%Diet) 
PercentDiet is the amount of a feed as a percentage of total dry matter supply.  If you change 
PercentDiet for a feed, the entered value is used to calculate a new AmountDM for the feed based 
on the current dry matter intake requirement, DMIReqt. 

AmountDM = PercentDiet/100 * DMIReqt 
 
Next, other feed amounts such as Amount AsFed and GroupAsFed for the feed are updated using 
the new AmountDM. Then the ration is resummarized. After these calculations, the PercentDiet 
column will be updated, and most likely the new PercentDiet will not be what you had specified. 
TIP: When you create a ration from scratch, you can use the PercentDiet column to quickly create a 
rough diet based on the DMI requirement. 
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Fiber Characteristics  
Fiber from long feed particles contributes to retention of digesta in the rumen and stimulation of 
rumination. Rumination stimulates salivation, and saliva contains buffers to help maintain a healthy 
rumen pH.  Therefore, dairy cattle need some long feed particles that are high in fiber to maintain a 
healthy digestive tract. Thus, we always include some forage in a dairy diet.  Fiber also has less 
energy than starch, protein, and fat, and therefore helps to fill the rumen and decrease total energy 
intake, which is important for cattle that are at risk for becoming obese.  
 
Optimal NDF for a high-producing cow 
Generally, the optimal %NDF for lactating cows 
fed a totally mixed ration (TMR) is about 27% on 
a dry matter basis.  This optimum shifts based on 
stage of lactation and body condition score, types 
and amounts of carbohydrate fractions, inclusion 
of fat and buffers, method of grain feeding, and 
quality in monitoring and controlling 
management of feeds and feeding.  For example, 
shifts in silage DM content that are not observed 
may cause a 1-2% change in  %NDF of the TMR.  
Farms that carefully monitor silage DM can make the appropriate adjustment for mixing.  In 
formulating diets for high producing cows, monitoring NDF, EfNDF, and ForNDF is useful, and 
helps to produce diets that follow the general principles of the above chart.  
 
Neutral Detergent Fiber (NDF) 
Neutral detergent fiber (NDF) is the best measure of fiber for a dairy cow. NDF is the total 
insoluble fiber in a feed and is what remains after boiling in a detergent solution at neutral pH for 
one hour. NDF fractions include hemicellulose, cellulose and lignin as well as minor fractions of 
true protein and NPN. A fraction (up to 50%) of NDF is indigestible because of lignification. The 
fraction of NDF that is potentially digestible may be fermented by microbes to short chain fatty 
acids in the rumen and large intestine but it cannot be digested in the small intestine by mammalian 
enzymes.  NDF is required to maintain a healthy digestive tract.  The requirement in Spartan 3 is 
27% for most high-producing lactating cows and increases up to 30% for cows that produce less 
milk relative to their metabolic body weight.  The requirement is 30% for cows in the first 3 wk 
after calving and for heifers and dry cows.   
 
NDF is used to calculate the following derived feed characteristics: efNDF, ForNDF, tdNDF, NFC, 
RDOM, and Kp Bprot. 
 
Effective NDF (efNDF) 
Effective neutral detergent fiber (EfNDF) is a measure of relative fiber particle size. EfNDF is a 
product of the NDF concentration of the feed times its effectiveness coefficient.  
On the home tab sheet, EfNDF is given in %DM -- this is the value that really matters to the cow. In 
the fiber tab, EfNDF also is presented in %NDF, which is a much easier way to enter the EfNDF 
value for your feeds. The program will automatically calculate efNDF in %DM from NDF and 
EfNDF in %NDF using the following relationship: 
     EfNDFasDM = EfNDFasNDF * NDF/100 
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NDF from long feed particles contributes to retention of digesta in the rumen and stimulation of 
rumination by formation of a rumen mat. Rumination is important to stimulate salivation, and saliva 
contains buffers to help maintain a healthy rumen pH. Cows require a minimum amount of EfNDF 
in the diet to help prevent ruminal acidosis. However, even the fiber of short particles has some 
value in preventing acidosis because fiber is generally less rapidly fermented and less likely to 
produce lactic acid than is starch. When more fiber and less starch is fed, acidosis is less likely to 
occur and less long fiber is needed. Predicting acid production from feeds and the relationship 
between acid production and EfNDF requirements is not easy, so in Spartan 3 (as in Spartan 2) we 
have given all NDF an effectiveness of at least 25%. Thus, while the fiber of soyhulls may have 
little value in stimulating rumination, it is still effective in helping to prevent ruminal acidosis.  
 
Feeds are given effectiveness values according to the following: 

Feeds EfNDF/NDF EfNDF in %NDF 
Forages 100% EfNDF = NDF 
Whole fuzzy cottonseeds 50% EfNDF = NDF * 0.5 
Finely chopped forages (all particles <1 inch (2.5 cm) 50-90%   
Other feeds 25% EfNDF = NDF * 0.25 

By default in Spartan 3, the EfNDF requirement is 80% of the NDF requirement.  
Another approach for using EfNDF in the program is to measure particle size of a feed using a 
particle separator, define effectiveness as the number of particles above a specific size, and 
incorporate this value into the program.  This would basically be Physically Effective NDF 
(peNDF).  Using this method, most byproduct feeds, such as corn distillers grains, would have 0% 
effectiveness. If you prefer this method, you can change the effective NDF values to 0% for all 
feeds except forages and some byproduct feeds of larger particle size. With these lower values, you 
can balance rations so that ~75% of the NDF requirement must be effective NDF. Although you 
cannot change the actual requirement listed in the program, the % EfNDF on the Fiber tab can help 
you determine if you have met your requirement for effective fiber. 
 
Forage NDF (ForNDF) 
Forage neutral detergent fiber (ForageNDF) is the source of long fibrous particles in diets and 
therefore the greatest contributor to effective NDF. Forage NDF is positively related to rumen pH, 
likely because of stimulation of rumination (and secretion of salivary buffers) and rumen motility 
(which increases absorption of fermentation acids from the rumen). 
 
In Spartan Dairy 3, the ForNDF is 75% of the NDF requirement.  Forage NDF is calculated based 
on Feed Type and NDF.  All NDF in feeds with the feed categories "Wet Forages" and "Dry 
Forages" is Forage NDF. 
  

ForageNDF = if( OR(FeedCategory="WF",FeedCategory="DF"),NDF,0) 
 
The amount of ForNDF in the diet is used to calculate the digestibility discount for high fiber feeds 
with short particle size in the Spartan energy system.  If the diet has a less than 18% ForNDF, the 
individual feed digestibility discount is applied rather than the general digestibility discount.  See 
the energy section for more information. 
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Lignin 
Lignin is not really carbohydrate, but it is a polyphenolic compound found in the cell wall that is 
essentially indigestible and limits digestion of cellulose and hemicellulose. It is included in the NDF 
value of a feed, and the amount of lignin in a feed is highly related to the amount of indigestible 
NDF. In other words, if a feed has more lignin, its NDF will be less digestible. However, the 
amount of lignin in a feed has no impact on the digestibility of starch, sugar, protein, or fat.  
 
NDF Digestibility (NDF dig) 
Neutral detergent fiber digestibility (NDF dig) is used to determine the amount of energy provided 
to a cow from the fiber fraction of its diet. NDF digestibility also gives an indication of the filling 
effects of forage NDF in the rumen over time. NDF that is less digestible will remain in the rumen 
longer and thus contribute more to rumen fill. NDF digestibility is measured in a flask (in vitro) 
with live microbes from the rumen of a cow using retention times ranging from 24 to 48 hours. 
In the NRC 2001, NDF digestibility is predicted based on the lignin concentration of a feedstuff.  

 NDF dig = 0.75 * (NDFn-Lignin) * (1- (Lignin/NDFn)^0.667) )  /   NDFn*100 
      where NDFn = t(NDF – NDICP) 

For the average feed, the relationship looks like this: 

lignin as %NDFn  5 10 15 20 25 

 %NDF digestibility  62 53 46 39 34 

We disagree with this approach. Although higher lignin often means lower digestibility for a given 
type of forage, this equation does not work across different types of forages. And in fact, it does not 
always hold true within a forage type and cutting.  The digestibility values in our Master Feed 
Library generally were derived using the NRC equations and are reasonable for the lignin values 
given.  
 
In general, the NDF dig for corn silage is overestimated by the NRC approach when lignin values 
increase.  For alfalfa grown in cool conditions and harvested at a low lignin concentration, the NDF 
dig will be higher than predicted by the NRC approach.  For example, Oba and Allen (1996) found 
the relationships were more like this for forages grown in Michigan: 

lignin as %NDFn 5 10 15 20  

 %NDF digestibility  
     Corn silage 50 38 
     Alfalfa, first cut  60 30 
     Alfalfa, other cuts no relationship 

NDF digestibility is used to calculate tdNDF and subsequently its DE1X (the amount of digested 
energy for cows eating only enough to meet maintenance requirement).  Some feed test labs will 
measure in vitro NDF digestibility based on a specified time (for example, 24 or 48-hours); the in 
vitro digestibility that represents how much fiber is digested at 1X maintenance would be most 
appropriate. This would usually be a longer (more complete) digestion.  The digestibility discount 
in Spartan is then used to estimate digestibility for cows eating at greater multiples of maintenance.  
Please note this is not an accurate science!  Thus, NDF dig values should be edited to match those 
for your location and growing conditions, as recommended by a nutritionist, and feed energy values 
should never be trusted for accuracy.  
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Acid Detergent Fiber (ADF) 
Acid detergent fiber (ADF) is a measure of the feed fractions remaining after boiling in a detergent 
solution at acid pH for one hour, which are mainly cellulose and lignin but also contains bound 
nitrogen (generally unavailable to the animal). ADF was original developed as a preparatory step 
for determination of lignin. It was used extensively in the past to predict digestibility of fibrous 
feeds, but it has been replaced by the summative approach (NRC, 2001).  
Currently, the most useful feature for ADF is that the ratio of ADF to NDF (ADF:NDF) in a mixed 
legume and grass forage can be used to determine the relative fraction of each in the mix. ADF is 
~62% NDF for pure grasses and ~82% for legumes. So if a silage is 50% NDF and 30% ADF, it is 
likely mostly grass. If the ADF is 40%, it is likely mostly legume. If the ADF is 35% (with 50% 
NDF), the silage is probably half grass and half legume. ADF:NDF is included in the Feed 
Relationships dialog.  
 
Rumen Degraded Neutral Detergent Fiber (RDNDF) 
Rumen degraded neutral detergent fiber (RDNDF) is the fraction of NDF that is degraded by 
microbes in the rumen. It is used to determine total organic matter degraded by rumen microbes and 
available for their growth.  
 
Total Digestible Neutral Detergent Fiber (tdNDF) 
Total digestible neutral detergent fiber (tdNDF) is the fraction of NDF that is digested in the total 
tract (rumen plus post-rumen). It is used to determine the energy available to the cow using a 
summative approach. Spartan Dairy 3 calculates tdNDF from NDF, NDF digestiblity, and neutral 
detergent insoluble crude protein (NDICP): 
 
 tdNDF = (NDFdigest/100) * (NDF - NDICP) 
 
A feed's tdNDF value is used to calculate DE1X and ME01. 
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Energy Characteristics  
The amount of energy a cow consumes is a major determinant of her milk yield, body condition, 
and/or growth rate. The amount of usable energy in feed is not easily measured and can only be 
estimated. To further complicate matters, as the daily intake of a diet increases, its digestibility and 
thus its energy value decreases. We have several ways that we consider feed energy, and most of 
them are calculated based on other feed characteristics. Ultimately, the energy of a feed depends on 
its content of digestible fiber, non-fiber carbohydrates, protein, and fat. For lactating cow and dry 
cow diets, use net energy for lactation (NEL) or metabolizable energy (ME). For heifer diets, use 
ME or NE for maintenance and NE for gain. 
 
Energy is usually the most limiting nutrient for a cow. It is often impossible to meet the energy 
requirement of a high-producing cow while still meeting her needs for fiber. Meeting fiber 
requirements should always take priority over meeting energy requirements. Feeding too much 
energy will result in excessive weight gain.  Heifers often eat more than expected when fed mixed 
rations in confined feeding systems and gain faster than desired.  Careful monitoring is required.   
 
The Spartan 3 energy system (NEL, ME, NEm, NEg, DEP, DE1X) is a modification of the NRC 
2001 system. Feed energy values using NRC 2001 calculations (NEL01, ME01) and NRC 1989 
tables (NEL89, ME89) are also included 
in the program. NEL89 and ME89 are 
editable data fields. However, energy 
values for the Spartan 3 and NRC 
2001 systems are calculated and 
cannot be edited directly. The basic 
calculation dependencies in the Spartan 
3 system are shown to the side.  Thus, if 
you think an energy value is too low or 
high, it can be edited by altering, for 
example, the NDF digestibility value 
(see NDF dig in the section on fiber).  
The NRC 2001 energy system is shown 
below.  Only NEL01 and ME01 are 
visible  in the program.   
 
In NRC 2001, the digestion discounter 
is a function of the %fat-corrected 
TDN1X concentration of the diet and 
the multiple of maintenance.  In Spartan 
3, the digestion discounter is a function 
of the multiple of maintenance and 
individual discounts for some feeds if 
the %forage NDF in the diet is below a 
threshold value.  For key differences 
between the Spartan and NRC energy 
systems, see Chapter 12 of this manual 
and see Energy System Differences on 
our website. 



Spartan Dairy Help Manual Michigan State University Page 32 

Comment about synchronized variables  
Many of the calculations for energy and protein of NRC and Spartan depend on DMI supply, the 
TDN1X concentration of the diet, and the %ForageNDF and %concentrate in the diet.  If intake is 
very low as you start to balance a diet, the dependencies create erratic behavior in the model.  Our 
synchronized (Sync) variables provide reasonable estimates for these equations when intake is low.   
 
Net Energy for Lactation (NEL; Spartan 3 system) 
The net energy for lactation (NEL) of a feed is the energy using the Spartan 3 system that actually is 
used for maintenance and milk synthesis, after accounting for losses in feces, urine, gas, and heat 
from metabolic work. NEL is a calculated value based on other feed characteristics. Because 
digestibility decreases as intake increases, the Spartan 3 NEL value of a feed will be lower with 
higher feed intake. The method of discounting energy at higher intakes is not the same as in the 
2001 NRC system (see NEL01). 
  

NEL = MAX(0, 0.703*ME-0.19 + MAX(0, (0.097*ME+0.19) * (FA-2)/98) ) {Mcal/kg} 
 

The NEL requirement is similar but not exactly the same as in NRC 2001, with NEL requirement 
determined as the sum of:    

NEL maintenance = 0.08 * (current NP3BW^0.75) * Feed additive adjuster (set by user) 
  where NP3BW is BW adjusted to nonpregnant and BCS of 3 
NEL milk = Target Milk * (0.0929 * milk fat + 0.0547 * milk protein/ 0.93 0.0395 * 

milk lactose) 
NEL frame gain = NEg frame gain / 0.688 
  NEg frame gain = 5.668 * daily frame gain ^1.097 *RelMatureBW 
  RelMature BW = Current NP3BW^0.75 / Mature BW^0.75 
  where daily frame gain is target set by user 
NEL condition change = dBC energy * (0.82 if losing, 0.85 if gaining during lactation, else 1.07)  
  dBC energy = target daily BCS change * BC energy conc 
  BC energy conc = 2.887 + 1.035 * current body condition score 
NEL activity = activity energy adjuster * NEL maintenance 
  where activity energy adjuster is set by user 
NEL thermal = thermal energy adjuster * NEL maintenance 
  where thermal energy adjuster is set by user with heat or cold stress 
NEL pregnancy = NEL gr uterus + NEL mam gain 
  NEL gr uterus = NE gr uterus / 0.14 * 0.64  
  NE gr uterus = 0.00318*Days Preg - 0.035 * FetalWt adjustment 
  FetalWt adjustment = CalfBirthWt^0.75 / 45^0.75 
  NEL mam gain = 5 * [0.046 * (DaysPreg – 256) with max of 0.46] * 

(0.8 for Lact 0 or 0.9 for Lact 1) * Mature BW^0.75 / 650^0.75 
 
These equations were derived from simplifications of the NRC 2001 model with modications 
according to VandeHaar et al., 1999 and other adustments described on our website 
 
Net Energy for Maintenance (NEm; Spartan 3 system)  
The net energy for maintenance (NEm) value of a feed is the energy that actually is used for 
maintenance in a heifer, accounting for losses in feces, urine, gas, and heat from metabolic work.  
NEm is a calculated value based on other feed characteristics. When balancing energy for a heifer, 
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use either NEm and NEg together, or use ME.  The NEm value of a feed assumes that the feed is 
used entirely for maintenance needs. If a heifer is fed enough feed to grow, then only a portion of 
her diet is needed for maintenance. The diet NEm value determines how much is needed. Generally, 
the NEm value of a feed will be slightly higher than its NEL value. 
 
NEm = (100-FA)/100 * IF(DE1X>1.1, 1.123*DE1X - 0.0928*DE1X^2 + 0.00579*DE1X^3 - 1.12, 

0) + FA/100 * 0.8*DEp {Mcal/kg} 
 
Note: NEm in Spartan 3 is usually slightly higher than in NRC 2001 because the energy value of 
digested protein is considered to be 4.6 kcal/g in Spartan 3 but 5.6 in NRC.   
 
NEm requirement is the sum of: 

NEm maintenance = 0.086 * (current NP3BW^0.75) * Feed additive adjuster (set by user) 
  where NP3BW is BW adjusted to nonpregnant and BCS of 3 
NEm activity = activity energy adjuster * NEm maintenance 
  where activity energy adjuster is set by user 
NEm thermal = thermal energy adjuster * NEm maintenance 
  where thermal energy adjuster is set by user with heat or cold stress 
NEm pregnancy = NEL pregnancy 

 
Net Energy for Gain (NEg; Spartan 3 system)  
The net energy for gain (NEg) of a feed is the energy that would actually be gained or retained in a 
heifer for every unit of feed above the amount needed for maintenance and after accounting for 
losses in feces, urine, gas, and heat from metabolic work. NEg is a calculated value based on other 
feed characteristics. When balancing energy for a heifer, use either NEm and NEg together, or use 
ME. 
 
The NEg value of a feed assumes that the feed is used entirely for gain. If a heifer is fed enough 
feed to grow, then only a portion of her diet is needed for maintenance. The diet NEm value 
determines how much is needed. The diet NEg value determines how much energy retention can be 
expected from the remaining feed. The NEg value of a feed will usually be 20 to 50% lower than its 
NEm value. 
  

NEg = (100-FA)/100 * IF(DE1X>1.1, 1.164*DE1X - 0.117*DE1X^2 + 0.00673*DE1X^3 - 1.65, 
0) + FA/100 * 0.55*DEp {Mcal/kg} 

 
Note: NEg in Spartan 3 may be slightly different than in NRC 2001 because DEp is calculated 
differently and the energy value of digested protein is considered to be 5.1 kcal/g in Spartan 3 
instead of 5.6 in NRC.   
 
NEg requirement is the sum of: 

NEg frame gain = 5.668 * daily frame gain ^1.097 *RelMatureBW 
  RelMature BW = Current NP3BW^0.75 / Mature BW^0.75 
  where daily frame gain is target set by user 
NEg condition change = target daily BCS change * BC energy conc 
  BC energy conc = 2.887 + 1.035 * current body condition score 



Metabolizable Energy (ME; Spartan 3 system)  
The metabolizable energy (ME) value of a feed is the energy that is available using the Spartan 3 
system after accounting for losses in feces, urine, and gas. ME is a calculated value based on other 
feed characteristics. Because digestibility decreases as intake increases, the Spartan 3 ME value of a 
feed will be lower with higher feed intake. ME can be used to balance diets for cows and for heifers. 

ME = MAX(0, 1.01*DEp - 0.45 + MAX(0, 0.004*(FA-2))) {Mcal/kg} 

ME supply is used to calculate NEL supply.  In the Spartan 3 energy system, ME is calculated a bit 
differently than it is in the NRC 2001 system (see ME01).    

ME requirements are calculated from NEL requirements for lactating and dry cows and from the 
requiremens for NEm and NEg for heifers.   
For cows, the ME requirement = NEL requirement * 1.6.   
For heifers, ME requirement = [NEm requirement + (NEg frame gain + dBC energy) / 0.688] * 1.6 
 
Net Energy for Lactation, NRC 1989 (NEL89)  
The NEL89 of a feed is based on the 1989 NRC system and is an assigned (not calculated) value for 
each feed. Like NEL in the Spartan 3 system, NEL89 is the energy that actually is used for 
maintenance and milk synthesis, after accounting for losses in feces, urine, gas, and heat from 
metabolic work. Unlike NEL, the NEL89 value does not change with changing feed intake. In the 
1989 NRC system, cows were assumed to be eating at 3X maintenance intake (about 25 kg or 60 
pounds of milk). If a fixed NEL value is preferred when using Spartan 3, we suggest using the 
NEL89 values in the Master Feed Library or setting NEL89 at the NEL value for each feed in a 
ration that is reasonably close to meeting the target animal's energy needs. Library NEL values 
assume a cow is eating at 4X maintenance.  Requirement is same as for NEL in the Spartan system. 
 
Metabolizable Energy, NRC 1989 (ME89)  
The ME89 of a feed is based on the 1989 NRC system and is an assigned (not calculated) value for 
each feed. Like ME in the Spartan 3 system, ME89 is the energy that is available after accounting 
for losses in feces, urine, and gas. Unlike ME, the ME89 value does not change with changing feed 
intake. If a fixed ME value is preferred when using Spartan 3, we suggest using the ME89 values in 
the Master Feed Library or setting ME89 at the ME value for each feed in a ration that is reasonably 
close to meeting the target animal's energy needs. Library ME values assume a cow is eating at 4X 
maintenance. ME can be used to balance diets for cows and for heifers.  Requirement is same as for 
ME in the Spartan system. 
 
Net Energy for Lactation, NRC 2001 (NEL01)  
The NEL01 of a feed is based on the 2001 NRC system and is a calculated value based on other 
feed characteristics. Like NEL in the Spartan 3 system, NEL01 is the energy that actually is used for 
maintenance and milk synthesis, after accounting for losses in feces, urine, gas, and heat from 
metabolic work. Because digestibility decreases as intake increases, the NEL01 value of a feed will 
be lower with higher feed intake, but the method of discounting energy at higher intakes is not the 
same as in the Spartan 3 system. 

NEL01 = MAX(0, 0.703*ME01 - 0.19 + (0.001*ME01+0.0019) * FA) {Mcal/kg} 

NEL01 requirement is same as NEL requirement.  Note that this is not the same as the true 
NRC2001 model, which differs for activity, thermoregulation, and pregnancy.   
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Metabolizable Energy, NRC 2001 (ME01)  
The ME of a feed is based on the 2001 NRC system and is a calculated value based on other feed 
characteristics.  Because digestibility decreases as intake increases, the ME01 value of a feed will 
be lower with higher feed intake, but the method of discounting energy at higher intakes is not the 
same as in the Spartan 3 system.  The NRC 2001 energy system was consolidated so that DE1X and 
DEp are part of the ME equation and thus are not visible in the model.  
 
TDN1X_MM = SyncDMISupply * SyncTDN1XConc/100 / (0.035*(Current_NPBC3BW)^0.75) 
 where TDN1X_MM = Multiple of Maintenance based on TDN intake, 
   and the “Sync” before DMISupply and TDN1XConc can be ignored,  
   and NPBC3BW^0.75 is metabolic BW adjusted to be nonpregnant and body condition 3 
 
TDNAdjuster = if(NRC01FatCorTDN1X>60,  

(1 - (TDN1X_MM-1) * (0.18 - 10.3/NRC01FatCorTDN1X))*100, 100) 
 
Base = (4.2*tdNFC + 4.2*tdNDF + 5.6*tdTruP + 9.4*tdFA - 4.4*MFTDN) / 100 
 where Base is DE1X in the 2001 NRC system 
 
ME01 = MAX(0, IF(AnimalType=Heifer, 0.82*Base, 1.01*(TDNAdjuster/100 * Base) - 0.46 + 
0.004*FA) ) {Mcal/kg} 
  where TDNAdjuster/100 * Base is DEp in the 2001 NRC system.   
 
ME01 requirement is same as ME requirement. 
 
Digestible Energy at Production (DEp; Spartan 3 system)  
Digestible energy at production (DEp) is the estimated amount of energy digested and absorbed 
from the diet at the level of intake for the target animal, using the Spartan 3 system. DEp is DE1X 
multiplied by the digestibility discount multiplier. This multiplier is a function of the amount of 
energy a cow consumes relative to her maintenance requirement (her multiple of maintenance), the 
energy discount of a feed, the forage NDF concentration of the diet, and the Spartan base discount 
(BaseDiscount=3). 
 
As intake increases, the rate of discount decreases proportional to the multiple of maintenance 
(MM) to the 0.8 power. The multiplier is,  

1.0 - ActualDiscount/100 * (MM - 1.0)^0.8 

The full equation for DEp of a feed is,  
DEp = DE1X* (1.0 - ActualDiscount)/100 * (MM - 1)^0.8) {Mcal/kg} 

In feed libraries, the multiplier for calculating DEp assumes that an animal is eating at 4X 
maintenance (MM =4) and that diets have more than 21% forage NDF so that the ActualDiscount is 
the BaseDiscount. Thus, in a library the equation is:  

DEp = DE1X * (1.0 - BaseDiscount/100 * (4 - 1.0)^0.8) 

This can be simplified to, 
DEp = DE1X * (1.0 - 0.03 * (3)^0.8) 

or, 
DEp = DE1X * 0.928 
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In a ration, the multiple of maintenance (MM) is calculated as the total ME required for the target 
animal divided by the ME required for its maintenance:  

MM = MEReqt / MEReqt_Maintenance 
  
Also, ActualDiscount of a feed will be the BaseDiscount, the EnergyDiscount of a feed, or some 
combination of the two, depending on the forage NDF concentration of the total diet. If forage 
NDF>21%, BaseDiscount is used, and DE1X will be multiplied by 97% to predict DEp of the feed 
at 2X maintenance intake. 
 
If forage NDF<18%, the EnergyDiscount of the feed is used to calculate the multiplier so some 
feeds will be discounted at a higher rate than others. Thus, for a feed with an EnergyDiscount of 
6%, DE1X will be multiplied by 94% to predict DEp at 2X maintenance intake. Between 18 and 
21% Forage NDF, the equation for ActualDiscount uses both factors, as  

ActualDiscount = IF(EnergyDiscount<=BaseDiscount, BaseDiscount,  
IF(SyncForageNDFConc>=21, BaseDiscount,  

IF(SyncForageNDFConc<=18, EnergyDiscount,  
(21-SyncForageNDFConc)/3 * (EnergyDiscount-BaseDiscount) ))) 

  
Note that EnergyDiscount values lower than BaseDiscount are ignored. 
SyncForageNDF prevents fluctuations in the discount at low intake. If dry matter intake is more 
than 50% of the DMI requirement, SyncForageNDF is the actual forage NDF concentration of the 
diet; otherwise, it is a prediction based on the target animal.  Synchronized variables are explained 
further in the nutritional model described on the Spartan Dairy 3 website.   
DEp is used to calculate ME, which is used to calculate NEL. 
 
Energy Discount (Disc. Fac.; Spartan 3 system)  
The energy discount factor is an entered value that indicates the decrease in digestibility that occurs 
when the energy intake of an animal increases from 1X maintenance to 2X maintenance. For some 
feeds this drop in digestibility may be greater. This is especially true for feeds with small particles 
high in fiber. If the diet is low in forage fiber, these particles may pass out of the rumen long before 
they are digested fully. In the Spartan 3 system, most feeds are assigned a discount factor of 3%; 
high fiber feeds with short particles are assigned discounts of 6%.  These individual feed discount 
values are used only if the total diet forage NDF concentration is below 21%.   
The energy discount factor is used to calculate DEp. 
 
Digestible Energy at 1X Maintenance (DE1X; Spartan 3 system)  
Digestible energy at 1X maintenance (DE1X) is the estimated amount of energy that would be 
digested and absorbed from the diet if it were fed to an animal at maintenance, using the Spartan 3 
system. At maintenance an animal is eating enough so it does not gain or lose body calories and 
produces no milk. DE1X is calculated as the sum of the energy from total digested fiber, non-fiber 
carbohydrate, protein, and fatty acids minus the fecal energy from endogenous sources. In a ration 
DE1X is adjusted for the effect of feed additives. The equation for DE1X in a ration is: 
  

DE1X = AdditiveEnergyAdjuster/100 * (4.2*tdNFC + 4.2*tdNDF + 5.1*tdTruP + 9.4*tdFA - 
4.4*MFTDN) / 100 {Mcal/kg} 

  
DE1X is used to calculate DEp, NEm, and NEg. 



Spartan Dairy Help Manual Michigan State University Page 37 

Metabolic Fecal Total Digestible Nutrients (MF‐TDN, MFTDN; Spartan 3 system)  
In calculating the DE1X of a feed, the fecal energy from endogenous sources must be subtracted 
from the truly digested energy of fiber, non-fiber carbohydrate, protein, and fatty acids. In NRC 
2001, this is a tabular value. In Spartan 3, we calculate MFTDN. Our formula gives values that are 
very close to the tabular values in NRC 2001. The implied assumption in NRC is that MFTDN 
output is a function of fiber, non-fiber carbohydrate, and true protein intake. 
  

MFTDN = 7 - ((FA + Ash + NPNCPE * CP/281) / 100) * 7 
 

MFTDN is used to calculate DE1X, DEp, and ME01. 
 
Total Digestible Nutrients at 1X Maintenance (TDN1X)  
Total digestible nutrients at 1X maintenance (TDN1X) gives a relative energy value for a feed using 
the traditional TDN approach. It is a calculated value and is used to calculate the digestibility 
discount multiplier in the NRC2001 system. Our method of calculating TDN1X varies slightly from 
NRC. NRC uses digested CP to calculate TDN1X but feeds high in NPN are given values of zero. 
In Spartan 3, TDN1X is always a calculated value and we can mirror the NRC system by using only 
digested true protein in the calculation. 
   TDN1X = tdNFC + tdNDF + tdTruP + 2.25 * tdFA - MFTDN 
  
TDN1X is used to determine the NRC digestion discounter and thus calculate ME01.  It is also used 
to calculate both the NRC and Spartan Fat-corrected TDN1X, and thus microbial protein yield. 
 
Equations to predict synchronized dietary TDN1X and fat‐corrected TDN1X values used in 
calculating digestibility discount for ME01 and for predicting microbial protein yield 
PredTDN1XConc = (RequiredNELDensity + 0.12) / 0.0245 
SyncTDN1XConc = if(DMISupply>ThresholdDMI, TDN1XConc, PredTDN1XConc) 
 
Spartan Fat-Corrected TDN1X for microbial yield equation to estimate MP 
SyncFatCorTDN1XConc = if(DMISupply>ThresholdDMI, ActualFatCorTDN1XConc, 

PredTDN1XConc) 
where Actual = if(FAConc<2, TDN1XConc, TDN1XConc - ((FAConc-2) * FAdigConc/100 
* 1.25) / ((100 - (FAConc-2))/100)) 

 
NRC 2001 Fat-Corrected TDN1X for calculating energy discount and microbial yield 
SyncNRC01FatCorTDN1XConc = if(DMISupply>ThresholdDMI, 

ActualNRC01FatCorTDN1XConc, PredTDN1XConc) 
where ActualNRC01FatCorTDN1XConc = if(EEConc<3, TDN1XConc, TDN1XConc - 
((EEConc-3)*FAdigConc / 100*2.25) / ((100 - (EEConc-3))/100)) 
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Protein Characteristics  
Protein is a key nutrient for milk 
production and growth.  Protein 
consists of amino acids, so amino 
acids are the building blocks for 
making milk and body proteins.  
More than half of the protein a 
cow eats is degraded in the 
rumen, but some escapes rumen 
degradation and passes to the 
small intestine intact.  Along with 
the protein of microbial cells that 
pass out of the rumen, this rumen 
undegraded feed protein can 
contribute to the flow of absorbed 
amino acids that can be 
metabolized by the cow.   
 
Spartan Dairy 3 uses the NRC 2001 system, with some slight modifications.  The two major 
changes of the Spartan system are:  
• In the Spartan 3 model, less RDP is needed to produce microbial protein than in the 2001 NRC 

model.  Thus, the RDP requirement is usually slightly lower and the N-potential microbial 
protein supply is slightly greater.  This is because we assume that RUP contributes to the 
availability of ruminal N by recycling, similar to the 1989 NRC and unlike the 2001 NRC.  

• In both systems, the supply of fat-corrected TDN1X is used to predict the energy-potential  
microbial protein yield with the same coefficient of 0.13 kg MCP/kg of fat-corr TDN1X.  
However, the fat-correction is less in Spartan 3 than in NRC 2001.  Without a fat-correction, an 
easy way to increase microbial protein yield would be to add fat, which has 2.25 times the 
TDN value of carbohydrates and proteins.  NRC subtracts all the energy of fat in predicting 
microbial protein yield (2.25 X), whereas Spartan 3 subtracts only the extra TDN of fat.  In 
other words, we assume that adding fat in place of carbohydrate will have no impact on 
microbial yield.  Thus, the Spartan 3 Metabolizable Protein (MP) supply will usually be 
slightly greater than that of the 2001 NRC Metabolizable Protein (MP01) supply.  

 
Crude Protein (CP)  
Crude protein (CP) is the nitrogen concentration of feeds (or diets) multiplied by 6.25 based on the 
assumption that the nitrogen concentration of feedstuffs averages 16%. CP includes both true 
protein and non-protein nitrogen which vary widely among feedstuffs.  Crude protein values entered 
in Spartan Dairy 3 must be in the range of 0 to 300 %DM.  CP is an input to several calculated 
nutrients in Spartan Dairy 3.  These include:  

• Metabolic fecal, total digestible nutrients (MF-TDN)  
• Non-fiber carbohydrate (NFC)  
• Total digestible true protein (tdTruP)  
• Rumen degraded protein (RDP)  
• Rumen degraded organic matter (RDOM) 

CP requirement = Metabolizable Protein requirement / 0.7 
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Rumen Undegraded Protein (RUP; Spartan 3 system)  
Rumen undegraded protein (RUP) is the fraction of CP that is not degraded before it passes from 
the rumen to the intestines.  This is also referred to as "bypass" or "escape" protein and is expressed 
as a percent of the total crude protein. Protein from animal sources is generally more resistant to 
degradation than protein from plant sources.  The RUP fraction is lower in ensiled feeds because of 
microbial degradation during ensiling and feedout.  Heat will increase the RUP fraction for plant 
proteins but consistency in temperature and time are critical.  The %RUP and %RDP in a feedstuff 
or ration must add up to 100%.  Thus, the amount of CP in a ration is the sum of the amount of RDP 
and the amount of RUP.  RUP is calculated from the A, B, and C fractions of each feed as follows. 
 
RUP = Bprot * AdditiveRUPAdjuster/100 * KpBprot/(KdBprot+KpBprot) + Cprot 
 
For feeds that do not contain any crude protein, the RUP concentration is 0 %CP. 
RUP requirement = Digested RUP requirement / 0.8 
 
Rumen Degraded Protein (RDP; Spartan 3 system)  
Rumen degraded protein (RDP) is the fraction of crude protein that is non-protein nitrogen (NPN) 
or that is true protein degraded before it passes from the rumen to the small intestine. This fraction 
of CP is available to the rumen microbes as a nitrogen source for protein synthesis. The %RUP and 
%RDP in a feedstuff or ration must add up to 100%.  RDP is calculated from the A, B, and C 
fractions of each feed as follows. 
 
RDP for a feed (in %CP) is calculated from RUP as follows:  

RDP = if(CP>0, 100 - RUP, 0) 
For feeds that do not contain any crude protein, the RDP concentration is 0 %CP.  
 
RDP requirement = Energy-potential Microbial CP supply / 0.75 – 0.15 * Dietary CP supply 
 
Metabolizable Protein (MP; Spartan 3 system)  
Metabolizable protein (MP) is the total amino acids absorbed from the true protein that is digested 
post-ruminally, using the Spartan 3 system. MP is derived from undigested feed protein, from 
microbial protein, and from endogenous protein (for example, the protein of sloughed cells of the 
digestive tract).  Microbial protein supply is the lesser of the potential microbial yield from 
fermented energy and the potential from ruminally-available N.  Amino acids are required by 
animals rather than CP as they are the building blocks for the synthesis of various proteins vital for 
maintenance, growth, reproduction, and lactation. Some amino acids have other unique functions 
that contribute to their requirement and thus to the MP requirement. 
 
In Spartan Dairy 3 there are no MP nutrient values for individual feeds; MP supply is calculated for 
the entire diet. Normally, the program uses the default Spartan 3 MP supply system that is a 
modification of the NRC 2001 system. However, the user can choose between the Spartan 3 MP 
supply system or an alternate system based on rumen degraded organic matter (RDOM). See the 
Metabolizable Protein Systems help topic in Chapter 9 for more information.  
 



Equations used to calculate the default Spartan 3 MP supply 
MPSupply = RUPdigSupply + EndoGutMPSupply + MicroMPSupply 

EndoGutMPSupply = 0.4 * 1.9 * 6.25 * SyncDMISupply/1000 

MicroMPSupply = 0.64 * Sp3MCPSupply 

Microbial crude protein supply is the lesser of energy- and N-potential microbial yield: 
MCPSupply = MIN(Sp3_EMCPSupply, Sp3_NMCPSupply) 

 
Sp3_EMCPSupply = 0.13 * SyncDMISupply * Sp3FatCorTDN1X/100 * TDNAdjuster/100 
* AdditiveProteinAdjuster/100                
 where FatCorTDN1X is shown at end of Energy Characteristics 
 
Sp3_NMCPSupply = 0.75 * (RDPSupply + 0.15*CPSupply) 

 
MPConc = if(DMISupply>0, MPSupply/DMISupply*100, 0) 
 
Equations to calculate MP requirement 
MP requirement is the summation of: 

MP maintenance = EndoGutMPSupply/0.67   {Endogenous MP} 
 + 0.03 * DMI – 0.125 * 0.64 * E-potential MCP {MP fecal} 
 + 0.0041 * NPBW^0.5 {Urinary MP} 
MP milk = Milk true protein output / 0.67 
MP frame gain = Net Protein for growth / MP to NP converter 
 MP to NP converter = 0.834 – 0.545* Current NP3BW /Mature BW  {minimum =0.289} 
 NP for growth = dFrameGain * (268 – 29.4* NEg for FrameGain/dFrameGain)/1000 
 where dFrameGain is daily frame gain set by user and NEg is defined in energy section 
 
MP condition change = dBC Protein change / (0.492 if gaining or 0.67 if losing condition) 
 dBC Protein change = BC Protein concentration {g/kg}* dBCchange / 1000 
 BC Protein concentration = 122.9 – 21.83 * Current BCS  
 where dBCchange is daily body condition change in kg/day set by user 
    
MP activity = 0.30 * NEL for activity 
MP thermal = 0.10 * NEL for thermoregulation 
MP pregnancy = [Max of (MP gr uterus + MP mam gain) and 67*NEL pregnancy] / 1000 
 MP gr uterus = NP gr uterus / 0.33 
 NP gr uterus = If DaysPreg>100, (0.69 * DaysPreg – 69.2) * CalfBirthWt^0.75 / 45^0.75 
 MP mam gain = NP mam gain / 0.5 
 NP mam gain = 0.2 * dMamGain/1000 
 dMamGain = [0.046 * (DaysPreg – 256) with max of 0.46] * CowBW adjustment 
 Cow BW adjustment = (0.8 for Lact 0 or 0.9 for Lact 1) * Mature BW^0.75 / 650^0.75 
 

This MP requirement is similar to that of NRC2001.  The equations for maintenance, milk, frame 
gain, and condition change have been simplified in form.  The equations for activity and 
thermoregulation were added to give reasonable protein to energy ratios for diets of cows that are 
active or stressed by heat or cold.  The equation for pregnancy is similar to that of NRC2001 with 
an added component for mammary growth in the last 3 wk of pregnancy.  
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Rumen Undegraded Protein Digestibility (RUPdig; Spartan 3 system)  
Rumen undegraded protein digestibility (RUPdig) is the intestinal digestibility of the RUP fraction.  
This varies widely by feedstuff and especially important for high RUP high protein feeds like 
heated soy proteins and animal proteins.   
 
Note: When balancing or evaluating diets, the amount of difference between RUPdig supply and 
requirement will be equal to the amount of difference between MP supply and requirement because 
RUPdig requirement is dependent on how much MP is supplied from other sources.  Thus, RUPdig 
on the home tab provides the same information as MP in the protein tab.   
 
RUPdig (in %RUP) is used to calculate the concentration of total digested true protein (tdTruP) of a 
feed.  
 
The requirement for digested RUP is the MP requirement minus the amount of MP supplied by 
microbial cells and endogenous protein.   

RUPdig requirement = MP requirement - Endogenous Gut MP supply - 0.64 * MCP supply 
 
A Protein Fraction (A prot)  
The A protein fraction (A prot) is one of the three fractions (A, B, C) of crude protein that 
represents the percentage of CP (mostly NPN) that is instantaneously solubilized at time zero and is 
assumed to have a degradation rate of infinity. It is determined chemically as that fraction of CP 
that is soluble in borate-phosphate buffer but not precipitated with trichloroacetic acid. 
If crude protein for a feed is greater than 0 %DM, the sum of A, B and C protein fractions totals 
100%. In Spartan Dairy 3, the A protein fraction is calculated by difference as,  

Aprot = 100 - (Bprot + Cprot) 
 
B Protein Fraction (B prot)  
The B protein fraction (B prot) is one of the three fractions (A, B, C) of crude protein that represents 
potentially degradable true protein. The amount of this fraction degraded in the rumen is dependent 
upon rates of degradation and passage, which vary greatly across feeds. It is determined by 
subtracting the A and C fractions from the total CP. 
If crude protein for a feed is greater than 0 %DM, the sum of A, B and C protein fractions totals 
100%. The concentration of B protein fraction for a feed is used to calculate the concentration of 
rumen undegraded protein in a feed.  
 
C Protein Fraction (C prot)  
The C protein fraction (C prot) is one of the three fractions (A, B, C) of crude protein that represents 
undegradable nitrogenous compounds. It is determined chemically as the percentage of total CP 
recovered with ADF. It contains nitrogenous compounds associated with lignin and tannins and heat 
damaged true proteins and amino acids. 
If crude protein for a feed is greater than 0 %DM, the sum of A, B and C protein fractions totals 
100%. The concentration of C protein fraction for a feed is used to calculate the concentration of 
rumen undegraded protein in a feed.  
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Digestion Rate of B Protein Fraction (Kd Bprot)  
Kd Bprot is the fractional rate of degradation of the B fraction of crude protein as %/h. The total 
rate of disappearance of the B fraction from the rumen is the sum of Kd and Kp. Kd is used with Kp 
to calculate ruminal degradation of the B fraction as Kd/(Kd+Kp). 
 
Passage Rate of B Protein Fraction (Kp Bprot)  
Kp Bprot is the fractional rate of passage of the B fraction of crude protein from the rumen as %/h. 
The total rate of disappearance of the B fraction from the rumen is the sum of Kd and Kp. Kp is 
used with Kd to calculate ruminal degradation of the B fraction as Kd/(Kd+Kp).  
Spartan Dairy 3 calculates Kp Bprot for a feed differently for different types of feeds using the dry 
matter intake of the ration as a percentage of body weight (SyncDMIasPercentBW), the 
concentration of feed concentrates in the ration as a percentage of ration dry matter 
(SyncConcAsPercentDM), and NDF. In a ration Kp Bprot for a feed is calculated as follows:  
  
where, 
   SyncDMISupply = if(DMISupply>ThresholdDMI, DMISupply,DMIReqt) 
   SyncDMIasPercentBW = SyncDMISupply / Current_TotalBW * 100 
and, 
   DMIatMaint {kgs} = NELMaintReqt {Mcals/day} / 1.3 
 
   DMI_MM = if(SyncDMISupply<DMIatMaint, 1, SyncDMISupply/DMIatMaint ) 
   SyncConcAsPercentDM = if(DMISupply>ThresholdDMI, ConcSupply/DMISupply*100,  

if(AnimalType=LactatingCow,40,20) ) 
 
ThresholdDMI is set at 50% of the DMI requirement. DMIatMaint estimates the dry matter intake 
requirement at 1X maintenance using the maintenance requirement of NEL.  See the comment 
about Synchronized variables at beginning of Energy Characteristics for help on this.   
 
Since feeds in a feed library are not associated with a ration, the values for SyncDMIasPercentBW 
and SyncConcAsPercentDM are approximated using the following constants:  
  SyncDMIasPercentBW = 4.1  
  SyncConcAsPercentDM = 50  
 
Non-protein Nitrogen in Crude Protein Equivalents (NPNCPE)  
Non-protein nitrogen in crude protein equivalents (NPNCPE) is the non-protein nitrogen fraction 
converted to CP equivalents by multiplying by 6.25. This is used to correct NFC for NPN. 
NPNCPE is also used to calculate total digestible true protein (tdTruP), metabolic fecal total 
digestible nutrients (MF-TDN), and rumen degraded organic matter (RDOM).  
 
Rumen Undegraded Protein, NRC 1989 (RUP 89)  
Rumen undegraded protein is the fraction of CP that is not degraded before it passes from the rumen 
to the intestines. This is also referred to as "bypass" or "escape" protein and is expressed as a 
percent of CP. CP is the sum of RDP and RUP. 
The program contains two RUP nutrient columns, RUP and RUP89. The RUP89 value for a feed is 
the 'book' value from the NRC 1989 guidelines. It has been included to provide a reference and 
comparison to the earlier guidelines and Spartan Dairy 2. You can edit and modify this value for a 
feed. The Spartan Dairy 3 RUP value for a feed is calculated and cannot be edited directly. 
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Rumen Degraded Protein, NRC 2001 (RDP 01) 
RDP01 is the fraction of CP that is non-protein nitrogen (NPN) or that is true protein degraded 
before it passes from the rumen to the small intestine. This fraction of CP is available to the rumen 
microbes as a nitrogen source for protein synthesis. RDP01 is calculated from the A, B, and C 
fractions of each feed exactly as is RDP in the Spartan 3 system.  However, the requirement for 
RDP and RDP01 are not the same because the amount of RDP needed for microbial protein is not 
the same.  See the N-potential MCP supply of the MP and MP01 equations.   
 
Metabolizable Protein, NRC 2001 (MP 01) 
MP01 is the total amino acids absorbed from the true protein that is digested post-ruminally, using 
the NRC 2001 system. MP01 is derived from undigested feed protein, from microbial protein, and 
from endogenous protein (for example, the protein of sloughed cells of the digestive tract).  
Microbial protein supply is the lesser of the potential microbial yield from fermented energy and the 
potential from ruminally-available N.   

MP01Supply = RUPdigSupply + EndoGutMPSupply + NRC01MicroMPSupply 
NRC01MicroMPSupply = 0.64 * NRC01MCPSupply 
NRC01MCPSupply = MIN(NRC01_EMCPSupply, NRC01_NMCPSupply) 
NRC01_EMCPSupply = 0.13 * SyncDMISupply * NRC01FatCorTDN1X/100 * TDNAdjuster/100 
NRC01_NMCPSupply = 0.85 * RDPSupply 
MP01Conc = if(DMISupply>0, MP01Supply/DMISupply*100, 0)  
The MP 01 requirement is the same as the MP requirement in the Spartan system, except the MP for 
mammary gain is not included in the requirement for a cow in late pregnancy. 
 
Total Digestible True Protein (tdTruP) 
Total digestible true protein (tdTruP)is the digestibility of the true protein in feeds as a percent of 
the feed DM. TdTruP for a feed is calculated using feed type, CP, NPNCPE, RUPdig, Aprot, Bprot, 
Cprot, and Kd Bprot: 

tdTruP = CP/100 * (AProt - NPNCPE + BDigested + RUPdig/100 * (CProt + BPassed) ) 
where, 
  KpFeedType = if(FeedCategory="DF",4,if(FeedCategory="WF",4,if(FeedCategory="MIX",5,6))) 
   BDigested = BProt * (KdBProt / (KdBProt + KpFeedType)) 
   BPassed = BProt * (KpFeedType / (KdBProt + KpFeedType)) 
tdTruP is used to calculate DE1X and TDN1X by the summative approach. These, in turn, are used 
to calculated a feed's energy concentration (ME, NEL, ME01, NEL01). 
 
Neutral Detergent Insoluble Crude Protein (NDICP)  
Neutral detergent insoluble crude protein (NDICP) is the fraction of crude protein that is insoluble 
in neutral detergent and is recovered in NDF. It is used to calculate energy concentration using a 
summative approach to prevent accounting for the CP contained in the NDF twice. 
NDICP is used to calculate NFC and tdNDF. 
 
Acid Detergent Insoluble Crude Protein (ADICP)  
Acid detergent insoluble crude protein (ADICP) is the fraction of crude protein that is insoluble in 
acid detergent and is recovered in ADF. It contains nitrogenous compounds associated with lignin 
and tannins and heat damaged true proteins and amino acids. It is also called "heat-damaged" 
protein or "bound" protein. 
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Carbohydrate Characteristics  
 
Although fiber is a carbohydrate, the carbohydrate tab includes only non-fiber carbohydrate (NFC) 
fractions.  Requirements are not given for any of the NFC fractions.  For some of these, such as 
starch and rumen-degraded starch, optimum dietary concentrations do exist under specific 
situations.  Spartan 3 enables the user to track NFC fractions for enhanced diet formulation.  
 
Non‐fiber Carbohydrate (NFC)  
NFC is the portion of the carbohydrate portion of a feed or ration that is not fiber as measured by 
NDF.  It is generally calculated by difference.   

NFC = 100 - ((NDF - NDICP) + CP * (1.0 - 0.006448 * NPNCPE) + FA + Ash) 
NFC is used to calculate total digestible non-fiber carbohydrate (tdNFC) in a feed, which is used to 
calculate energy values.  Note that NFC is calculated slightly differently than in 2001 NRC.  
Spartan 3 corrects CP for NPN so that NPN is not multiplied by 6.25.   NFC is also used to calculate 
the concentration of soluble fiber (SolFiber).   
 
Non‐fiber Carbohydrate Digestibility (NFCdig)  
Non-fiber carbohydrate digestibility (NFC dig) is the percentage of NFC that is digested in the total 
tract of the animal, whether in the rumen, the small intestine, or the large intestine. This is similar to 
the PAF value found in NRC 2001.  However, whereas the PAF value in NRC can exceed 100%, 
NFC digestibility is never greater than 100%.   
 
NFC dig is used to calculate total digestible non-fiber carbohydrate (tdNFC).  
 
Total Digestible Non‐fiber Carbohydrate (tdNFC)  
Total digestible Non-fiber carbohydrate (tdNFC) is the amount of digestible NFC as a percentage of 
feed DM.  

tdNFC = NFC * (NFCdig / 100) 
tdNFC is used to determine the energy available to the cow using a summative approach. It is an 
input used to calculate both total digestible nutrients (TDN1X) and digestible energy (DE1X), both 
at 1X maintenance.  
 
Starch 
Starch is the storage carbohydrate in grains with a very wide range in rate of digestion in the rumen 
and ruminal digestibility. Starch is composed of long chains of the sugar glucose that are branched 
(amylopectin) or not-branched (amylose). 
Starch is used to calculate the concentration of soluble fiber (SolFiber) in a feed and to calculate 
rumen degraded organic matter (RDOM) for one option of predicting microbial protein.  
 
Rumen Degraded Starch (RDStarch)  
Rumen degraded starch (RDStarch) is the fraction of starch that is degraded by microbes in the 
rumen. RDStarch is used to determine total organic matter degraded by rumen microbes and 
available for their growth. In addition, excess ruminally degraded starch can result in decreased 
fiber digestion, poor feed efficiency, and ruminal acidosis. Many factors affect the digestion of 
starch and the major constraint is access to the starch granules that are embedded in endosperm 
proteins. Rumen degradation is increased by increasing surface area. Surface area is increased by 
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rolling or grinding, steam flaking to disrupt endosperm proteins, and solublization of endosperm 
proteins by ensiling. 
RDStarch is used to calculate rumen degraded organic matter (RDOM).  
 
Sugar 
Sugar is assumed to be completely degraded in the rumen and used to determine total organic 
matter degraded by rumen microbes and available for their growth. Sugars include monosaccharides 
such as glucose or fructose in non fermented feeds or disaccharides such as sucrose (glucose plus 
fructose) in molasses or lactose (glucose plus galactose) in whey. Sugars are rapidly fermented and 
can be used to alter populations of ruminal microbes. Effects on milk production have not been 
consistent but addition of sugars generally increase ruminal butyrate production. 
Sugar is used to calculate the soluble fiber (SolFib) in a feed and to calculate rumen degraded 
organic matter (RDOM) for one option of predicting microbial protein. 
 
Ingested Fermented Acids (INFA)  
Ensiled feeds contain varying fractions (up to 7% or more) of fermentation acids (primarily lactate 
and acetate with some propionate). These acids are not effectively utilized for growth by ruminal 
microbes and InFA is used to correct the total OM available for microbial growth. 
Ingested Fermented Acids is used to calculate the concentration of soluble fiber (SolFiber) in a feed.  
 
Soluble Fiber (SolFiber)  
Soluble fiber (SolFiber) is the fiber fractions that are soluble in neutral detergent solution and are 
not recovered in the NDF fraction. SolFiber includes pectin and gums. Citrus and beet pulp are 
sources of pectin as are immature legumes. Soluble fiber is fermented by microbes to short chain 
fatty acids in the rumen and large intestine but not digested in the small intestine by mammalian 
enzymes. Spartan Dairy 3 calculates Soluble fiber from non-fiber carbohydrate (NFC), starch, 
sugar, and ingested fermented acids (INFA) by difference:  

SolFiber = NFC - Starch - Sugar - InFA 

In turn, SolFiber is used to calculate rumen degraded organic matter (RDOM). 
 
Rumen Digestible Soluble Fiber (RDSolF)  
Rumen digestible soluble fiber (RDSolF) is the fraction of soluble fiber that is degraded by 
microbes in the rumen. RDSolF is used to calculate rumen degraded organic matter (RDOM) as one 
option for predicting microbial growth. The digestibility of SolFiber is generally quite high. 
 
Rumen Degraded Organic Matter (RDOM)  
Rumen degraded organic matter (RDOM) is the total organic matter degraded in the rumen 
calculated as the sum of sugar (assumed to be completely degraded in the rumen), rumen degraded 
starch, rumen degraded soluble fiber, rumen degraded NDF, and rumen degraded true protein. 

RDOM = RDNDF*NDF/100 + RDStarch*Starch/100 + Sugar  
 + RDSolFiber*SolFiber/100 + (RDP-NPNCPE)*CP/100 

RDOM is used to determine the energy available for microbial protein production in the rumen for 
one of the alternate metabolizable protein systems (RDOM). 
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Lipid Characteristics  
 
The lipid tab includes several fractions.  Requirements are not given for any of these, and cows 
seldom require any supplemental fat in their diets.  Diets for lactating cows diets should contain less 
than ~6% total fat, and diets with more than 4% fat frequently decrease feed intake. Spartan 3 
enables the user to track lipid fractions for enhanced diet formulation.  
 
Ether Extract (EE)  
Ether extract (EE) is the crude fat concentration of a feed which includes fatty acids (FA) as well as 
glycerol and various amounts of wax, galactolipids, steroids, and phospholipids. The EE of feeds 
averages about 1 percentage unit higher than the FA concentration. EE is used to calculate the 
concentration of fatty acids (FA) in a feed.  
The concentration of EE in a diet is used to calculate the NRC 2001 fat-corrected TDN1X 
concentration of a diet. This in turn, is a key input to both the NRC 2001 energy supply and NRC 
2001 metabolizable protein subsystem. 
 
Fatty Acids (FA)  
Fatty acids (FA) are carbon chains of various lengths that contain about twice the energy of 
carbohydrates or proteins, once absorbed. They can be saturated (no double bonds) or unsaturated 
(one or more double bonds). They are generally in the form of triglycerides with 3 FA esterified to a 
glycerol backbone but can be rapidly hydrolyzed to free FA in the rumen. The predominant FA 
from feedstuffs contains 16 or 18 carbons and FA from animal sources are generally more saturated 
than FA from plants. Spartan Dairy 3 calculates FA from ether extract (EE) and feed type.  

Fatty Acid (FA) Calculations  
Feed type  Equation 
Non-lipid feeds (most feed stuffs)  FA = EE - 1  
Fatty acid feeds (FA) FA = EE 
Triglyceride feeds (TRI) FA = EE * 0.9  

 
Saturated fatty acids (SFA) are the percentage of total FA in feeds that contain no double bonds—
they are already fully saturated with hydrogens and therefore cannot be biohydrogenated.  Saturated 
triglycerides are resistant to hydrolysis to free FA in the rumen.  Total FA are the sum of SFA, 
MUFA, and PUFA (SFA + MUFA + PUFA = 100%).  
 
Monosaturated Fatty Acids (MUFA)  
Monosaturated fatty acids (MUFA) are the percentage of total FA in feeds that contain one double 
bond which can be saturated in the rumen via biohydrogenation by rumen microbes. Total FA are 
the sum of SFA, MUFA, and PUFA (SFA + MUFA + PUFA = 100%). 
In Spartan Dairy 3 MUFA is calculated using the following equation:  

MUFA = 100 - SFA - PUFA 

MUFA is used to calculate intestinally digested unsaturated fatty acids (IDUFA). 
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Polyunsaturated Fatty Acids (PUFA)  
Polyunsaturated fatty acids (PUFA) are the percentage of total FA in feeds that contain two or more 
double bonds which can be completely or partially saturated in the rumen via biohydrogenation by 
rumen microbes. Biohydrogenation intermediates can pass from the rumen before they are 
completely saturated and have been implicated in milk fat depression. Total FA are the sum of SFA, 
MUFA, and PUFA (SFA + MUFA + PUFA = 100%). 
PUFA is used to calculate intestinally digested unsaturated fatty acids (IDUFA). 
 
Biohydrogenated Fatty Acids (BHFA)  
Biohydrogenated fatty acids (BHFA) are the fraction of total FA that are biohydrogenated in the 
rumen as a percent of total FA.  Saturated FA (SFA) are already completed saturated with hydrogen 
and therefore cannot be biohydrogenated further.  Thus, the percent BHFA in a diet  cannot exceed 
the sum of MUFA and PUFA. Not all MUFA and PUFA will be biohydrogenated in the rumen, and 
the degree of hydrogenation will depend on the feed.  Some fat sources are more protected from 
rumen action than others. 
 
BHFA produce trans FA and contribute to the Rumen Unsaturated Fatty Acid Load and are 
implicated in the pathways that cause milk fat depression.  Generally, biohydrogenation of  PUFA is 
a greater problem than biohydrogenation of MUFA.  Thus, one option is to only consider PUFA 
that can be hydrogenated for this characteristic.   
 
BHFA is used to calculate intestinally digested unsaturated fatty acids (IDUFA).   
  
Intestinally Digested Unsaturated Fatty Acids (IDUFA) 
Intestinally digested unsaturated fatty acids (IDUFA) are the fraction of FA that are absorbed as 
unsaturated FA in the intestines as a percent of total FA. Unsaturated FA absorbed in the small 
intestine have been implicated in the depression of energy intake and a maximum seems warranted.   
In Spartan Dairy 3 IDUFA is calculated using the following equation:  

  IDUFA = (MUFA+PUFA) * (100-BHFA)/100 * FAdig/100 
 
Fatty Acid Digestibility (FAdig) 
Fatty acid digestibility (FA dig) is the digestibility of FA in the total tract which varies by source. 
While digestibility is similar for saturated and unsaturated free FA, saturated FA that are esterified 
and in the form of triglycerides have much lower digestibility. 
FAdig is used to calculate IDUFA and total digested fatty acids, which is used in the energy system. 
 
Total Digested Fatty Acids (tdFA)  
Total digested fatty acids (tdFA) are the FA digested in the total tract as a percentage of DM of a 
feed.  The calculation for tdFA is as follows:  

tdFA = FA * FAdig/100 

tdFA is used to calculated energy concentration (DE1X, ME01) by the summative approach. 
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Macromineral Characteristics  
There are seven macromineral elements important in dairy rations: 

• Calcium (Ca) 
• Phosphorus (P) 
• Magnesium (Mg) 

• Potassium (K) 
• Sodium (Na) 
• Chlorine (Cl) 

• Sulfur (S) 

Additionally the Dietary Cation-Anion Difference (DCAD) involving Na, K, Cl and S is often  
considered in ration formulation for dry cows.  
 
NOTE: Laboratory wet chemistry methods must be used to accurately measure total concentrations 
of each mineral element in feeds. Near-infrared spectrometry (NIR) ‘detects’ covalent binding 
between mineral elements and the organic matrix, but not unbound element. Some mineral elements 
or some varying proportions of specific elements exist covalently bound to feed organic matter and 
some do not. And, the degree of binding varies both among feeds and also differs for the different 
mineral elements. Therefore, NIR is not practically and universally applicable to detect total 
element concentrations across a wide variety of feeds and supplements used in rations. 
 
Suggested Maximum Tolerable Concentrations for Macrominerals in Dairy Rations  

Nutrient Concentration in Ration Dry Matter  
Calcium (Ca)  2.0 %DM (NRC 2001 gives no maximum for Ca)  
Phosphorus (P)  1.0 %DM  
Magnesium (Mg)  0.5 %DM  
Potassium (K)  3.0 %DM  
Sodium (Na)  1.6 %DM  
Chloride (Cl)  2.4 %DM  
Sodium Chloride (NaCl)  4.0 %DM  
Sulfur (S)  0.4 %DM  

 
Availability (efficiency of absorption) 
Not all of the various mineral elements in rations are available for absorption. Therefore, Spartan 3 
adopted the NRC (2001) approach of using an absorption coefficient to supply adequate mineral 
elements in rations. Where research results permitted, an absorption coefficient was assigned for the 
mineral element in concentrates, forages, and inorganic mineral sources. Sufficient data were not 
available for the NRC committee to use this approach for sulfur (S). Spartan 3 differs slightly from 
NRC. We did not use absorption coefficients for the electrolytes -- K, Na, and Cl; these elements 
are 90% absorbed and the extra column for amount absorbed seemed unnecessary. 
 
 Absorption Coefficients (%) for Macrominerals in Spartan Dairy 3    

Macromineral Element   For Concentrates For Forages 
Calcium (Ca)   60 30 
Phosphorus (P)   70 64 
Magnesium (Mg)   16 16 

Notes:  
• Absorption coefficients differ among supplemental inorganic mineral sources; see Spartan 3 

feed library for each individual inorganic mineral element source.  
• The 2001 NRC expresses absorption coefficients as proportions (i.e., 0 to 1) while Spartan 3 

expresses absorption coefficients as percent absorption (i.e., 0 to 100).  
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Match mineral supplement to requirements, without under- or over-feeding 
Evaluate carefully proposed or formulated rations to be sure each mineral element is not under-fed 
or grossly over-fed relative to the requirement. Individual mineral elements can be incorrectly fed if 
low or high concentrations exist in base ration ingredients or if the mineral/vitamin supplement 
included in the ration does not complement mineral content of the base ingredients of the ration to 
meet requirements of the animal. If the risk of under- or over-supplementation is apparent because 
of the mineral/vitamin supplement used in the formulation, a different or newly formulated 
mineral/vitamin supplement must be used to eliminate the risk for each essential mineral and 
vitamin. 
 
Calcium (Ca) 
Calcium (Ca) is required for bone growth, muscle function, and secretion into milk. Cows use bone 
Ca to help meet their needs at the onset of lactation, but it is not desirable for them to do so except 
immediately around calving time. The absorption coefficient for Ca varies considerably. The 
availability of Ca is about 30% for most forages, about 60% for most concentrates, and as high as 
95% for some mineral supplements. The typical lactating cow requires about 200 g of total Ca and 
80 g of absorbed Ca per day, which would be met with about 0.8% Ca in the diet. The Ca 
requirement in Spartan 3 is similar to that of NRC 2001, but will be slightly higher (see below). 
There is seldom any reason to exceed our requirement. The Ca content of major feed ingredients 
should be determined using wet chemistry laboratory methods for accurate quantification. See 
MacroMineral Characteristics for general information on feeding guidelines, maximum tolerable 
limits, and mineral absorption. 
 
Most dairy diets need supplemental Ca. Calcium should be supplemented by adding limestone, 
dicalcium phosphate, or a commercial mineral premix. Animals fed rations high in alfalfa may need 
little supplemental Ca. 
 
High dietary Ca concentrations during the late dry period may impair a cow’s ability to meet the 
intense Ca needs at the onset of lactation, resulting in hypocalcemia.  Clinical hypocalcemia is seen 
as milk fever. One option for preventing milk fever is to feed cows a ration containing less than 
0.6% Ca (and perhaps even lower if practically possible) during the last 3 weeks before calving.  A 
better option is to carefully control the Dietary Cation-Anion Difference.    
 
Typically rations should contain more Ca than P, simply to meet the animal’s requirements. 
However, the ratio of Ca to P is not very important unless Ca or P is deficient in the ration. As long 
as the requirement for each element is met, the ratio can vary over a fairly wide range, from 1-to-1 
to 8-to-1 without affecting milk production. It is still prudent to monitor the Ca to P ratio (Ca:P) in 
diets of young calves to ensure it falls between 1.25 and 1.50. 
 
Overfeeding Ca is unlikely to cause major problems. If Ca is overfed as the result of high Ca 
concentrations of forages, there is little to be concerned about, except for dry cows prone to milk 
fever. If, however, Ca is being over-supplemented because your mineral/vitamin supplements are 
not matched well to the ‘base’ ration, then you should consider finding a new source for minerals 
and/or vitamins that has a better blend. We generally recommend that blended supplements for 
mineral elements contain enough Ca for most rations, and that extra limestone be added as needed.  
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The requirement for Ca in Spartan 3 is similar to that of NRC 2001.  However, we added in a 
requirement for activity to keep the concentration consistent, and we adjusted the requirement for 
milk production to reflect the discussion in the NRC text regarding milk protein.  Rather than use 
different Ca requirements for each breed of cattle, as in NRC2001, we adjust the Ca requirement 
with milk protein content.  This approach is simpler and consistent and reflects the intent of the 
NRC (see page 107 of NRC 2001).   
 
AbsCa requirement (g/d) = 0.0318 x body weight + 0.41 x milk protein % x milk yield +  ~11 x 
frame gain + 1.0 x NEL for activity + about 0.914 x calf birth weight x (days pregnant above 170).  
The actual requirements for frame gain and for pregnancy are more complicated than this (see NRC 
2001). For nonlactating cows and heifers, the 0.0318 x body weight is replaced with 0.0162 x body 
weight.   
 
Phosphorus (P)  
Phosphorus (P) is needed for bone formation, energy metabolism, cellular regulation, and buffer 
systems. The absorption coefficient for P varies. The availability of P is about 60% for most grains, 
70% for most forages, and 75 to 90% for most mineral supplements. The typical lactating cow 
requires about 90 g of total P and 60 g of absorbed P per day, which would be met with about 0.4% 
P in the diet. The P requirement in Spartan 3 is similar to that of NRC 2001 (see below).  See 
MacroMineral Characteristics for general information on feeding guidelines, maximum tolerable 
limits, and mineral absorption. 
 
Current data gives no justification for exceeding our requirement.  The P content of major feed 
ingredients should be determined using wet chemistry laboratory methods for accurate 
quantification. As new data are reported on P availability of feeds, the absorption coefficient for P 
should be altered in the Spartan feed libraries. 
 
If supplemental P is needed, it can be supplemented by adding dicalcium phosphate, monosodium 
phosphate, another appropriate inorganic mineral source (see Feed Library), or a commercial 
premix or supplement to the ration.  
 
NOTE: Attention to phosphorus in animal feeding has intensified in recent years to reduce the risk 
of P pollution in aquatic biosystems.  Too often, P is overfed, either because of excess supplemental 
P or because the diet includes a high proportion of a high P byproduct feed.  Information on P 
excretion can be viewed in Ratios and Relationships. 
 
The requirement of P for lactating cows was reduced in the NRC 2001 compared to previous 
recommendations. This reflects new research which shows that the efficiency of absorption of 
ration P is higher than once believed and that the maintenance requirement for P is less than 
previously estimated. 
 
AbsP requirement (g/d) = 1.0 x DM intake + 0.002 x body weight + 0.9 x milk yield +  ~6 x frame 
gain + 1.0 x NEL for activity + about 0.382 x calf birth weight x (days pregnant above 138).  The 
actual requirements for frame gain and for pregnancy are more complicated than this (see NRC 
2001).  For heifers, the 1.0 x DM intake is replaced with 0.8 x DM intake.   
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Consider these specific ration formulation and feeding management strategies to more accurately 
feed P at requirements and minimize excess P. 

1. Analyze feeds for P content. P concentrations may vary considerably, even for the same 
feeds from the same farm. The P content of feed byproducts especially should be determined 
routinely. Phosphorus should be determined using wet chemistry laboratory methods for 
accurate quantification. Near-infrared spectrometry (NIR) is not practically and universally 
reliable to detect element concentrations among a wide variety of feeds (especially 
byproduct ingredients) and supplements.  

2. Use the actual %P of commercial supplements. Not all feeds called ‘dical’ are pure 
dicalcium phosphate. Pure dical, ‘Ca 23%:P 18%’ is listed in the Spartan 3 Feed Library.  
Be sure to add the supplement you use to the Spartan feed library with the actual 
concentrations provided by the manufacturer.   

3. Formulate rations knowing that the bioavailability of ration P is quite high. In typical 
rations the absorption coefficient of P in the overall ration is generally close 0.70 or greater. 
The absorption coefficient for P from typical supplemental inorganic sources is 0.75 or 
greater (see Spartan 3 Feed Library). Additionally, ruminal microbes release almost all of 
organically bound phytate-P in feeds rendering that P readily available for absorption.  

4. Formulate rations to meet but not exceed P requirements. Spartan 3 will help you do this 
accurately. As an additional check use this rule of thumb for mature lactating Holstein cows: 
about 1 gram of P is needed for each pound of milk produced; this will supply the needs for 
lactation, maintenance, growth and pregnancy. This is typically provided with 0.32 to 0.38% 
ration P (dry matter basis) depending on feed intake and milk yield. Greater concentrations 
are not necessary unless feed intake is depressed. Rations for replacement heifers with 0.25 
to 0.30% P provide P requirements at normal feed intake rates, depending on body size and 
growth rate.  

5. Does the particular ration need any P supplementation at all? The basal ration 
ingredients (such as forages, grains and by-product ingredients) often contain enough P to 
meet requirements. All P in excess of requirements simply results in more manure P.  

6. Consider alternative feeds with lower P content for the ration. If the basal ration 
ingredients contain more P than needed, alternative feedstuffs should be considered. The 
cost of managing excess manure P should be considered when comparing feeds.  

7. Consider grouping cows and feeding them to meet P requirements. Feeding the same 
diet to all cows results in significant overfeeding of P to low producing cows and thus 
excess manure P.  

8. Choose mineral supplements to accurately match the basal feedstuffs for meeting P 
requirements. We generally recommend that blended supplements for mineral elements 
contain very little P, so that P can be added only when it is needed. 

 
Magnesium (Mg)  
Magnesium (Mg) is essential in every major metabolic pathway and is vital for normal nerve and 
muscle function and bone formation. The absorption coefficient for Mg varies considerably. The 
availability of Mg is less than 10% for some feeds but may be as high as 90% for some mineral 
supplements. The Mg requirement in Spartan 3 is the same as in NRC 2001, with a small addition 
for activity (see below).  See MacroMineral Characteristics for general information on feeding 
guidelines, maximum tolerable limits, and mineral absorption. 
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The Mg content of major feed ingredients should be determined using wet chemistry laboratory 
methods for accurate quantification, especially in situations where a deficiency might be expected. 
Mg supplementation is often needed in rations containing high amounts of corn silage or in cattle 
grazing lush pasture. The most common supplements are commercial premixes, magnesium oxide, 
or magnesium sulfate.  
Overfeeding Mg is not a problem; however, diets should never exceed 0.5% Mg (dry matter basis). 
If Mg is being over-supplemented because your mineral/vitamin supplements are not matched well 
to the base ration, then you should find a new mineral source that will supply Mg closer to the 
required concentration. 
 
The Mg requirement in Spartan 3 is essentially that of NRC 2001.  AbsMg requirement = 0.003 x 
body weight + 0.15 x milk yield + 0.45 x frame gain + 0.2 x NEL for activity + 0.33 x calf birth 
weight adjustment if days pregnant >190.   
 
Potassium (K)  
Potassium (K) is required for normal water balance, acid-base regulation, nerve and muscle 
function, protein and energy metabolism, as well as other functions. The absorption coefficient for 
K is about 90% for most feeds; for this reason, we did not include absorbed K in Spartan 3 even 
though it is part of the NRC 2001 model. The typical lactating cow requires about 270 g of K per 
day, which would be met with about 1.1% K in the diet. The K requirement in Spartan 3 is similar 
to that of NRC (see below). See MacroMineral Characteristics for general information on feeding 
guidelines, maximum tolerable limits, and mineral absorption. 
 
Supplementation of K is seldom needed because most forages contain lots of it. Supplementation 
may be needed for rations based on corn silage. In addition, supplementation may help alleviate 
heat stress. Good sources are potassium chloride (KCl) or commercial supplements.  
 
Overfeeding of K seldom causes any problem, except in dry cows. NOTE: High dietary K in dry 
cow diets increases the risk of hypocalcemia (milk fever) at calving and  may contribute to 
increased udder edema. High K also may increase the need for Mg supplementation. If K is being 
over-supplemented because your mineral/vitamin supplements are not matched well to the base 
ration, then you should find a new mineral source or supplement that will supply K at requirement.  
 
The K concentration of feeds varies, and we recommend that the major ingredients of a ration be 
analyzed for K, especially when feeding dry cows or feeding lactating cows diet high in corn silage. 
K content of feeds must be determined by wet chemistry method and cannot be accurately predicted 
from NIR analysis.  
 
For close-up dry cows, we recommend feeding diets that provide no excess K. This can be difficult 
to do. Forages from fields that have had little manure application typically have lower K 
concentrations. We recommend these forages be reserved for dry cows. For information on 
minimizing the impact of excess K in dry cow diets, see Dietary cation-anion difference (DCAD).  
The K requirement in Spartan 3 is similar to that of NRC 2001, but we increased the requirement 
for heat stress (the NRC 2001 requirement has virtually no impact).  K requirement (g/day) = 6.1 x 
DM intake + 0.038 x body weight + 1.5 x milk yield + 1.6 x frame gain + 2 x NEL for activity + 3 x 
body weight during severe heat stress + 1 if days pregnant exceeds 190.  For dry cows and heifers, 
the 6.1 x DM intake is replaced with 2.6 x DM intake. For mild or moderate heat stress, the 
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multiplier of body weight is 1 or 2 instead of 3. To be effective in alleviating heat stress, this 
equation likely does not add enough K to the diet.   
 
Sodium (Na)  
Sodium (Na) is critical for acid-base regulation, osmotic pressure, water balance, heart function, 
nerve impulse conduction, and transport of compounds in and out of cells. The absorption 
coefficient for Na is about 90% for most feeds; for this reason, we did not include absorbed Na in 
Spartan 3 even though it is part of the NRC 2001 model. The typical lactating cow requires about 60 
g of Na per day, which would be met with about 0.23% Na in the diet. The Na requirement in 
Spartan 3 is similar to that of NRC (see below).  See MacroMineral Characteristics for general 
information on feeding guidelines, maximum tolerable limits, and mineral absorption. 
 
Supplementation with Na is almost always needed. Salt (NaCl) is the least expensive and most 
widely used source and typically is fed at 0.25% to 0.5% of the ration dry matter. Some commercial 
supplements also contain Na. Sodium bicarbonate fed as a rumen buffer generally will supply 
enough Na to meet requirement; in this case attention should be given to be sure adequate chlorine 
is provided in the ration.  
 
Salt also can be fed free-choice in a mineral feeder or as salt blocks. Trace mineralized salt can be 
used to supply some of the trace mineral elements as well as Na and Cl, however the amount and 
balance of trace minerals should be carefully checked and the costs relative to other trace mineral 
supplementation methods should be evaluated. There can be considerable risk of trace mineral 
deficiencies in certain classes of animals if one depends solely on free-choice supplementation. 
 
Overfeeding of Na seldom causes any problem for most cows, provided good quality fresh water is 
available.  The exception to this is dry cows. NOTE: High dietary Na in dry cow diets increases the 
risk of hypocalcemia (milk fever) at calving and  may contribute to increased udder edema. For 
information on the potential role of Na in dry cow diets, see Dietary cation-anion difference 
(DCAD).   
 
The Na requirement in Spartan 3 is similar to that of NRC 2001. Na requirement (g/day) = 0.038 x 
body weight + 0.63 x milk yield + 1.4 x frame gain + 1 x NEL for activity + 0.75 x body weight 
during severe heat stress + 1.4 x calf body weight adjustment if days pregnant exceeds 190.  For dry 
cows and heifers, the 0.038 x body weight is replaced with 0.015 x body weight. For mild or 
moderate heat stress, the multiplier of body weight is 0.25 or 0.50 instead of 0.75.   
 
Chloride (Cl)  
Chloride (Cl) is important in osmotic pressure, acid base balance, and digestive functions. The 
absorption coefficient for Cl is about 90% for most feeds; for this reason, we did not include 
absorbed Cl in Spartan 3 even though it is part of the NRC 2001 model. The typical lactating cow 
requires about 70 g of Cl per day, which would be met with about 0.28% Cl in the diet. The Cl 
requirement in Spartan 3 is similar to that of NRC (see below).  See MacroMineral Characteristics 
for general information on feeding guidelines, maximum tolerable limits, and mineral absorption. 
 
Cl is usually not a problem when salt (NaCl) is used to meet the Na requirement. If the ration 
contains sodium bicarbonate as a buffer, however, the ration may contain inadequate Cl, and salt 
should be added to meet the deficit.  
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Overfeeding of Cl is seldom a problem and may be beneficial for some dry cows  Added dietary Cl 
during the last 3 week before calving decreases the risk of hypocalcemia (milk fever) at calving. For 
information on the potential role of Cl in dry cow diets, see Dietary cation-anion difference 
(DCAD).  
 
The Cl requirement in Spartan 3 is similar to that of NRC 2001. Cl requirement (g/day) = 0.0225 x 
body weight + 1.15 x milk yield + 1.0 x frame gain + 1 x NEL for activity + 1.0 x calf body weight 
adjustment if days pregnant exceeds 190.   
 
Sulfur (S)  
Sulfur (S) is used by ruminal microbes to synthesize the amino acids methionine and cysteine and 
some B-vitamins. Absorption of S is not an important consideration as it is used in the rumen. The 
typical lactating cow requires about 50 g of S per day, which would be met with about 0.2% S in the 
diet. The S requirement in Spartan 3 is similar to that of NRC (see below). See MacroMineral 
Characteristics for general information on feeding guidelines, maximum tolerable limits, and 
mineral absorption. 
 
 Supplementation with S is sometimes required to meet requirements; especially in high corn silage 
rations, if urea or another non-protein nitrogen source is added. Good sources include gypsum 
(calcium sulfate), magnesium sulfate, and commercial premixes. 
 
Elemental sulfur (e.g., flowers of sulfur) is unavailable to animals and should not be used in rations. 
Inorganic sulfur (in the form of sulfate or sulfite) will alter the cation-anion difference of the ration; 
organic sulfur (component of protein) does not. Magnesium sulfate and ammonium sulfate, two of 
the so-called anionic salts, are sometimes used to reduce the dietary cation-anion difference DCAD 
of rations fed to late-pregnant (close-up) dry cows. Both, as well as other anionic salts should be 
used with caution because they may reduce feed intake if inclusion rates are too high.  
 
The total sulfur content should not exceed 0.4% of the ration dry matter. NOTE: High levels of 
sulfur and molybdenum in the diet can reduce the absorption of Copper. 
 
The S requirement in Spartan 3 is similar to that of NRC. S requirement (g/day) = 2 x DM Intake  
 
Dietary Cation‐Anion Difference (DCAD) 
Dietary Cation-Anion Difference (DCAD) influences systemic acid-base status and the metabolism 
of other nutrients such as Ca. In Spartan 3 DCAD is expressed as milliequivalents of major fixed 
cations minus major fixed anions per 100 grams of dietary dry matter:  

mEq [(K + Na) – (Cl + S)]/100 grams 

To convert ration mineral element concentrations to milliequivalents Spartan 3 uses the equation:  
DCAD = (Na/0.023 + K/0.0391) - (Cl/0.0355 + S/0.016) mEq/100 g  

where Na, K, Cl, and S are expressed on a percent dry matter basis. 
 
This is the equation used most commonly in the field. The majority of S in common dairy rations is 
in the form of sulfate (an anion), with the remainder as organically bound S (such as in S-containing 
amino acids). Practically and for simplicity, total sulfur (S) of the ration is used in calculation of 



Spartan Dairy Help Manual Michigan State University Page 55 

DCAD, with the anions sulfate (and sulfite to a lesser degree) having a key anionic influence on the 
DCAD and on the physiology of animals. 
 
When considering DCAD in ration formulation, the first step is to analyze the K, Na, Cl and S 
contents of all feed ingredients used in ration formulation by wet-chemistry analysis to insure 
accuracy. The contents of these elements are variable within feed type, especially for forages within 
and among farms, and are heavily influenced by fertilization practices and other agronomic and 
weather-related factors. 
 
The second step is to meet the nutrient requirements (e.g., grams per day) for the defined animal 
description for K, Na, Cl and S. Several mineral sources either provide a net contribution of fixed 
anions [such as the so-called ‘anionic salts’ (like ammonium sulfate, ammonium chloride, 
magnesium sulfate or calcium sulfate), or commercial products with high concentrations of Cl or 
sulfate relative to fixed cations] or fixed cations [such as sodium bicarbonate or potassium 
carbonate] to adjust the DCAD to influence animals’ metabolic and production responses as 
desired. 
Note: addition of common white salt (NaCl) and KCl do not alter the DCAD of a ration because 
they are ‘neutral salts’. Addition of elemental sulfur (such as the flowers of sulfur), while it will 
change the numerical value of the calculated DCAD as defined and computed in Spartan 3, has no 
physiological influence on of the target animal because it is biologically un-/non-reactive as 
delivered via the ration. 
 
DCAD in rations for late pregnant, dry cows (close-up cows) 
Dietary cation-anion difference has been addressed in research and used the field application for 
cows in the phase of the production cycle for about 15 years. It is well known that formulating 
rations with a DCAD of 0 to -10 mEq/100 grams ration dry matter, by the addition of anions (Cl 
and sulfate), affects systemic acid-base and calcium status, and metabolic health during the 
transition from the dry period to lactation. Field application is common in many herds. But careful, 
expert ration formulation and nutritional/feeding management are required to be sure that transition 
cows respond as desired and that feed intake and energy status are not negatively affected when 
supplementing significant amounts of anions. 
Careful and routine laboratory analyses of feeds for Na, K, Cl and S, especially forages as they 
change through time, and routine use of urine pH to monitor the physiological efficacy of the 
formulated DCAD are critical to realize success with this feeding strategy. 
 
DCAD in rations for lactating cows 
Based on summary of published reports on lactational performance, DCAD in the range of +25 to 
+30 mEq/100grams of ration dry matter is effective and sufficient to achieve maximum feed intake 
and milk yield. The magnitude and difference in feed intake and milk yield were quite small over 
the range +20 to +40 mEq/100g DM. DCAD in the range of -20 to +10 mEq was quite detrimental 
to lactational performance. Greater than +40 mEq was not beneficial, and even detrimental at higher 
DCAD concentrations greater than +50 mEq. 
 
To implement a formulation strategy to achieve a target DCAD several points are important. It 
might be possible to increase DCAD by reducing Cl and (or) S contributed by specific basal 
ingredients or supplements, as long as the requirements for Cl and S are met. After that 
consideration, the cations Na and K are equally efficacious for addition to increase DCAD. 
Assuming that the actual nutritional requirements (grams/day) for Na and K are met already, the 
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fundamental formulation objective is to increase DCAD with the cation source that is least cost on a 
milliequivalent basis. Consideration also should be given to reducing the amount of supplemental 
cations (K or Na) and anions (Cl and S) that are in excess and are excreted into dairy farming 
systems and are currently problems or emerging problems. 
 
Ash 
Ash is the inorganic part of a feed -- everything that is left if you burn the sample at a really hot 
temperature (like 600 degrees Celsius). Some ash is a good thing as it includes the necessary 
minerals for a cow. Ash, however, adds no energy or protein to a feed, and feeds with a lot of ash 
will have lower energy values. 
 
Ash is used to calculate NFC (page 39) and MFTDN (page 33). 
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Trace Mineral Characteristics  
There are seven trace mineral elements that are important in balancing dairy rations: 

• Cobalt (Co)  
• Copper (Cu)  
• Iron (Fe) 

• Iodine (I)  
• Manganese (Mn)  
• Selenium (Se)  

• Zinc (Zn) 

 
The trace mineral element concentrations in common forages and concentrate feeds are quite low 
and can vary considerably, even among different sources of feeds with the same name. Therefore, 
when using Spartan 3 it is recommended that all trace mineral elements be supplemented in the 
ration at 100% of NRC DAIRY (2001) requirements. Trace minerals are relatively inexpensive, and 
this ensures that all will be fed at adequate concentrations to meet requirements. In the Spartan 3 
feed library the concentrations for the trace mineral elements are zero for common feeds. However, 
trace mineral concentrations are listed for specific inorganic mineral sources (e.g., cobalt carbonate, 
copper sulfate, iron sulfate, etc.) used to supplement rations. If you know actual concentrations, you 
should go ahead and use them for your own feeds. 
 
Excess concentrations of trace elements, due to errors in formulation, mixing, or feeding, can very 
easily result in toxicity problems that will destroy the profitability of a dairy operation.  
 
NOTE: When balancing for trace elements in Spartan 3, be sure to check very carefully 
concentrations in the final ration compared with those that are recommended. Mistakes can be very 
costly.  
 
Also, apparently proper supplementation based on the ration generated from the computer program 
and the printout does not guarantee proper supplementation in the feed bunk. See the section on 
feed mixing considerations for more information.  
 
Suggested Maximum Tolerable Concentrations for Trace Minerals in Dairy Rations 
Nutrient  Concentration in Ration Dry Matter   
Cobalt (Co)        10 ppm   
Copper (Cu)        40 ppm (unless molybdenum is elevated greatly) Jerseys apparently are 

more susceptible to toxicity than other dairy breeds.   
Iron (Fe)   1,000 ppm   
Iodine (I)          5 ppm   
Manganese (Mn)   1,000 ppm   
Selenium (Se)         2 ppm   
Zinc (Zn)     500 ppm   
 
Availability (efficiency of absorption) 
Not all of the various mineral elements in rations are available for absorption. Therefore, Spartan 3 
adopted the NRC (2001) approach of using an absorption coefficient to supply adequate mineral 
elements in rations. Where research results permitted, an absorption coefficient was assigned for the 
mineral element in concentrates, forages, and inorganic mineral sources. Sufficient data were not 
available for the NRC committee to use this approach for cobalt (Co) and selenium (Se). We believe 
that Se absorption may someday be valuable information. Although sufficient data are not available 
to warrant the use of absorbed Se at this time, the data may become available in the near future; thus 
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a column for absorbed Se is included in Spartan 3. The following table lists the absorption 
coefficients for trace mineral elements that are used by default. 

 Absorption Coefficient (%) for Trace Minerals in Spartan Dairy 3 
Trace Mineral Element   For Concentrates For Forages 
Copper (Cu)   4 4 
Iodine (I)   85 85 
Iron (Fe)   10 10 
Manganese (Mn)   0.75 0.75 
Zinc (Zn)   15 15 
Selenium (Se)   40 40 

 
Notes:  
• Absorption coefficients differ among supplemental inorganic mineral sources; see Spartan 3 

feed library for each individual inorganic mineral element source.  
• This table gives the base absorption coefficient for copper.  Abs Cu is altered by the 

concentration of Mo and S in the diet.  
• Absorption coefficients for Se are not used in the 2001 NRC model.  
• The 2001 NRC expresses absorption coefficients as proportions (i.e., 0 to 1) while Spartan 3 

expresses absorption coefficients as percent absorption (i.e., 0 to 100).  
 
Cobalt (Co)  
Cobalt (Co) is a component of vitamin B12 and is used by rumen microbes to synthesize this 
vitamin, which is a critical factor in the synthesis of glucose from propionic acid. Because Co is 
needed in the rumen, absorption is not considered. The general feeding recommendation for Co is 
0.11 ppm (0.11 mg/kg DM or 0.05 mg/lb), and a typical lactating cow requires about 3 mg/day. The 
Spartan 3 requirement for Co is the same as in NRC 2001. There is no evidence to support the 
supplementation of cobalt at concentrations much greater than this.  
 
The trace mineral composition of feeds can vary considerably. We recommend that you consider all 
feeds to have no cobalt except those with a laboratory analysis (by wet chemistry, not NIR) or a 
guaranteed analysis from a commercial feed company. We recommend that cobalt be supplemented 
to achieve 0.11 ppm Co, dry basis, in the final ration.  
 
Overfeeding cobalt is not usually a problem. If you have included cobalt values for all your 
feedstuffs, this could easily occur and likely can be ignored if the cobalt concentration is less than 5 
ppm. If, however, cobalt is being over-supplemented because your mineral/vitamin supplements are 
not matched well to the base ration (for example, a poor balance of trace minerals in a TM-salt or 
TM-premix), then you should find a new mineral source that will supply Co closer to the required 
concentration. 
 
Co requirement (mg/day) = 0.11 x DM intake 
 
Copper (Cu)  
Copper (Cu) is important for energy metabolism, strong bones and connective tissues, hemoglobin 
synthesis, and immune function.  The general feeding recommendation for total Cu is 10 to 15 ppm 
(10 to 15 mg/kg DM or 5 to 7 mg/lb), depending upon the animal description, its feed intake and 
production, and the absorption coefficients of dietary Cu sources.  The absorption coefficient for 
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copper is only 4 to 5% and is decreased by sulfur and molybdenum (see below). A typical lactating 
cow requires about 270 mg total Cu and 11 mg absorbed Cu per day. There is no evidence to 
support the supplementation of copper at concentrations much greater than this. See Trace Mineral 
Characteristics for general information on feeding guidelines, maximum tolerable limits, and 
mineral absorption. 
 
The trace mineral composition of feeds can vary considerably. We recommend that you consider all 
feeds to have no Cu except those with a laboratory analysis (by wet chemistry, not NIR) or a 
guaranteed analysis from a commercial feed company. We recommend that Cu be supplemented to 
meet 100% of the final requirement.    
 
Overfeeding Cu up to 5X is not a problem for cattle. If you have included Cu values for all your 
feedstuffs, this could easily occur and likely can be ignored if the Cu concentration is less than 50 
ppm. If, however, Cu is being over-supplemented because your mineral/vitamin supplements are 
not matched well to the base ration (for example, a poor balance of trace minerals in a TM-salt or 
TM-premix), then you should find a new mineral source or supplement that will supply Cu at 
requirement. 
 
The Cu requirement in Spartan 3 is essentially that of NRC 2001 with an addition for activity.  
AbsCu requirement (mg/day) = 0.071 x body weight + 0.15 x milk yield + 1.15 x frame gain + 0.2 x 
activity requirement + a requirement for pregnancy of 2, 1.5, or 0.5 if days pregnant is >225, 
between 225 and 100, or <100, respectively.  In the NRC system, the absorption coefficient for each 
feed is altered by Mo and S.  However, in Spartan 3, we fix the absorption coefficient for most 
nonmineral feeds at 4% and for most mineral supplements at 5% and then adjust the total absorbed 
Cu using the concentrations of S and Mo in the diet.     
 

Cu_absSupply = TotalAbsCu * ((10^(-1.153 - 0.76*SConc - 0.13*SConc*MoConc)) / 0.047) 
 
See also 

• Molybdenum 
• Sulfur 

 
Iron (Fe)  
Iron (Fe) is important for oxygen transport and energy metabolism. The first deficiency sign is 
anemia. The general feeding recommendation for total Fe is in the range of 10 to 30 ppm (10 to 30 
mg/kg DM or 5 to 14 mg/lb), depending upon the animal description, its feed intake and production, 
and the absorption coefficients of dietary Fe sources. The absorption coefficient for iron is 10% for 
most nonmineral feeds and 40% for most mineral supplements.  A typical lactating cow requires 
about 700 mg total Fe and 70 mg absorbed Fe per day. This requirement is higher than that 
recommended by NRC 2001 (see below). There is no evidence to support the supplementation of Fe 
at concentrations greater than this. See Trace Mineral Characteristics for general information on 
feeding guidelines, maximum tolerable limits, and mineral absorption.  
 
Iron deficiency is rare in adult cattle but can occur in milk-fed calves. Iron supplementation is 
relatively inexpensive; however common feed ingredients contain plenty of Fe. It is prudent to 
analyze all feeds in the ration by laboratory analysis (by wet chemistry, not NIR) or obtain a 
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guaranteed analysis from a commercial feed company to assess whether or not Fe supplementation 
is needed in a specific ration. The maximum tolerable concentration of Fe in rations is 1,000 ppm.  
 
Iron is often overfed, and this is not a problem. If you have included Fe values for all your 
feedstuffs, this could easily occur and likely can be ignored if the Fe concentration is below 500 
ppm. If, however, Fe is being over-supplemented because your min/vit supplements are not 
matched well to the base ration (for example, a poor balance of trace minerals in a TM-salt or TM-
premix), then you should find a new mineral source or supplement that will supply Fe at closer to its 
requirement. 
 
The NRC 2001 model includes no maintenance Fe requirement.  We added a maintenance 
requirement but decreased the Fe requirement for milk.  AbsFe requirement (mg/day) = 2 x DMI for 
maintenance + 1 x DMI for milk + 34 x Frame gain + 1 x NEL reqt for activity + 18 x calf birth 
weight adjustment if days pregnant > 190.  See DMI prediction for information on the DMI 
components.   
 
Iodine (I)  
Iodine (I) is needed for the synthesis of the thyroid hormones, which help regulate energy 
metabolism. The general feeding recommendation for total iodine is in the range of 0.3 to 0.9 ppm 
(0.3 to 0.9 mg/kg DM or 0.14 to 0.41 mg/lb), depending upon the animal description, its feed intake 
and level of production, and the absorption coefficients of dietary I sources. The absorption 
coefficient for iodine is high (85% for most nonmineral feeds and 90% for most mineral 
supplements).  A typical lactating cow  requires 13 mg total iodine and 11 mg absorbed iodine per 
day. This is not the same as the requirement for iodine in NRC 2001 (see below). There is no 
evidence to support the supplementation of iodine at concentrations much greater than this. See 
Trace Mineral Characteristics for general information on feeding guidelines, maximum tolerable 
limits, and mineral absorption.  
 
Iodine supplementation is relatively inexpensive, and its composition in feeds can vary 
considerably. We recommend that you consider all feeds to have almost no iodine except those with 
a laboratory analysis (by wet chemistry, not NIR) or a guaranteed analysis from a commercial feed 
company. Thus, we recommend that iodine be supplemented to meet 100% of the final requirement.  
However, supplemental iodine should not exceed 0.5 ppm (as per NRC 2001 guidelines). 
 
NOTE: Supplementation of iodine above 0.5 ppm to lactating cows may result in high 
concentrations of iodine in milk; there are legal maximums for the allowable concentration of 
iodine in saleable milk.  
 
Overfeeding iodine to nonlactating animals is seldom a concern. If you have included iodine values 
for all your feedstuffs, this could easily occur and likely can be ignored if the iodine concentration 
is below 20 ppm.   
 
If iodine is being over-supplemented, especially to lactating cows, because your min/vit 
supplements are not matched well to the base ration (for example, a poor balance of trace minerals 
in a TM-salt or TM-premix), then you should find a new mineral source or supplement that will 
supply the iodine at the recommended level. 
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The NRC 2001 model requirement for iodine seems inconsistent with the NRC text. In Spartan 3, 
the AbsI requirement (mg/day) = 0.3 x DMI for maintenance + 0.6 x DMI for milk + 0.3 x DMI for 
gain + 0.1 x NEL reqt for activity and pregnancy.  
 
Manganese (Mn)  
Manganese (Mn) is important for skeletal growth, energy metabolism, and anti-oxidant protection. 
The general feeding recommendation for total Mn is in the range of 12 to 24 ppm (12 to 24 mg/kg 
DM or 5 to 11 mg/lb), depending upon the animal, its feed intake and level of production, and the 
absorption coefficients of dietary Mn sources. The absorption coefficient for Mn is very low (0.75% 
for most nonmineral feeds and 1% for most mineral supplements). A typical lactating cow requires 
about 300 mg total Mn but only 3 mg absorbed Mn per day. This is essentially the same as the Mn 
requirment in NRC 2001 (see below). There is no evidence to support the supplementation of Mn at 
concentrations much greater than this. See Trace Mineral Characteristics for general information on 
feeding guidelines, maximum tolerable limits, and mineral absorption.  
 
Manganese supplementation is relatively inexpensive, and the trace mineral composition of feeds 
can vary considerably. We recommend that you consider all feeds to have no manganese except 
those with a laboratory analysis (by wet chemistry, not NIR) or a guaranteed analysis from a 
commercial feed company. We recommend that Mn be supplemented to meet 100% of the final 
requirement. 
    
Overfeeding Mn is seldom a problem. If you have included Mn values for all your feedstuffs, this 
could easily occur and likely can be ignored if the Mn concentration is below 500 ppm. If, however, 
Mn is being over-supplemented because your min/vit supplements are not matched well to the base 
ration (for example, a poor balance of trace minerals in a TM-salt or TM-premix), then you should 
find a new mineral source or supplement that will supply Mn at the requirement. 
 
The Mn requirement is essentially that of NRC 2001 with a small addition for activity.  AbsMn 
requirement (mg/day) = 0.002 x body weight + 0.03 x milk yield + 0.7 x frame gain + 0.1 x NEL 
for activity + 0.3 if days pregnant > 190. 
 
Molybdenum (Mo)  
Molybdenum (Mo) is a required nutrient but the requirement is very low. Supplementation is not 
recommended, and the normal concentration in feeds is more likely to result in Mo toxicity than 
deficiency. The Mo content often is monitored by laboratory analyses of common feeds and its 
concentration can be included in the Spartan 3 Feed Library. 
 
Mo is a practical concern because it antagonizes absorption of copper (and to a lesser extent 
phosphorus). Mo interacts with sulfur in the digestive tract to form a thoiomolybdate complex with 
high affinity for copper, rendering the copper unabsorbable. Mo toxicosis essentially presents itself 
as copper deficiency (e.g., loss of hair pigmentation, particularly around the eyes; anemia; poor 
growth and reproductive performance). Mo toxicity (copper deficiency) can be corrected by adding 
supplemental copper, or copper toxicity can be overcome by supplementing Mo. 
 
As little as 5 ppm Mo in the ration dry matter can cause copper depletion, and 10 ppm is considered 
the maximum tolerable concentration. 
 



Spartan Dairy Help Manual Michigan State University Page 62 

Selenium (Se)  
Selenium (Se) is an important component of the antioxidant system and thus in the immune system. 
The general feeding recommendation for total Se is 0.3 ppm (0.3 mg/kg DM, or 0.14 mg/lb). The 
absorption coefficient for Se is about 40% for most feeds. A typical lactating cow requires about 7 
mg total Se and 3 mg absorbed Se per day. This is essentially the same as the NRC 2001 
requirement. In most cases, there is no evidence to support the supplementation of Se at 
concentrations much greater than this. See Trace Mineral Characteristics for general information on 
feeding guidelines, maximum tolerable limits, and mineral absorption. 
 
Selenium supplementation is relatively inexpensive, and the trace mineral composition of feeds can 
vary considerably. We recommend that you consider all feeds to have no Se except those with a 
laboratory analysis (by wet chemistry, not NIR) or a guaranteed analysis from a commercial feed 
company. Thus, we recommend that you supply Se as a mineral supplement at 100% of its 
requirement.  If you live in an area that has exceptionally high Se concentrations in the soil, such as 
the western Great Plains, Se supplementation is not necessary.  
 
There is some evidence to support the supplementation of Se at concentrations greater than 0.3 ppm 
(up to 0.6 ppm) in dry cow rations to improve immune function and reduce the incidence of 
reproductive disorders after calving.  
 
NOTE: Overfeeding selenium is seldom a problem for the animal, but is illegal in the United States 
if the excess Se is from a supplement. The maximum legal limit for Se is currently (as of 2009) set 
at 0.3 ppm.  If you have included Se values for all your feedstuffs, overfeeding of Se can occur, 
especially in the western plains of the US, and can be ignored if the Se concentration is below 1.0 
ppm.  
 
If, however, Se is being over-supplemented because your min/vit supplements are not matched well 
to the base ration (for example, a poor balance of trace minerals in a TM-salt or TM-premix), then 
you should find  a new mineral source or supplement that will supply Se at 0.3 ppm.   
 
NOTE: NRC 2001 does not include absorption coefficients for Se or a requirement for absorbed Se 
in its mineral system. In Spartan 3, we include the possibility of using absorbed Se because there is 
some evidence that supplements with greater availability may be useful in supplying extra absorbed 
Se to enhance immune function in cows without exceeding the maximum legal limit for total Se.   
 
In Spartan 3, AbsSe requirement (mg/day) = 0.12 x DM intake. 
 
Zinc (Zn)  
Zinc (Zn) is a component of many cellular proteins, including enzymes and hormones, and thus has 
myriad functions in the body. The general feeding recommendation for total Zn is in the range of 20 
to 80 ppm (20 to 80 mg/kg DM or 9 to 36 mg/lb), depending upon the animal, its feed intake and 
level of production, and the absorption coefficients of dietary Zn sources. The absorption coefficient 
for Zn is 15% for most feeds. A typical lactating cow requires about 1300 mg total Zn and 200 mg 
absorbed Zn per day. This is essentially the NRC 2001 requirement (see below). There is no 
evidence to support the supplementation of Zn at concentrations much greater than this. See Trace 
Mineral Characteristics for general information on feeding guidelines, maximum tolerable limits, 
and mineral absorption. 
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The trace mineral composition of feeds can vary considerably. We recommend that you consider all 
feeds to have no Zn except those with a laboratory analysis (by wet chemistry, not NIR) or a 
guaranteed analysis from a commercial feed company. We recommend that Zn be supplemented to 
meet 100% of its final requirement.  
 
Overfeeding Zn is seldom a problem. If you have included Zn values for all your feedstuffs, this 
could easily occur and likely can be ignored if the Zn concentration is below 250 ppm. However, if 
Zn is being over-supplemented because your mineral/vitamin supplements are not matched well to 
the base ration (for example, a poor balance of trace minerals in a TM-salt or TM-premix), then you 
should find  a new mineral source or supplement that will supply Zn at requirements. 
 
The Zn requirement is essentially that of NRC 2001 with a small addition for activity.  AbsZn 
requirement (mg/day) = 0.045 x body weight + 4 x milk yield + 24 x frame gain + 3 x NEL for 
activity + 12 x calf birth weight adjustment if days pregnant > 190. 
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Vitamin Characteristics  
There are three fat-soluble vitamins important in balancing dairy rations: Vitamin A, Vitamin D, 
and Vitamin E.  
 
In the Spartan 3 feed library, concentrations of these vitamins are not listed for common feeds. 
These concentrations can be quite variable for different sources of the common feeds even with the 
same name. Therefore, we recommend that these three vitamins be supplemented in the ration at 
100% of requirements. These vitamins are relatively inexpensive, so it makes sense to ensure that 
they will be fed at adequate concentrations. However, proper supplementation as indicated in the 
computer program or on a printout does not mean proper supplementation in the feed bunk – make 
sure mixing is done properly.  For information on sources of vitamins, go to the help topic on 
mineral and vitamin sources (about 4 pages after the current page).    
 
Vitamins can lose their potency when stored for a prolonged period of time. They may be even less 
stable when mixed with supplemental minerals. Therefore, if you order a custom-made premix, or if 
you purchase a commercial premix containing vitamins, try to order batches that will be fed within 
4 months of formulation. Always store premixes in a dry environment.  
 
Suggested Maximum Tolerable Concentrations for Vitamins in Dairy Rations 

Vitamin Maximum Concentration in Ration Dry Matter   
Vitamin A   30 kIU/lb (66 kIU/kg)   
Vitamin D   long-term feeding: 1.0 kIU/lb (2.2 kIU/kg)  

short-term feeding: 12 kIU/lb (25/kIU/kg)  
Vitamin E   no data on maximum tolerable concentrations for cattle   

 
Vitamin A (VitA)  
Because the vitamin A (or its precursor such as beta-carotene) content of common feed ingredients 
and rations is highly variable and almost never actually known in the field, the vitamin A 
requirements recommended in Spartan 3 are for supplemental vitamin A, not total dietary vitamin 
A. 
 
Based on the recommendation of NRC DAIRY 2001, the vitamin A requirement for growing 
animals was set at 36 IU/lb of body weight. For adult cattle the requirement was set at 50 IU/lb of 
body weight.  Therefore, in the NRC, as an example, for a lactating Holstein cow (1600 lb body 
weight) the requirement (all supplemented in the ration) equals 80,000 IU/day (80 KIU/day), 
irrespective of feed intake or milk production rate. Over a typical range of body weights and feed 
intake rates for lactating cows the dietary concentration of vitamin A would range from about 990 
to 1680 IU/lb of ration DM.  
 
We have modified this requirement in Spartan 3, so that the vitamin A requirement on a 
concentration basis does not decrease as milk production increases, as occurs with NRC2001.  
 
Vitamin A supplementation is relatively inexpensive, and the vitamin composition of feeds can vary 
considerably. We recommend that you consider all feeds to have no vitamin A except those with a 
laboratory analysis (wet chemistry, not NIR) or a guaranteed analysis from a commercial feed 
company. We recommend that the full 50 IU/ lb of body weight be added to the ration as a 
supplement. See the section on min/vit supplementation for more information.  
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Overfeeding vitamin A is seldom a problem. If you have included vitamin A values for all your 
feedstuffs, this could easily occur and likely can be ignored if the vitamin A concentration is below 
30 KIU/kg or 15 KIU/lb. If, however, vitamin A is being over-supplemented because your min/vit 
supplements are not matched well to the base ration or relative to each other (for example, a poor 
balance of vitamins in a vitamin A-D-E pack or TM/vitamin pack), then you should consider adding 
a new vitamin source or supplement that will supply the vitamin A at the requirement. 
 
Requirement details 
The Spartan Dairy 3 requirement for Vitamin A is set on an amount basis in kIU/day using an 
additive model:  

VitA_Maintenance = 0.08 * Current_NPBC3BW {kgs} 
VitA_Milk = 1.3 * FCM4 {kg/day} 
VitA_Gain = 4 * PredictFrameDailyGain {kg/day} 
VitA_Pregnancy = if(DaysPregnant>210,0.03 * Current_NPBC3BW {kgs}, 0) 
VitAReqtAmount = VitA_Maintenance + VitA_Milk + VitA_Gain + VitA_Pregnancy 

 
Vitamin D (VitD)  
Because the vitamin D (and its precursors) content of common feed ingredients and rations is highly 
variable and almost never actually known in the field, the vitamin D requirements recommended in 
Spartan 3 are for supplemental vitamin D, not total dietary vitamin D. 
 
Based on the recommendation of NRC DAIRY 2001, the vitamin D requirement for all ages of 
cattle (growing heifers as well as adult cattle) was set at 13.6 IU/lb of body weight. Therefore, in the 
NRC, as an example, for a lactating Holstein cow (1600 lb body weight) the vitamin D requirement 
(all supplemented in the ration) equals 21,760 IU/day (21.76 KIU/day), irrespective of feed intake, 
growth, or milk production rate. Over a typical range of body weights and feed intake rates for 
lactating cows the dietary concentration of vitamin D would range from about 270 to 470 IU/lb of 
ration DM. 
 
We have modified this requirement in Spartan 3, so that the vitamin D requirement on a 
concentration basis does not decrease as milk production increases.  
 
Vitamin D supplementation is relatively inexpensive, and the vitamin composition of feeds can vary 
considerably. We recommend that you consider all feeds to have no vitamin D except those with a 
laboratory analysis (wet chemistry, not NIR) or a guaranteed analysis from a commercial feed 
company. We recommend that the full requirement of vitamin D be added to the ration as a 
supplement. See help on min/vit supplementation for more information. 
 
Overfeeding vitamin D is seldom a problem. If you have included vitamin D values for all your 
feedstuffs, this could easily occur and likely can be ignored if the vitamin D concentration is below 
5 KIU/kg or 2.4 KIU/lb. If, however, vitamin D is being over-supplemented because your 
mineral/vitamin supplements are not matched well to the basal ration or relative to each other (for 
example, a poor balance of vitamins in a vitamin A-D-E pack or TM/vitamin pack), then you should 
consider finding a new vitamin source or supplement that will supply vitamin D at the requirement. 
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Requirement details 
The Spartan Dairy 3 requirement for Vitamin D is set on an amount basis in kIU/day using an 
additive model:  

VitD_Maintenance = 0.024 * Current_NPBC3BW {kg} 
VitD_Milk = 0.3 * FCM4 {kg/day} 
VitD_Gain = PredictFrameDailyGain {kg/day} 
VitD_Pregnancy = if(DaysPregnant>210,0.006 * Current_NPBC3BW {kg}, 0) 
VitDReqtAmount = VitD_Maintenance + VitD_Milk + VitD_Gain + VitD_Pregnancy  

 
Vitamin E (VitE)  
Because the vitamin E content of common feed ingredients and rations is highly variable and almost 
never actually known in the field, the vitamin E requirements recommended in Spartan 3 are for 
supplemental vitamin E, not total dietary vitamin E. 
 
In Spartan 3, the vitamin E requirement of heifers and dry cows during the last 60 days of 
pregnancy was set at 0.73 IU/lb of body weight, based on NRC DAIRY (2001). Therefore, for a late 
pregnant Holstein dry cow (1600 lb body weight with 28 lb of dry matter intake/day) total vitamin E 
intake would be about 1168 IU/day or about 42 IU/lb of DM to meet requirement. 
For lactating cows the NRC requirement is 0.36 IU/lb of body weight. For example, for a Holstein 
cow (1500 lb body weight) the total E intake would be 545 IU/day or about 10.45 IU/lb of ration 
DM.  
 
We have modified this requirement in Spartan 3, so that the vitamin E requirement on a 
concentration basis does not decrease as milk production increases. 
 
Vitamin E supplementation is relatively inexpensive, and the vitamin composition of feeds can vary 
considerably. We recommend that you consider all feeds to have no vitamin E except those with a 
laboratory analysis (wet chemistry, not NIR) or a guaranteed analysis from a commercial feed 
company. We recommend that the full 15 IU/kg DM vitamin E be added to the ration as a 
supplement. See help on min/vit supplementation for more information.  
 
Overfeeding vitamin E is seldom a problem. If you have included vitamin E values for all your 
feedstuffs, this could easily occur and likely can be ignored if the vitamin E concentration is below 
1,000 IU/kg or 450 IU/lb. If, however, vitamin E is being over-supplemented because your 
mineral/vitamin supplements are not matched well to the base ration or relative to each other (for 
example, a poor balance of vitamins in a vitamin A-D-E pack or TM/vitamin pack), then you should 
consider finding a new vitamin source or supplement that will supply vitamin E at the requirement. 
 
Requirement details 
The Spartan Dairy 3 requirement for Vitamin E is set on an amount basis in IU/day using an 
additive model:  

VitE_Maintenance = 0.8 * Current_NPBC3BW {kgs) 
VitE_Milk = 8 * FCM4 (kgs/day) 
VitE_Gain = 15 * PredictFrameDailyGain {kg/day} 
VitE_Pregnancy = if(DaysPregnant>210,0.8 * Current_NPBC3BW {kgs), 0) 
VitEReqtAmount = VitE_Maintenance + VitE_Milk + VitE_Gain + VitE_Pregnancy 
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Mineral and Vitamin Sources, Mixes and Packs 
In Spartan Dairy 3, supplementation of the macromineral elements (Ca, P, Mg, K, Na, Cl, and S) is 
often required to meet the difference between the requirements and the total nutrients supplied by 
the base ration. However, there may be occasions, depending of feed ingredients in the base ration, 
when no phosphorus or chloride supplementation will be needed. 
 
With the approach used in Spartan 3 the trace mineral elements (Co, Cu, Fe, I, Mn, Se, and Zn) and 
vitamins (A, D, and E) are supplemented to the base ration to meet the entire requirement. For all 
non-mineral and non-vitamin feeds in the Spartan 3 feed library, the concentration values for trace 
mineral elements and vitamins are set at zero by default. Therefore, the program will supplement 
with additional trace minerals/vitamins at 100% of NRC DAIRY (2001) requirements.  
If you have actual values for the mineral/vitamin content of feeds from a laboratory analyses using 
wet chemistry or from a guaranteed analysis of a commercial supplement, the values should be 
placed into the appropriate columns in the Ration Worksheet or Feed Library. Many nutritionists 
recommend that supplemental selenium and vitamins be fed at 100% of requirements, regardless of 
the amount supplied by feed ingredients in the base ration.  
 
It may be beneficial to leave "0" in the trace mineral and vitamin A, D, and E columns for all feeds 
except actual supplements (unless the feedstuff is grown in a soil with high selenium, such as those 
of the western Great Plains). Some nutritionists may wish to enter actual analyzed concentrations of 
iron of feeds in their Feed Library so that it is easier to track total iron concentration in the ration. 
Many times iron (from the base feed ingredients) is more likely to be much greater than needed to 
meet requirements, and they are concerned about monitoring the potential for iron toxicity. In 
addition, the actual values for molybdenum should be used in balancing rations, as Mo supply will 
impact the requirement for copper. 
 
In general, deliberately supplementing trace mineral elements or vitamins at concentrations much 
above twice the NRC DAIRY 2001 requirements (the requirements given in Spartan Dairy 3) 
cannot be justified and could even be dangerous if they are over-supplemented to concentrations 
that may cause toxicity or deleterious interactions with other nutrients. 
NOTE: When supplementing trace mineral or vitamin premixes, always consider the minimum 
inclusion rates of the premix in order to achieve for proper mixing to achieve a uniform distribution 
of all ingredients and nutrients in the ration.  
 
Concentrations of trace mineral elements (TM) that are toxic to cows also are toxic to humans. Be 
careful when using concentrated sources of TM. Avoid prolonged exposure to skin and lungs. Wear 
a dust mask while mixing. Making your own TM premix from pure TM sources is strongly 
discouraged for health risks and major challenges for accurate and precise weighing.  
 
Trace Mineralized Salts 
One common TM source is trace mineralized salt. TM salt generally should be fed at 0.5% of ration 
dry matter to supply adequate amounts of TM. Because TM salt is more expensive than white salt, 
and because salt is usually only needed at 0.2 to 0.4% DM, supplementing with TM salt can 
actually cost more than other methods, but it may be easier. 
 
The TM balance of many commercially available TM salts is not optimal for dairy rations. Also, not 
all TM salts are equal and suppliers may switch sources without notifying clients. If TM salt will be 
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used as the TM source, check the concentration of each TM in the ration to make sure requirements 
have been met. 
 
Trace mineral salts are usually generic mixes designed for all species and all locations and 
sometimes do not contain selenium. Selenium, however, is the trace mineral for which 
supplementation is most important in many locations. In addition, they do not contain vitamins, so 
both selenium and vitamin sources must be supplied in addition to the TM salt.  
Dry cows require much less salt (NaCl) than lactating cows, but their requirements for trace 
minerals and vitamins may not be much different on an absolute mass basis (e.g., mg/cow per day 
or IU/cow per day). They may benefit from more selenium than lactating cows. Therefore, using 
specially formulated trace mineral/vitamin packs is especially a good approach for rations of dry 
cows in late pregnancy. 
 
Trace Mineral/Vitamin Packs 
Custom-formulated TM/vitamin packs are used by dairy producers who employ the services of 
professional nutrition consultants. The prices of these packs often include the fees for consulting 
services. The concentration of TM/vitamin can be set to meet the basic needs of each animal class. 
Then supplementation on a percent of ration DM basis can be maintained for dry cows while 
decreasing the dietary supplementation of salt, calcium, and phosphorus. 
These packs vary considerably in their balance of TMs and vitamins. Whereas it is acceptable to 
supplement some TM at less than 100% of requirement, all TM's should be supplemented to at least 
half of requirements. Selenium and vitamins A, D, and E should be supplemented at 100% of 
requirements.  
 
Trace Mineral Premixes 
Trace mineral premixes vary considerably in their composition. Many are generic premixes for all 
species in all locations and therefore do not contain selenium, the trace mineral for which 
supplementation is most necessary and important.  
 
Vitamin Packs 
Vitamin A-D-E packs vary considerably in their composition. Many are generic mixes for all 
species and contain so little vitamin E that for all practical purposes, they are vitamin A-D packs. 
Although there are cases where vitamin E supplementation may not be necessary, generally, all 
three of these vitamins (A, D, and E) should be supplemented at 100% of requirements.  
 
Complete Dairy Mineral/Vitamin Premixes 
A good way to supplement all minerals and vitamins is to feed a complete dairy mineral/vitamin 
premix. Although the cost may be greater than some other methods, complete min/vit premixes are 
easy to use and generally will be fed at high enough inclusion rates to ensure adequate distribution 
during mixing into the whole ration.  
 
Nutritional services are often provided by the company selling the product and this must be 
considered when comparing prices of different mineral and vitamin sources.  
 
These supplements vary considerably in their composition, and the best one for a group of cows will 
depend on: the forage base of the ration; the ratio of grain to forage in the ration; and, whether the 
animals are lactating, dry, or heifers. Thus, you likely will need several different min/vit premixes 
for your farm, and these may change during the year if your forages change. The major difference 
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among premixes from the same company is usually the balance of macromineral elements, 
specifically the relative amounts of calcium and phosphorus. Some are balanced for corn silage-
based rations, some for alfalfa-based rations, and some for in between. The balance of trace mineral 
elements and vitamins also may be different among different companies and depending on which 
group of cows the premix is designed for -- such as close-up cows of mid-lactation cows.  
When comparing premixes, it is important to check the balance (i.e., proportions) of all minerals 
and vitamins, including the trace mineral elements. Make sure the concentrations are adequate for a 
dairy ration and feed the correct mix to each animal class or group of animals.  
 
Complete Dairy Base Mixes 
A good way to supplement some fat or protein, along with all required minerals and vitamins, is to 
feed a complete dairy base mix. Although the cost may be greater than some other methods, 
complete base mixes are easy to use and will be fed at high enough inclusion rates to ensure 
adequate distribution during mixing into the entire ration. 
 
Nutritional services are often provided by the company selling the product and this must be 
considered when comparing prices of different mineral and vitamin sources. For smaller farms 
especially, these mixes may be the most economical and efficient way to supplement minerals, 
vitamins, and high-quality protein or fat supplements.  
 
These supplements vary considerably in their composition, and the best one for a group of cows will 
depend on: the forage base of the ration; the ratio of grain to forage in the ration; the life-cycle stage 
(growing, lactating, or dry); and, the level of performance. Thus, you may need several different 
types of min/vit base mixes for your farm, and these may change during the year if your forages 
change. The major difference between base mixes from the same company likely will be the 
proportions of macromineral elements, the concentration of fat, and the concentration of rumen 
undegradable protein. The balance of trace minerals and vitamins also may be different among 
different companies.  
 
When comparing base mixes, check not only how the mix will help meet the cow's protein and 
energy needs, but also the balance of all minerals and vitamins. Make sure the concentrations are 
adequate for a dairy ration and be sure to feed the correct mix to each animal class or management 
group. 
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Amino Acid Characteristics  
Although ten amino acids are needed in the metabolizable protein supply of a cow, only two, 
lysine and methionine, are most likely to occasionally limit production.  
 
Essential amino acids are supplied to the cow from two sources: they are part of the protein found in 
rumen microbes that are digested in the small intestine and they are part of the feed protein that is 
not degraded in the rumen but is digested in the small intestine.   The concentration of each AA in 
the digested RUP fraction is likely not the same as its concentration in total CP, but it is not easy to 
estimate and certainly not easy to routinely measure the concentration in the digested RUP fraction.  
Thus, the concentration of lysine and methionine may be entered as a % of an estimate of RUP 
(residue after partial degradation by rumen bacteria) or as a % of total CP.  Given that AA are 
seldom actually measured, book values are appropriate.   
 
The requirement for lysine and methionine are considered to be 7.2% and 2.4% of the total 
metabolizable protein (MP) requirement.  Some nutritionists consider the ratio of lysine to 
methionine to be as important as the concentration of each, this ratio should be about 3:1.  In 
Spartan 3, the supply of lysine and methionine are not calculated the same as in the 2001 NRC.  
NRC uses regression equations, but in Spartan 3 we use a sum of the AA from the various sources.  
The NRC supply and lysine to methionine ratio can be viewed in Ratios and Relationships.   
 
Lysine (Lys)  
This is the % of the digested RUP that is lysine.   The requirement for lysine is considered to 
be 7.2% of the MP requirement.    The lysine concentration of cereal grains is typically low.   
 
Methionine (Met)  
This is the % of the digested RUP that is methionine.  The requirement for methionine is considered 
to be 2.4% of the MP requirement.  The methionine concentration of soy protein tends to be low 
relative to its total digested RUP supply.  In fact, both the NRC and Spartan models will often show 
methionine to be deficient, indicating that supplemental rumen-undegraded methionine would be 
beneficial.  Given the inaccuracies in estimating AA supply and requirements, we encourage close 
monitoring whenever AA supplements are indicated to be sure that a positive response occurs.   
 
Total Essential Amino Acids (TEAA)  
This is the % of the digested RUP amino acids that are essential.  Essential AA are phe, trp, leu, ile, 
val, thr, his, arg, lys, and met.  
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Cost Characteristics  
In Spartan 3, the cost of a feed can be entered on a wet weight (as sold) basis or on a per 
pound or kg of DM basis.   The Spartan 3 system was designed for US currency.  However, if 
you want, you can enter your costs in other currencies.  Unfortunately the $ sign will still 
appear in the program and on printed reports.   We apologize for this inconvenience.   
 
Cost as Sold (Cost AsSold)  
The cost per unit with the unit being that defined by the Weight AsSold column.   
 
Weight as Sold (Wt AsSold)  
The weight on a wet or as sold basis that corresponds to the denominator for the Cost AsSold 
column.   
 
Cost of Dry Matter (Cost DM)  
The cost per unit of dry matter as either pounds or kg, depending on which measurement system is 
specified.   

CostPerKgDM = (CostAsSold / WtAsSold) / (DM/100) 
 
Purchased Feeds (Purchased?) 
Check the box for any feeds that are purchased from off the farm.  The summation of the cost of 
each of these purchased feeds is the Purchased feed costs in Ration Ratios and Relationships.    
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Miscellaneous Characteristics  
Test Date  
Test dates can only be used in month/day/year formats.  Whenever a feed is retested, you may wish 
to keep the old test information in your library.  If you copy feed data from excel, make sure the 
date format in Excel is correct, or the copy and paste function will not work properly.   
 
Feed Type  
Some calculated feed characteristics use feed type as an input.  

 
The following table lists the 13 feed types supported in Spartan Dairy 3, and how these map to Feed 
Categories used in the nutritional model. 
   Mapping Feed Types to Feed Categories  

Feed Type Feed Category 
Dry forage DF  
Corn silage WF 
Alfalfa silage WF 
Other wet forage WF 
By-product C 
Grain C 
Fatty acid source FA 
Triglycerides TRI 
CP source C 
RUP source C 
Mineral C 
Vitamin C 
Mix MIX 

Feeds can also be sorted on feed type. Sort order shown in table from top to bottom 

The feed type “Mix” is reserved for mixes.  If you convert a mix into a feed, you must change its 
feedtype to something other than “Mix”.  If you leave it as a mix, some calculations may be 
inaccurate.  Choose whichever feedtype is  closest.  For a concentration mix, choose “Grain”.  For 
ration TMR, the best choice is probably “forage” but you the forage NDF will be inaccurate.   
 
Feed Category 
Some calculated feed characteristics use feed category as an input in their equations. Each of the 13 
feed types maps to one of 6 feed categories used in the nutritional model. These categories are not 
visible in the program, but are used in several calculations.  Thus, you may see them in the 
transcript window.   
 
Common Feed? 
Check this box if a feed is used frequently.  This is not particularly useful in feed rations, but is 
helpful for organizing feeds in a library.   
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Blank Columns 1‐5 
The blank columns are user-defined.  The column format and number of decimal places can be 
defined in the Settings>User Defined Columns...  command of the menu.  Blank columns can be 
defined with the caption of your choice and with the following units:  
• No calc 
• currency 
• weight  
• concentrate 
• % 
• %DM 

• %CP 
• %NDF 
• %starch 
• %fatty acid 
• %RUP 
• %dRUP 

• ppm 
• IU/wt 
• mg/wt 
• g/wt 

 
Some examples of how to use the blank columns: 
• Physically effective NDF: Set caption to “peNDF” and the units to %NDF.  Enter appropriate 

values.  On an amount basis, you will see the kg or lb of peNDF supplied per day.   
• Histidine: Set caption to “His” and units to %dRUP.  Enter appropriate values.  On an amount 

basis, you will see the g of His supplied per day from the digested RUP feed fraction.  The 
amount from microbial protein will not be available. 

• Sort Order: Set caption to “Order” and units to No calc and enter a min and max values to define 
the range of valid numbers from 0 to 500.  Make numbers for each feed that give its priority 
place in the order of ration ingredients.  Use a wide range with plenty of gaps—so give forages 
numbers between 1 and 30, give byproducts values of 50 to 80, grains 100 to 120, proteins 150 to 
170, and minerals 200 to 240.  Click on the heading and the feeds will sort in this order, click 
again and they go in reverse order.  Because mixes are always given a zero for a NoCalc column, 
you might want to put these in reverse order.  Or set the units for the Order column to mg/wt.   

 
Unfortunately requirements for these cannot be set and the information will not be printed in a 
report unless the full office report is specified.  The blank columns are unique to one version of 
the program and are defined by the user.  So if a ration is sent from one user to another, the 
blank column settings will be lost.  If both users have the same settings for each blank column, it 
will work fine as the numbers for each feed are kept.   
 
In addition, when a feed is copied to excel, the blank column settings are lost.   
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Chapter 7 
Feed Libraries 

 
Feed libraries store information about feeds.   
 
Creating a New Feed Library  
To create a new library, choose File>New Feed Library.   
The first step in creating a new library is to choose the source of the 
feeds for your new library.  The first dialog box that opens upon 
choosing to create a new feed library is the “Select Source” box.  Some 
users may be confused and think this is where they enter the name of 
the new library they are creating.  Instead use the box to browse 
through your files to find sources for feeds.  A good source is the Master Feed Library. 

 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 

Opening an Existing Feed Library  
To open an existing library, choose File>Open Feed Library. 
 
Library Toolbar  
The library toolbar has several components and 
submenus for working in the library.  There are 
also several hot buttons.   
 
Master Feed Library 
The Master Feed Library cannot be modified.  Thus, its contents can serve as a standard should 
information be lost from other libraries.  Moreover, you cannot copy the Master Feed Library in 
Windows and then edit it.  If you want to use all of the feeds from our library to build your own 
library, you should use the Sample Library.  Open the Sample Library and save it with a new name.  
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Then make any changes you want and resave.  Once resaved, you will be able to find the new feeds 
with the Add Feeds dialog.   
 
Organizing Feeds Data  
You can have an unlimited number of feed libraries, but generally it would be reasonable to have 
one feed library for a farm.  If you balance rations for several farms, you might want a separate 
library for each farm and then a common library for feeds used across farms.   
 
Using Common Feeds in a Library 
Feeds that are commonly used within a library should be checked in the Common Feed? column of 
the Misc. tab.  Then when finding feeds in the Add Feeds dialog, you can check the box for 
Viewing common feeds only and quickly find the feeds you use most often.   
 
Tracking Feed Composition Changes 
Use the Test Date column of the Misc. tab to track changes in the composition of a feed over time.  
Every time a feed is updated, use the Feeds>Update Feed command, which will copy the row to 
make a new feed with the same name and composition but with the current date as the new Test 
Date.  You can then change the values for feed characteristics, such as %NDF and %CP, that are 
different. 
 
Adding new feeds to an existing Library 
To add new feeds to an existing library, select the Add Feeds function from the menu.  The 
command and dialog box work like they do for adding feeds to a ration.  You may select feeds from 
other libraries or from rations.  You should also check our website for additional feeds that may 
not be included in our original libraries.   
 
See also 
• Chapter 5: Working with Feeds.  In particular, read the sections on:  

o Filtering Feeds 
o Updating a Feed in a Library 
o Editing Nutrient Composition 
o Feed tags 
o New feeds 
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Chapter 8 
Describing a Target Animal 

 
This chapter includes: 
• Selecting Animal Breed and Type 
• Animal Descriptions 
• Set Daily Body Weight Gain Parameters 
• Set Environmental Parameters 

• Set Feed Additives 
• Understanding Animal Weights 
• High Energy Density Warning

 
This menu item is used to set body weight, milk production, daily gain, and other parameters that 
are used to predict how much an animal will eat and its nutrient requirements.  
     
Selecting Animal Breed and Type 
Use this dialog box to select the breed and type of animal to 
be described further in other dialogs.   
  
Choices for animal type are: 
• Lactating cow 
• Dry cow/ late pregnant heifer -- heifers within 2 

months of calving 
• Heifer 
 
NOTE: The only difference between breeds in Spartan 
3 is the default settings for body weights, milk 
production and composition, and frame gain. The nutrient requirement and feed intake equations 
are the same for all breeds. Although we realize that this may result in some error, the equations 
seem to give reasonable results. 
    
Animal Descriptions  
Mature body weight is predicted based on breed. It should be adjusted when appropriate. Mature 
BW is used in the program to predict current BW. Current BW is used to estimate feed intake and 
requirements for most nutrients, so this setting can have a major effect on the final target diet. 
Current body weight information is altered in the "Set Daily Body Weight Gain Parameters" dialog, 
which sequentially follows this dialog box when starting a new ration or can be viewed by selecting 
"Gain and Pregnancy..." from the "Animal" sub-menu. 
 
Actual dry matter intake is used for several calculations in the Ratios and Relationships dialog and 
in reports. 
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Describing a Target Heifer  
Use this dialog to input target values for a 
growing heifer.  

 
Current age: used to establish default 
values for body weight. 

Total body weight: This is current BW if 
the heifer was weighed on a scale.   

Mature body weight: the predicted based 
on breed. It should be adjusted when 
appropriate. Mature BW is used in the 
program to predict current BW. Current 
BW is used to estimate feed intake and 
requirements for most nutrients, so this 
setting can have a major effect on the 
final target diet. Current body weight 
information is altered in the "Set Daily 
Body Weight Gain Parameters" dialog, 
which sequentially follows this dialog box when starting a new ration or can be viewed by 
selecting "Gain and Pregnancy …" from the "Animal" sub-menu. 

Target age: the age for the end point of the current growth period. 

Target Non-pregnant BC3 body weight: Target body weight of the heifer adjusted to a body 
condition score of 3 and after subtracting the tissues of pregnancy (if appropriate) This is the 
target for the end of the current frame gain period. This target end point is used to calculate the 
daily frame gain. The value you enter here must be equal to or greater than the current non-
pregnant BC3 body weight. 

Actual dry matter intake (DMI): Actual DMI is used for several calculations in Ratios and 
Relationships dialog and in reports 
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Describing a Target Lactating Cow 
Use this dialog to input target values for a 
lactating cow. 
 

Selecting a lactating cow stage: Changing 
the cow stage automatically adjusts the default 
settings for days in milk, which in turn alters 
default settings for cow body weight and 
condition. These can be set independently. 
Days in milk is set to 10 for fresh cows, 60 for 
early lactation cows, 120 for a mid lactation 
cows, 240 for late lactation cows, and 320 for 
predry cows. 
 
Setting current information for lactating 
cows 
How current lactation affects model 
predictions: Changing the lactation number 
automatically adjusts the body weight of the 
cow and her daily body weight gain. Cows in 
lactation 1 are assumed to be 80% of mature 
weight at the beginning of the lactation, and 
they gain body frame over 400 days to 
achieve 92% of mature weight at the beginning of lactation 2. During lactation 2, they gain body 
frame so that they have achieved mature weight at the beginning of lactation 3. 
How days in milk affects model predictions:  Days in milk (DIM) is used to predict the current 
body weight and condition of the cow, based on her mature weight and lactation number. 
 
Setting Milk Production Information  
Target milk production and composition: Target milk yield and composition are used to calculate 
nutrient requirements and predict feed intake for a cow. Default values for composition are 
included based on cow breed, but yield is left blank. Thus, it is essential that you enter a value for 
target milk yield when evaluating or balancing a diet. Targets for %fat, %protein, and %lactose 
can be altered. Adjusting %fat will adjust %protein, but once you have altered the %fat, you can 
adjust the %protein independently. 

Actual milk production and composition: Actual yield will be the target yield by default, but if 
actual yield is entered, it will be used for several calculations in the Ratios and Relationships 
dialog and in the reports. 

Farm milk price: If a value is entered, it will be used to calculate income over feed costs in the 
Ratios and Relationships dialog. 

Actual dry matter intake is used for several calculations in the Ratios and Relationships dialog 
and in reports. 
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Describing a Target Dry Cow/Pregnant Heifer  
Use this dialog to input target values for a dry 
cow or heifer in the last 2 months before 
calving.  

Cow stage 
Changing the cow stage automatically 
adjusts the default settings for days in milk, 
which in turn alters default settings for cow 
body weight and condition. These can be set 
independently. Days to calving is set to 40 
for dry cows and pregnant heifers and to 21 
for close-up dry cows and heifers.  

Upcoming lactation number 
Changing the lactation number automatically 
adjusts the body weight of the cow and her 
daily body weight gain. Cows in lactation 1 
are assumed to be 80% of mature weight at 
the beginning of the lactation, and they gain 
body frame over 400 days to achieve 92% of 
mature weight at the beginning of lactation 
2. During lactation 2, they gain body frame so that they have achieved mature weight at the 
beginning of lactation 3.  

Days to calving 
Days to calving is used to predict the additional body weight due to pregnancy, to determine 
nutrient requirements for supporting the pregnancy, and to predict the depression in feed intake 
in late pregnancy.  Days to calving is used to calculate Days Pregnant assuming that pregnancy is 
280 days.   

Days to calving influences predicted DM intake and Nutrient requirements. 
• Nutrient requirements, especially energy and protein, are increased as pregnancy progresses 

and the gravid uterus gains mass.  Requirements are further increased in the last 3 wk before 
calving as the mammary gland undergoes growth in preparation for lactation.  

• Predicted intake decreases as calving approaches. 
• The difference between Total BW and BW without fetus increases as calving approaches. 
• DCAD strategy further alters requirements and intake in the last 3 wk.  

Total body weight 
Current total body weight of the cow; this includes weight associated with pregnancy. This will 
be used in balancing the diet.  

Body weight without fetus 
Predicted current body weight if the cow was not pregnant.   
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Mature body weight 
Mature body weight is predicted based on breed. It should be adjusted when appropriate. Mature 
BW is used in the program to predict current BW.  Current BW is used to estimate feed intake 
and requirements for most nutrients, so this setting can have a major effect on the final target 
diet.  Mature BW is adjusted to a body condition 3 basis, so it can be less than current total BW 
or BW without fetus if the cow is fat.  Current body weight information is best altered in the "Set 
Daily Body Weight Gain Parameters" dialog, which sequentially follows this dialog box when 
starting a new ration or can be viewed by selecting "Gain and Pregnancy …" from the "Animal" 
sub-menu. 

Actual dry matter intake (DMI) 
Actual DMI is used for several calculations in Ratios and Relationships dialog and in reports. 

DCAD strategy 
DCAD is Dietary Cation-Anion Difference. The risk of hypocalcemia and associated 
complications is decreased when dry cows are fed diets with DCAD values less than 0. Choices 
for DCAD strategy are to ignore it or strive for a low or moderate DCAD diet. Choosing the low 
DCAD strategy will increase requirements for calcium.  

DMI adjustment 
This variable enables you to alter the predicted feed intake in cases where cows in a specific 
situation typically eat more or less than the Spartan 3 prediction.  

Predictions from Target Animal  
Note that at the bottom of the Describe target animal box, there is a panel titled “Predictions from 
ration targets”.   This panel gives you a quick summary of the implications of the target values you 
have specified.   
 Predicting Dry Matter Intake  

The predicted base DMI is predicted from BW, milk yield and composition, and body weight 
gain.  The equation is:  

 
The predicted adjusted DMI is predicted from the base DMI but modified for days before or after 
pregnancy.  As dry cows approach calving, DMI typically drops.  And in early lactation, most 
cows are not able to eat as much as they would later in lactation for a given BW, milk yield, milk 
composition, and body weight gain.  The equation is:    

 
 Predicting Energy Needs   

The predicted NE and ME density needed to meet the animal’s requirements is also listed.  This 
is based on the energy requirements to meet the target animal specifications and her predicted 
intake.   
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Set Daily Body Weight Gain Parameters  
Use this dialog to alter current body weight and 
body condition and targets for weight and 
condition.  The dialog is divided into 3 panels.  
Use the top panel to alter current body weight 
and condition, the middle panel to alter targets 
for frame gain, and the bottom panel to alter 
targets for condition gain.  For pregnant cows or 
heifers, the top panel is used to calculate daily 
gain associated with pregnancy.  At the bottom 
of this dialog, the sum of pregnancy gain, frame 
gain, and condition gain is displayed. 

Current total body weight is what would be 
measured if the cow was weighed on a scale.     

Current body condition score is on a 1-5 
scale with 1 being extremely thin and 5 
obese. 
Current days pregnant is used to determine 
nutrient requirements associated with 
pregnancy and to estimate weight of the fetus 
and tissues of pregnancy.   Days pregnant = 280 – Days til Calving. 
Current body weight without fetus is an estimate of the current weight of the cow after 
subtracting the tissues of pregnancy.  
Current non-pregnant BC3 body weight is the body weight of the cow adjusted to a body 
condition score of 3 and after subtracting the tissues of pregnancy. 
Mature body weight is the non-pregnant BC3-adjusted body weight of the cow when she is 
mature.  Generally mature BW is reached in lactation 3.   
 
Target Frame Growth Settings  
Target non-pregnant BC3 body weight is the target body weight of the cow adjusted to a body 
condition score of 3 and after subtracting the tissues of pregnancy. This is the target for the end 
of the current frame gain period. This target end point is used to calculate the daily frame gain. 
The value you enter here must be equal to or greater than the current non-pregnant BC3 body 
weight. Once a cow reaches her mature body size or frame size, she will no longer gain frame 
size according to the Spartan equations, but instead would gain only condition. The target usually 
would be several days or weeks out. 

Days to achieve frame growth is typically the number of days left in the current lactation for a 
lactating cow, days til fresh for a pregnant heifer or dry cow, and days of the current growth 
phase for a heifer.  
 
Target Body Condition Gain Settings  
Target body condition score is that desired for the end of the current condition change period. 
This defines the target end point that will be used to calculate the daily condition gain or loss.  
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Days to achieve body condition is the days to achieve the target condition score. For a fresh 
cow, a reasonable value would be 60 days for a slight loss in condition. For a cow in mid-
lactation, a reasonable value would be 150 days for a 0.5 gain in body condition. For a dry cow, 
the days-til-fresh would be appropriate.  
 
Body Condition    
We use a 1 to 5 scale for condition (fatness) with 1 being emaciated and 5 being obese.  
Typically  cows vary in the lactation cycle between slightly fattened (3.5 to 4.0) at calving to thin 
(2.0 to 2.5) at 60 days after calving.  Thus most cows must gain about 1 to 1.5 condition score 
points in the last 200 days of lactation.  This translates to about 1 pound (half kilogram) of body 
weight gain per day.    
 
In the Spartan Dairy 3 model, body condition gain or loss is mostly fat but also contains protein 
and this depends on the current condition of the cow.  For a typical Holstein cow (680 kg if BCS 
3.0), 1 change in condition score is associated with 93 kg (205 lb) body weight.  If the cow is 
currently a BCS of 1.5 (thin), a gain or loss of condition will be about half muscle and half fat; 
each kg of condition gain contains 4.4 Mcal of energy and 9.0% protein.  If the cow is currently a 
BCS of 4.5 (fat), a gain or loss of condition will be mostly fat tissue; each kg of body condition 
gain contains 7.6 Mcal of energy and 2.5% protein.  Requirements for condition gain or loss are 
based on the NRC 2001 model.   
 
Frame Growth 
Frame growth is normal growth of a young heifer or cow and is the normal body tissue growth 
that occurs as an animal gains body weight with no change in body condition or fattening.  Thus, 
frame gain includes muscle, bone, fat, and other tissues.  Early in life, frame growth is mostly 
lean tissue.  As an animal progresses along its growth curve, the frame gain will contain a higher 
proportion of fat relative to lean tissue.  Requirements for frame growth are based on the NRC 
2001 model.   

   
Excessive Gain Warning 
At the bottom of the Set Daily Body Weight Gain dialog, the sum of pregnancy gain, frame gain, 
and condition gain is displayed.  If this sum is greater than 0.8 kg (1.8 lb) or less than -0.9 kg (-2.0 
lb), a warning box is displayed upon accepting inputs for the dialog.  You can choose to ignore the 
warning, but we suggest you examine inputs to verify their accuracy.      
 
Set Environmental 
Parameters  
Use this dialog to edit target 
inputs for temperature and 
activity.  Both of these inputs 
will impact predicted feed 
intake and energy 
requirements.  The top panel of 
the dialog is used to set targets 
and the bottom panel shows the 
impact to feed intake and 
energy requirements.   
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 Temperature Stress 
Choices for temperature 
stress include 7 temperature 
levels ranging from severe 
cold to severe heat.  When 
estimating temperature 
level, you should consider 
actual ambient temperature, 
humidity, wind speed, coat 
condition and adaptation of 
the animal, and exposure to 
sun, rain, or snow averaged 
over a day.  Also consider the relative temperature for day vs night.  The impact of the 
temperature level setting is displayed in the two boxes to the right.  You can choose to refine 
these adjustments directly, but be cautious as the temperature setting, especially heat stress,  can 
have a huge impact on the required nutrient densities of a diet.   
    
Activity Level   
Choices for activity level 
include 4 settings ranging 
from no work to extreme 
work.  When estimating 
activity level, you should 
consider distance walked, 
topography, and mud.  
Extreme work would be 
similar to a lactating cow 
grazing a hilly pasture and 
walking 8 km a day for milking in the 2001 NRC model.  The impact of the activity level setting 
is displayed in the two boxes to the right.  You can choose to refine these adjustments directly.   

  
Set Feed Additives 
This dialog can be used to alter the 
intermediate calculations used in 
determining how feed energy and 
protein are used to meet 
requirements for growth and milk 
production.  Impact of feed 
ingredients on feed intake and 
maintenance can also be included.   
   
At present, only one feed additive, 
“ionophore”, is given as an option 
in the program.  Default values for 
the impact of ionophore on 
efficiency are included in Spartan 3, 
but we do not guarantee their accuracy.  For ionophore to alter program equations, you must check 
the box stating that the factor is legal.   
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Understanding Animal Weights 
Body weight is considered several different ways in Spartan Dairy 3.   
Non-pregnant-BC3-body weight (NP3BW) is the standard body weight used in Spartan 3; it is the 
expected body weight if the animal was not pregnant and had a body condition score of 3.  This 
weight only changes when an animal is growing so its frame size is increasing.  Changes in weight 
due to pregnancy or to body condition gain or loss do not alter NP3BW.  Frame gain will increase 
NP3BW, and frame loss cannot occur, so NP3BW can only increase or stay constant as an animal 
gets older in Spartan Dairy 3.  Once the animal has achieved its mature BW, NP3BW is constant. 
 
Total body weight is the weight if you weighed the animal on a scale.   
 
Body weight without fetus is corrected for pregnancy only and is the estimated body weight 
without the extra weight of the fetus, enlarged uterus, and placenta.  Total body weight may be 
greater than NP3BW if an animal is fat or pregnant.   Total BW will be less than NP3BW if an 
animal is thin and not pregnant. 
 
Mature body weight is the expected mature weight of a cow on a body condition 3 equivalent and 
nonpregnant basis.  Mature body weight cannot be less than the current non-pregnant BC3 body 
weight.  Thus, if you increase an animal’s current NPBC3BW,  mature BW will be increased if it is 
not at least as great as the new number.  Conversely, if you decrease the mature BW of an animal, 
the current NP3BW will be decreased if it is not at least as low as the new mature BW.   
 
Spartan Dairy 3 also has targets for BW at some future time.  The target BW must always be 
entered on a nonpregnant and BC3-equivalent basis.  The target BW cannot be greater than the 
mature BW, because both are on a non-pregnant and body condition 3 basis. 

 
 

High Energy Density Warning  
After pressing okay for a dialog describing a target animal, a warning window may pop up.  This 
window will tell you that the maximum NEL density should be less than 1.76 Mcal/kg.  This is 
likely to happen if you enter a very high level of milk production, a cow less than 60 days in milk, 
or heat stress.   Regardless of whether the warning appears or not, the new entries will be accepted.  
However, if the warning appears, you should check to make sure the target animal is accurately 
described at the top of the ration worksheet.  More importantly, before you press okay on any 
dialog, be sure to check the entries.  And when balancing a ration, remember it is more important to 
meet the fiber requirement for a cow than to meet its energy requirement.   
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Chapter 9 
Working With Rations 

 
This section of the Help system gives tips on how to use the program to evaluate and create a new 
ration.  The chapter includes: 
• Creating a New Ration 
• Opening an Existing Ration 
• Ration Toolbar 
• Group Information 
• Nutrient Balance Graph 

• Metabolizable Protein Systems 
• Ration Ratios & Relationships 
• Balancing Supply Against Requirements 
• Strategies for Balancing Rations 
• Strategies for Improving Management

 
Most of the items in this Help section are accessed using the Ration command of the Worksheet 
Menu once a Ration File is open, which is done using File command of the main Spartan menu.  .   

 
 
Whenever you are working in a ration, it is a good idea to check occasionally to make sure you 
described the animal correctly, especially if the numbers just don’t seem to be working as you 
expected.  You can reopen the animal description dialogs, but a quick summary of the animal is 
always visible at the top of the ration worksheet.   

   
In this example, the animal being fed is a close-up dry cow weighing 1750 lb at 10 days til fresh 
with a target gain of 3.2 lb per day.  The “12” is the number of cows in the group. 
 
The program has multiple tabs for viewing all the feed characteristics and examining diet supply 
relative to requirements.  These tabs are visible at the bottom of the ration worksheet.   
 

 
 
 Creating a New Ration   
 To create a new ration, select File > New > Ration.  You must first go through several dialogs to 

describe the target animal (1: Select Animal Breed and Type, 2: Describe Target Animal, 3: Set 
Daily Body Weight Gain Parameters) and choose feeds to use in the ration.   

   
 Opening an Existing Ration  
 To open an existing ration, select File > Open > Ration.  A dialog will open for you to browse 

through directories and files until you select the desired file.   
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Ration Toolbar  
 The ration toolbar consists of several shortcut command buttons just below the ration menu.   

   
 These include shortcuts to create a new ration, open an existing ration, save a file, add feeds, 

open the animal description dialog, open the Ratios and Relationships output dialog, modify the 
nutrient balance graph, or print the mix, batch, summary, or full office reports.  In the above 
example, the print mix option is not available because the ration includes no mixes; thus the 
button is grey.   

 
 Nutrient Balance Graph  
 Use the nutrient balance graph to get a quick visual representation of how well a diet meets the 

requirements of the target animal.  You can set whether or not the graph is displayed and which 
feed characteristics are displayed within the graph by several methods.  Select  Ration > Nutrient 
Balance Graph Settings from the main Ration menu, type Ctrl +G, or hit the graph setting button 
of the toolbar.  If the graph is already in view, you can also right click with your mouse anywhere 
on the graph.  The graph can display up to 30 feed characteristics.  Each characteristic is 
displayed as the amount of the nutrient supplied above or below its requirement and expressed as 
a % of the requirement.  Thus, if the nutrient is supplied exactly at its requirement, no bar will be 
visible at it will be 0% above or below requirement.  If the nutrient is 10% deficient, the bar will 
extend to the left to the 10% band.  If the nutrient is oversupplied by 10%, the bar will extend to 
the right.  Ideally, all the bars should be very small, indicating that most nutrients are supplied 
very close to their requirements.     
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The Ration submenu has 3 choices. 
 
Group Information  
 Use the Group Information dialog to give 

a name to your ration and to specify the 
number of animals in the group.  The 
batch report will use this number to calculate the recipe for making a batch of feed for the group.  
 

Metabolizable Protein Systems  
The Metabolizable Protein (MP) supply can be calculated by 3 different methods.  If you choose the 
NRC 2001 method, the MP supply will be exactly the same as the MP01 supply.   

 
 Spartan Dairy 3 MP System 

If you choose the default Spartan 3 system, the MP 
supply will be very similar to that of MP01 in most 
situations.  By default, Spartan 3 uses the NRC 2001 
coefficient for calculating Microbial Crude Protein 
(MCP) production from fat-corrected TDN; both systems 
use 0.13 kg MCP per kg fat-corrected TDN supply.  The 
fat correction for TDN is slightly different so that for 
most diets where energy limits MCP yield, the MCP 
yield will be slightly greater for Spartan 3 than for NRC 2001, and MP supply will be slightly 
greater than MP01 supply.  This coefficient can be edited; using a value of 0.14 would increase 
MCP production further in Spartan 3 and decrease the need for RUP supplements. 
 
More importantly, the amount of RDP needed to maximize MCP yield is lower in Spartan 3 than 
in NRC 2001.  Thus, for diets low in RDP, the prediction for MCP synthesis will be greater for 
Spartan 3 than for NRC 2001, and Spartan 3 will require less RUP supplementation.  This is 
because Spartan 3 assumes that some blood urea can recirculate to the rumen for use by bacteria, 
whereas NRC 2001 equations do not increase urea recycling to the rumen when high CP diets are 
fed.  See help on the nutritional model for more information.  The Spartan system can be adjusted 
as well.  A higher value means that more MCP can be produced from a given amount of RPD.   

 
RDOM MP System 
RDOM is Rumen-Digested Organic Matter.  The RDOM MP system is based on the idea that 
what matters for predicting MCP production is the amount of organic matter digested 
(fermented) in the rumen.  The problem with using fat-corrected energy is that some of it may 
not be fermented in the rumen.  By default, the RDOM MP system uses a coefficient for energy-
potential MCP yield of 30 g Microbial N per kg of RDOM.  The N-potential MCP yield for the 
RDOM MP system works the same as the Spartan 3 MP system.     
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Ration Ratios & Relationships  
This dialog gives useful information that does not neatly fit into a feed characteristic column.   
    

     Ratios and Relationships for the Sample Lactating Cow 
 

Intake Ratios & Relationships: If you entered a value for Actual Dry Matter Intake (DMI) in 
the animal description dialog, that value will be shown here.  Otherwise, the Actual DMI will be 
the total DMI supply shown on the ration worksheet.  This value will be used for all calculations 
involving Actual DMI in the Ratios and Relationships dialog box.  NRC01 Predicted DMI is the 
predicted DMI using NRC 2001 equations.   
 
If you entered values for actual milk, milk fat%, and milk protein % in the animal description 
dialog, then Energy-Corrected Milk (ECM) is based on actual milk entries.  If these values are 0, 
then ECM is based on the target milk entries.  ECM corrects the amount of milk for the 
concentration of fat and protein, so if the % fat and protein are high, ECM will be adjusted up.  If 
they are low, ECM is adjusted down.  Changes in fat have greater impact than changes in protein.  
ECM per unit of DMI is one way to consider efficiency.  DEp/DE1X indicates the digestibility of 
the diet for the target cow as a percent of the expected digestibility if the cow had been eating 
only enough for maintenance (no gain or loss of body tissues and no milk or fetal gain).   
   
Heifer Production Relationships 
This panel includes energy- and protein-allowable gain based on estimated energy and protein 
supply, which are calculated from Actual DMI and diet composition.  Assumptions to calculate 
allowable gain are that target requirements for thermoregulation, work, and pregnancy must be 
met and that body condition will not be lost to provide frame gain. Thus, any net energy or 
metabolizable protein that exceeds the requirements for maintenance, pregnancy, physical work, 
and thermogenesis can be used for gain.   In addition, net energy intake is adjusted for any excess 
RUP or RDP to discount the energy value of excess protein. 
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Lactating Cow Production Relationships 
This panel includes energy- and protein-allowable milk based on estimated energy and protein 
supply, which are calculated from Actual DMI and diet composition.  The composition of 
allowable milk will be the actual milk composition if values for these fields in the animal 
description are greater than 0; otherwise it will be the target composition.  Assumptions to 
calculate allowable milk are that target requirements for frame gain, pregnancy, 
thermoregulation, and work must be met and that body condition will not be lost to provide milk. 
Thus, any net energy or metabolizable protein that exceeds the requirements for maintenance, 
frame gain, pregnancy, physical work, and thermogenesis can be used for milk.   In addition, net 
energy intake is adjusted for any excess RUP or RDP to discount the energy value of excess 
protein. 
 
Dry Cow Production Relationships 
This panel includes energy- and protein-allowable body condition gain based on estimated 
energy and protein supply, which are calculated from Actual DMI and diet composition.  
Assumptions to calculate allowable BC gain are that target requirements for thermoregulation, 
work, frame gain, and pregnancy must be met. Thus, any net energy or metabolizable protein that 
exceeds the requirements for maintenance, frame gain, pregnancy, physical work, and 
thermogenesis can be used for gain.  In addition, net energy intake is adjusted for any excess 
RUP or RDP to discount the energy value of excess protein. 
 
Cost Ratios & Relationships 
This panel includes variables that give an indication to ration prices.  Feed cost per ME3X is a 
good way to compare ration costs because it eliminates variability in feed cost per unit energy 
due to differences in total feed intake and the digestibility discount.  ME3X is the energy value of 
a ration assuming that the animal is eating 3X its maintenance energy requirement. The other 
variables in this panel are calculated by standard methods.  The feeds considered purchased feeds 
are those with a check mark in the column for “Purchased?” in the Cost tab of the ration 
worksheet.   
 
Diet Composition Information 
This panel contains several ratios related to diet composition, including % forage, forage NDF,  
the protein to energy ratio, and lysine and methionine content.  CP/ME3X can be useful for 
comparing diets for heifers and removes variability due to differences in total intake and 
digestibility discount.  MP/ME is useful when comparing similar target animals as both MP and 
ME are altered by total feed intake.  Lys:Met is the ratio of these two amino acids using the 
Spartan 3 estimates for absorption.  The remaining Lys and Met values are estimated using NRC 
2001 equations.   
 
Nutrient Management Information 
This panel contains information useful for nutrient management planning and for devising 
strategies to reduce N and P waste.  Because diet can have a major impact on nutrient excretion, 
these values provide a more accurate method for predicting N, P, and K output than standard 
values.  All values are given on a per animal basis.  P and K excretion are given as P2O5 and 
K2O equivalents, which are more helpful for land application considerations. 
 
Fecal DM is predicted from the equations for digestibility in the model.  Predictions for N 
captured and excreted are based on actual values for feed intake, diet composition, and milk yield 
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(if entered) and target protein gains for body condition, frame, and pregnancy.   Fecal N is 
predicted based on equations for protein supply and urinary N is by difference.  P capture and 
loss is calculated similarly to N and assume animal tissues are 0.7% P and milk is 0.09% P.      

 
Comparing Supply of Nutrients to Requirements  
When evaluating or balancing a diet in Spartan 3, there are several ways to examine the supply of 
each nutrient relative to its requirement.  At the bottom of the ration worksheet, you can see the 
supply of each nutrient, it total requirement, and the difference between the two.  A positive number 
means the diet supplies more than required; a negative number indicates a deficiency.  If the 
deficiency is severe, you probably should fix the problem.  However, if the shortage of a nutrient is 
small relative to its requirement, it is not worth your concern.  For example, a shortage on NEL of 
0.80 Mcal per day is only 2% of the ~40 Mcal required by a high-producing cow.  Given the 
inaccuracies in our prediction equations for NEL requirements and supply, this is hardly worth 
worrying about.  One way to get a better idea of important differences between supply and 
requirements is to use the Nutrient Balance graph.  If the bar for a nutrient is barely visible, then it 
is close enough to its requirement.   
 
Strategies for Balancing Rations  
Some general recommendations for balancing diets are:  
• When you describe a target lactating cow, use the actual average milk of a group.  This way you 

will get a DMI that is reasonable.  If you want to “lead feed” a group (feed for the better cows in 
the group), you can always just balance energy and protein to be a little on the high side.   

• Be systematic.  First balance for fiber and energy, then for protein, then for minerals and 
vitamins.  Basically, use the nutrient balance graph, and work your way down the graph.   

• When you adjust amounts of feeds, it works best to adjust feeds on a DM basis  
• When you work in the ration worksheet, it is helpful if the feeds are organized by feed type.  To 

sort feeds by feed type, go to the Misc. tab and click on the Feed Type heading.  Clicking once 
will put forages dry forages at the top.  Clicking again will sort in reverse.  You can also sort 
feeds with the Feeds > Sort feeds by command.  See help on Working with Feeds for more 
info. 

• Do not get caught up trying to meet nutrient requirements exactly.  If you are within 2% of a 
requirement (100 x difference / requirement), that is close enough. Turn on the nutrient balance 
graph and watch it rather than the difference row as you adjust feeds.     

• There are many calculations that occur each time you change the amount of a feed.  Depending 
on your computer, you may notice a time lag between pressing enter and getting the new results.  
If you try to change numbers too quickly, you may experience errors in the program.  In general, 
wait to enter a new number until results from the previous change have returned. 

 
Steps for Balancing a Lactating Cow Ration: 
1. Describe the target cow and choose feeds.  
2. If you want to use a high-fiber byproduct feed, choose up front how much you want to 

use.  There are many factors to consider when making this decision, but one that is 
helpful is the cost per unit energy.  You can examine the cost per unit ME in the Feed 
Relationships dialog.  Select the feed row after entering the price you can purchase it for, 
and then choose Feeds > Feed Relationships.   
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3. Forage NDF.  Add forages to make up about half the diet and adjust so that the Forage 
NDF requirement is just met.  To make this easy, turn on the ForNDF display in the 
Nutrient Balance Graph.   
• Instead of using Forage NDF, you could add forages to about 90% of the Effective 

NDF requirement.  Because grains have some Effective NDF in the Spartan 3 
system, you do not need to be at 100% of the Effective NDF requirement yet. 

• For animals with low requirements, you may want to feed well above the Forage 
NDF requirement.   

4. Effective fiber and energy.  Add grains (concentrates) to make up most of the remaining 
predicted DMI (leave ~2% of predicted DMI for mineral and vitamin supplements).  
• Adjust forages and grains to meet Effective NDF and NEL requirements (just 

substitute in one for the other on a pound for pound basis).  It may be impossible to 
do both–in such case, make sure diet has adequate effective fiber as the first 
priority.  Being short on energy means the cow will mobilize body reserves, which 
is okay for awhile.   

• If you want to try some fat, include that in the grain portion.  But recognize that the 
cow may eat less than predicted if you add fat, especially oils.  You can track fatty 
acid fractions in the lipid tab.   

• You may want to examine other indicators of fiber and energy nutrition as checks.  
For fiber, you can examine NDF, ForNDF, and EfNDF; for energy, examine NEL, 
NEL01, NEL89, or ME, ME01, and ME89.  For heifers, examine NEm, NEg, or 
ME alternatives.  The three systems (Spartan 3, NRC 2001, and NRC 1989) will 
give slightly different estimates of the diets energy availability.    

5. Protein. Balance the concentrates to meet the Crude Protein and/or Metabolizable Protein 
requirements.   
• For every pound of protein supplement included, take out a pound of grain.   
• If you first balance for CP, then check to see if the MP requirement is met (the RUP 

and digestible RUP requirements will give the same info).  Replace some of the 
protein supplement with a high RUP supplement if needed.   

• Make sure the RDP requirement is met.  A shortage of RDP will decrease microbial 
protein yield, and therefore increase the requirement for RUP.   

• You may want to examine MP01 as another check on the diet.   
• Check amino acids.  It is okay if they are a bit short – even 10 to 20% short is 

probably okay, especially if MP is higher than needed.   
6. Minerals and vitamins.  Add minerals and vitamins last because their supplementation 

(especially for Ca and P) depends on the feeds used to meet fiber, energy, and protein.   
• Be sure to use the mineral and vitamin supplements that are actually available on 

the farm.  If you have a feed tag with nutrient specifications, copy these into the 
Spartan program.  Remember that feed tags usually report nutrients on an as-fed 
basis and that Spartan data is on a dry matter basis.  For dry mineral supplements 
(98% DM), this distinction is not important.     

• Note that most minerals can be considered on both a total and an absorbed basis.  
Both bases may be useful.  For some minerals, such as Na, K, or Cl, the absorption 
coefficients are so high that the absorbed basis was deemed to add no value.    

• Note that most feeds in the Spartan 3 libraries do not have values assigned for 
concentrations of trace minerals and vitamins.  This is because the concentrations 
vary considerably depending on soil type and other factors.  If you have values 
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from a good feed analysis, you should go ahead and include those concentrations 
for the feed.   

• We recommend that TM and vitamins be added to diets so that the supplement is at 
least 50% of the total requirement.  For some TM and vitamins, such as Se, meeting 
the requirement is so beneficial that you should meet 100% of the requirement with 
the supplement.   

• Pay special attention to Se, which has a maximum legal limit on inclusion.   
• If a complete min/vit supplement is used, add it to meet the Se reqt and then inspect 

everything else  
• If separate supplements are used, add them in a systematic order.  First balance for 

P, then Ca, then other macrominerals, then trace minerals and vitamins.  For 
example, you might first add dicalcium phosphate to meet P requirement, then add 
limestone to meet Ca requirement, add salt to meet Na requirement, use a TM 
supplement to meet Se requirement, and finally add a vitamin supplement to meet 
vit A or E. 

• After you are finished adding mineral and vitamin supplements, check the mineral, 
trace mineral, and vitamin tabs to ensure that all mineral and vitamin are adequately 
supplied.    

7. Go back and check everything one last time. A completed ration may look like this.  Note 
that NEL and CP are not met with this ration.    

   
8. Evaluate the actual response to this new diet by monitoring feed intake and milk yield and 

then fine tune the diet accordingly.   
9. DM content of silages should be checked regularly. 
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 Strategies for Improving Management  
  Tracking Costs 

Changes in the cost of feeds may necessitate a change 
in ration composition.  At present, Spartan 3 does not 
include an optimizer to help determine the most cost 
effective diet.  The specifications and model for an 
optimizer are ready to be put into code but we do not 
know if or when that may happen.  However, one way 
to consider the relative value of feeds is to simply 
examine the cost per unit energy.  You can obtain the 
cost per Mcal ME with the Feeds > Feed 
Relationships command or Shift+Ctrl+R.  For feeds 
with similar protein to energy ratios, the ones that are 
cheapest per unit energy are often the best value.  See our website for additional MS Excel 
worksheets that can help you compare feeds for their relative values.   
 
However, no computer model or optimizer can consistently and accurately estimate the effect 
of different feeds on intake, partitioning, and milk production.  The response to a ration is 
almost always more important than the actual cost of the feeds in the ration.    

     
  Tracking %DM of Wet Forages 

The % dry matter of wet forages should be evaluated regularly.  Establish a routine so that 
each wet forage is sampled and analyzed once a week.  A Koster tester or microwave can be 
used effectively.  If the %DM changes, the ration does not necessarily need to be reanalyzed 
and reprinted; the Batch Report can be used to make adjustments to the recipe for a batch of 
feed.   
 
Computer vs cow.   
As with any computer program, the cow should be the judge of nutritional adequacy.  
Evaluate the actual response to a diet change by monitoring DMI and milk production and 
estimating energy intake and adequacy.  Then fine tune the diet accordingly.  Body condition 
is helpful too but takes longer to evaluate.  The DM content of wet feeds should be checked 
regularly.  
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Chapter 10 
Reports 

 
The Spartan 3 report generator is the 5th command of the ration worksheet menu.  You can print 3 
different types of reports.  Mix reports show the composition of feeds within a mix to be used for 
making up the mix.  Batch reports show a recipe to be used on the farm when making up a batch of 
feed.  Office reports show general information and 
nutrient specifications for a ration and show a column 
data for every feed.  A summary report gives only a 
summary of the office report.  These reports can be 
viewed on your computer monitor or printed.    
    
Note: Although you can work with several rations or libraries at one time, the 
Reports command is not available if more than one file is open.  To generate a 
report, you must first close all ration or library files except the one you want to print.   
 
Customizing Reports 
Reports can be customized to include who prepared it and who it is prepared for, a logo, a diet 
name, and some notes about it.  After choosing a report, such as a summary report with the Reports 
> Summary Report command or the Summary Report toolbar button, a dialog will appear for 
modifying report settings.  Note that the 
tabs visible across the top of this dialog; 
these tabs can be used to customize 
reports.  In the General tab, enter names 
and addresses in the “Prepared for” and 
“Prepared by” fields.   
 
Note: We also planned that you would 
be able to select a logo to be printed on 
the report and be able to print notes for 
the reports.  However, the database 
image component of the report generator 
does not function properly.  The only 
option we can give you is to print on to 
paper that already has the logo in the 
appropriate place of the report.  
  
Printing Reports 
To print a report, press the Print button from Modify Report 
Settings dialog.  If you simply press Okay button, nothing will 
happen.  Upon pressing Print, a dialog will appear giving Output 
Options.  If you want to edit Settings of the printed report, 
choose the Setup button.  In the Print Setup dialog, you can 
select a printer and choose properties for the printer using 
standard Windows features.  If you would like to generate an 
electronic report and have a PDF writer, choose Adobe PDF as 



Spartan Dairy Help Manual Michigan State University Page 95 

the printer.  You can also save the file as a Rave Snapshot file and download a free viewer for that 
program.  To preview the report before printing, select the Preview radio button for report 
destination on the Output 
Options dialog.  Once you 
are in the Report Preview, 
you can select pages to 
view and either print the 
file or close the Preview.  
The top of a preview is 
shown to the side.   

  
Mix Report    
Print this report to get a recipe for making a mix and to get the nutrient characteristics of the mix.  
Using the Mix Settings tab of the Modify Report Settings dialog, you can edit the name of the mix, 
the batch size of the mix, and the mixing order.   

 
Batch Report    
Print this report to get a recipe for making a 
batch of the ration on farm.  This report will 
give several versions of the recipe so that 
you can make different amounts of the total 
ration.   
 
Using the Batch Settings and Mixing Order 
tabs of the Modify Report Settings dialog, 
you can edit the location name where the 
batch will be fed, the number of animals in 
the group, the mix, the batch size of the mix, 
and the mixing order.   
 
Errors in Printing Batch Reports: You may discover errors in the program when using the Batch 
Report.  If you change the number of animals in a group in the Batch Report Settings dialog, the 
new number may not be updated on the ration worksheet.  Instead you may need to change number 
of cows using the menu command Ration > Group Info.  If you have several wet feeds, you may 
find the Batch Report generates thousands of pages.  This error has been difficult for us to track, but 
it especially seems to occur if you have a ration with several wet feeds and make changes to feed 
dry matter concentrations in the worksheet.  To work around it, you may need to delete water as a 
feed ingredient (if it was included), and you might try changing the %DM first in the library.   
 
Summary Report    
Print this report to get a summary of a ration.  It should print on 2 pages, unless you have more than 
about 10 feeds in the ration.   You may choose to print only page 1 in the print settings.  
 
Office Report 
Print this report to get a full report of a ration containing all feeds and all characteristics for each 
feed.  It likely will take 6 to 8 pages to print this report.    
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Chapter 11 
User Settings 

 
Use this command of the ration worksheet menu to set parts of the program to your preferences.   
 
General Settings    
• Changing Measurement Systems: Decide whether to have lb or kg and Mcal or Mjoule be the 

default measurements for your program.  Decide whether the ration summary should be on an 
amount per day or on a concentration basis.    

• Selecting a User Data Folder: Select the starting folder for user data when you open the program.   
• Managing User Data: Select options for the Transcript window of the program.   
 
User Defined Columns    
• User Defined Column Formats: Select formats including captions and measurement units for the 

blank columns of the Misc tab.     
 
Resetting Column Order 
Choose Settings>Column Order to revert to the default order for the program.   
   
Editing Decimal Places 
Choose Settings>Decimal Places to alter the number of visible decimal places for each column in 
the main grid and in the ration summary grid.   
 
Customizing the Nutrient Balance Graph 
Choose Settings>Nutrient Balance Graph to change which nutrients are shown and the scale for 
the horizontal axis.  You can also right click on the graph or press the  button.   
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Chapter 12 
Nutritional Model 

 
Model Overview 
The Spartan Dairy 3 program includes the energy and protein system of the 2001 NRC, the energy 
and RUP references from the 1989 NRC system, and our own modifications of the 2001 NRC.  
These modifications are referred to as the Spartan 3 system or model.  This model will be described 
in  detail on our website: www.spartandairy.msu.edu.  Some key features of the Spartan 3 model 
that are different from NRC 2001 are:  
 
General 
• Requirements are based on body weight adjusted for body condition and gestation.   The 

acronym for this adjusted body weight is BWNP3 or NP3BW.  See “Understanding Animal 
Weights” in chapter 8.   

• DMI intake prediction is driven by energy-corrected milk, not fat-corrected milk, and includes 
components for target gain and pregnancy.  In addition, the DMI prediction for all animals uses 
BW to the 0.75 power, unlike NRC which is inconsistent.   

• In cases where NRC used a combination of formulas and fixed value for nutrient columns, 
equations were derived to approximate NRC.  

• Fat and carbohydrate fractions can be monitored.  These include saturated, unsaturated, and 
estimated biohydrogenated fatty acids as well as starch, sugars, soluble fiber, and fermentation 
acids.   

• Effective NDF and Forage NDF are used and we consider them key characteristics in any ration 
evaluation or formulation.   

• Requirements for minerals and vitamins are essentially the same as in NRC 2001.  However, in 
some cases, the amount of a mineral or vitamin required per day is not altered by milk 
production or DM intake in NRC 2001.  Therefore, in the NRC model, cows with the highest 
energy and protein requirements and highest predicted intakes may require diets that are less 
mineral or vitamin-dense than lower producing cows.  In Spartan 3, the equations were edited 
so that the required concentration is not decreased for high producing animals.   

 
Energy submodel 
• Energy requirements in Spartan 3 are similar to those of NRC but include requirements for 

thermoregulation.  The energy requirement for pregnancy is a little higher, and the requirement 
for activity was altered. 

• The energy discount system was modified so it discounts digestibility less at high intakes.  It also 
allows for some byproduct feeds (high in NDF with short particle length) to be discounted 
more if the diet is low in forage fiber.  Read more about this in the energy section of Chapter 6. 

• The digestibility of NDF is a fixed value entered by the user rather than calculated based on 
%lignin.  The problem with using lignin to calculate NDF digestibility is that the relationship is 
not consistent across forage types and also is not consistent across season of harvest within a 
forage type.  

• The energy value of protein is lower (5.1 kcal/g digested protein compared to 5.6 for NRC 2001).  
The 5.6 value for NRC is technically correct but NRC does not adjust the efficiency of 
converting DE to ME based on the protein content of the diet and protein needs of the animal.  
Thus, NRC overvalues protein in its contribution to the energy value of diet and makes high 
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protein diets more attractive for high-producing cows.  Most cows capture only about 30% of 
the protein that is truly digested, with the remainder being broken into its carbon skeleton and 
used for energy and the amino group being converted to urea and excreted or recycled.  In 
losing the amino group, about 20% of the energy value of protein is lost.  Theoretically, this 
loss should occur in the conversion of DE to ME and be based on the expected capture of 
digested protein.  By using an energy value of 5.1 kcal/g for digested protein, Spartan 3 treats 
protein more fairly so that the energy value of a high protein feeds like soybean meal are 
similar to high starch feeds like corn.    

• The digestibility of NFC cannot exceed 100%, unlike the Processing Adjustment Factor of the 
2001 NRC.  Thus digested NFC is generally a little lower for Spartan 3 than for NRC.   

• NPN is subtracted from CP before calculating the contribution of protein to energy supply and 
before calculating NFC. 

• The digestibility of fat is assumed to be about 90% for most feeds whereas NRC assumes it is 
100%.   

• Output of the protein submodel is used to determine the contribution of protein to dietary energy 
supply.  Rather than using NDICP and ADICP as in NRC, Spartan calculates true protein 
digestibility from RDP, digested RUP, and NPNCPE.   

• The contribution of activity to energy requirements is less mechanistic and more practical.  NRC 
uses equations based on distance traveled and whether or not a pasture is “hilly” to predict 
energy expenditure; the equations are precise but the inputs are subjective.  Our method 
acknowledges the imprecision of calculating work energy.   

• Environmental temperature stress can be included to alter requirements.  
• The energy requirement for late pregnancy includes a requirement for an increase in BW due to 

tissue gain of the mammary gland.  Experiments with dry cows consistently show that cows 
can be losing body condition in the last 3 wk of gestation while at the same time eating to meet 
NRC requirements for maintenance and pregnancy.  Thus, unlike NRC 2001, Spartan assumes 
some BW gain of the cow (NP3BW) is necessary in the last 3 wk before calving, and this 
typically increases the NEL requirement by 3-8 Mcal/day.  

 
Protein submodel 
• Spartan 3 has a CP requirement, but this can be ignored if one chooses to balance on MP, RUP 

and RDP.   
• Requirements for MP in Spartan 3 were increased for pregnancy by including mammary gain and 

were increased for other situations that increase energy requirements so that the protein to 
energy ratio remains reasonable when energy requirements increase due to temperature stress 
or activity.   

• In the Spartan 3 model, less RDP is needed to produce microbial protein than in the 2001 NRC 
model.  Thus, the RDP requirement is usually slightly lower and the N-potential microbial 
protein supply is slightly greater.  This is because we assume that RUP contributes to the 
availability of ruminal N by recycling, similar to the 1989 NRC and unlike the 2001 NRC.   

• In both systems, the supply of fat-corrected TDN1X is used to predict the energy-potential  
microbial protein yield with the same coefficient of 0.13 kg MCP/kg of fat-corr TDN1X.  
However, the fat-correction is less in Spartan 3 than in NRC 2001.  Without a fat-correction, an 
easy way to increase microbial protein yield would be to add fat, which has 2.25 times the 
TDN value of carbohydrates and proteins.  NRC subtracts all the energy of fat in predicting 
microbial protein yield (2.25 X), whereas Spartan 3 subtracts only the extra TDN of fat.  In 
other words, we assume that adding fat in place of carbohydrate will have no impact on 
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microbial yield.  Thus, the Spartan 3 Metabolizable Protein (MP) supply will usually be 
slightly greater than that of the 2001 NRC Metabolizable Protein (MP01) supply.  

• The supply of methionine and lysine use a purely summative approach rather than the regression 
approach of NRC.  So lysine supply is the sum of lysine from digested RUP and from digested 
microbial true protein.   

 



Spartan Dairy Help Manual Michigan State University Page 100 

Chapter 13 
Using the Transcript Window 

In Spartan 3, all equations and assumptions in working with the program can be examined using the 
Transcript Window.   

The Transcript Window can be 
used to visualize variable values as 
they are calculated by the program. 
You can also display the equations 
used to calculate each variable. All 
text in the transcript is editable and 
can be copied to the Windows 
clipboard for pasting into other 
applications. For permanent record 
keeping the entire contents of the 
transcript window can be saved to a 
file at any time. Or, the transcript’s 
recording feature can be used to 
write transcript information to a log 
file as it is displayed in the 
transcript window. 

Variable values are presented using the measurement systems (kg or lb) and decimal place settings 
you have selected. So if you change these settings, those changes will be reflected in subsequent 
transcript output.                                                                                             
 
Use the mouse to left click and drag on the window’s title bar to move the window to a different 
location on the screen. The Transcript Window is resizable. Use the mouse to left click and drag on 
window edges to resize the window.  Click on the icons in the upper right corner of the window to 
minimize, maximize, or close the window.  
 
Access transcript commands using the Transcript Window’s main menu. These commands are 
explained in the following help topics: 
• Saving a Transcript to Disk  
• Printing a Transcript  
• Editing a Transcript  
• Searching a Transcript  

• Changing Transcript Text Font and Size  
• Transcript Window Always on Top  
• Recording a Transcript Session 
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All transcript output settings, including whether or not the 
transcript window is displayed, can be changed in the 
program’s General Settings dialog. The General Settings dialog 
is also where you specify which categories of variables and/or 
equations to output to the transcript window. This portion of 
the General Settings dialog is shown below: 

Note:  Using the Transcript Window’s close icon  to 
close the Transcript Window will uncheck the Display Transcript Window checkbox in the 
General Settings dialog. 

Transcript Outputs can only be changed when the Display Transcript Window checkbox is 
checked. The program outputs hundreds of different variables and equations to the transcript. The 
sheer volume of this information can be overwhelming, so we suggest you limit the amount of 
information displayed at any one time to one or two categories of transcript outputs. 
• Animal information: Variables modified using dialogs in the program’s Animal submenu 

including the animal description, daily gain and pregnancy, environmental factors, and feed 
additives dialogs. This category includes all animal based nutrient requirements.  

• Nutrient composition: Variables that describe the nutrient composition of a feed, such as %DM, 
NDF, NEL, MP, RUP, etc. About 1/3 of the feed characteristic columns in the ration worksheet 
are not input by the user, but are calculated from other inputs.  

• Nutrient amounts: Variables tracking the amount of each nutrient contained by each feed. 
Changing the composition or amount of one feed in a ration can change the amounts of nutrients 
in other feeds. This occurs because some nutrient characteristics are calculated based on whole 
ration characteristics. For example, the amount of energy available from a feed depends on the 
total amount of feed consumed.    

• Ration summaries: Variables used in the calculation of whole ration nutrient summary 
information on a composition and amount basis. A few characteristics, such as metabolizable 
protein, are only calculated on a whole ration basis.  

• Debug variables: These checkboxes turn on/off transcript outputs that are still being used to test 
the program. This item will be removed in the finished product.  

See Transcript Equation Syntax for help on understanding equations.   

Saving a Transcript to Disk 
 
The contents of the transcript window can be saved to disk. The file is saved in rich text format 
using the extension .rtf. This is a generic text format that is readable by word processing software, 
and by Windows Notepad. 
 
To specify a filename to use when saving the file, select Transcript 
> Save As from the Transcript Window’s main menu. 

 
A standard MS Windows Save As dialog appears. This dialog 
allows you to browse to the folder where you want to save the 
transcript, and to specify a filename. To save the file, select Save. The dialog remembers the 
filename and folder you specified, and will use them the next time you launch the Save As dialog. If 
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you select Cancel, no file is written to disk, and any directory or filename changes you made in the 
dialog are discarded. 
 
If you do not need to change the filename or folder, you can simply select Transcript > Save from 
the Transcript Window’s main menu to save the entire contents of the transcript to disk using the 
current directory and filename. The keyboard shortcut for Save is Ctrl+S. 

 
Note:  The default name of the transcript file is “transcript.rtf”. By default transcripts are saved to 
your current working directory. This is typically the same folder where your rations and feed 
libraries are stored. 

Printing a Transcript 

You can print either the entire contents or only a portion of the transcript. To print the transcript 
select Transcript > Print from the Transcript Window’s main 
menu. The keyboard shortcut to print a transcript is Ctrl+P. 

A MS Windows Print dialog will appear allowing you to select a 
destination printer.   

If you selected a portion of the transcript before launching the Print dialog, you can print only the 
selected text, or the entire transcript. To only print the selected text, answer Yes to the Confirm 
dialog shown below. This dialog will not appear if no text was selected when you launched the print 
dialog. 

Editing a Transcript 

The contents of the Transcript Window are fully editable. The window itself is a rich text editor. 
Editing commands can be accessed using the Transcript Window’s Edit submenu. The Transcript 
Window supports cutting, copying, and pasting selected text to/from the Windows clipboard. You 
can easily use copy/paste to export transcript information to other applications such as MS Word 
and Excel. Transcript edit commands use standard Windows keyboard shortcuts. For easy reference, 
supported keyboard shortcuts are listed on the Edit submenu to the right of commands. 

The Erase Transcript command erases the entire contents of the transcript window. This provides 
a quicker solution than the two step process of Select All | Delete.   

You can search for text in transcript contents using Edit > 
Find. This feature is covered in the Searching a Transcript 
help topic. 

Many of the editing commands are also available from a 
popup menu. To launch the editing popup menu shown below, 
right click anywhere in the transcript window.   
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Searching a Transcript 

You can easily search for text in a transcript. Select Edit > Find from the Transcript Window’s 
main menu.  The Find dialog shown below appears. Enter the desired text in the Find what box. If 
you want to only search for matching whole words, check the Match whole word only box. 
Similarly, if you only want to search for text that matches specific case (upper and/or lower) of your 
search string, check the Match case box. 

When you are ready to start searching, 
click Find Next. The Transcript Window 
cursor will move to the first location that 
matches your search string. To find the 
next place in the transcript that matches 
your search string, click Find Next again. 
You can do this repeatedly to search through the entire transcript. If the cursor position does not 
move when you click Find Next, there are no more matches in the transcript. 

NOTE: Searching is always performed downwards from the beginning of the transcript. 

Changing Transcript Text Font and Size 

The text font and size used in the Transcript Window is changed 
by selecting Format > Text Font and Size from the Transcript 
Window’s main menu. 

Changes to text font and size are applied to any text selected when the dialog is launched, and to 
new text added after the dialog is completed. Selecting Cancel to end the dialog results in no font 
changes to the transcript. 

Note:  The default setting for transcript text is Arial 10pt. 

Transcript Window Always on Top 

The Transcript Window style can be changed so this window always 
appears on top of other windows on your desktop. To change this 
window style, select View > Always on Top. The menu item is an 
on/off toggle. If a check appears before Always on Top, it is turned 
on. 

Select View > Always on Top a second time to turn it off. This state is 
shown below. 
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Recording a Transcript Session 

Program transcripts, or portions thereof, can be recorded directly to a rich text format (.rtf) log file. 
Text comments you add to the transcript will not be included in the log, it will only contain text 
directed from the program to the transcript. As each new line of information is received by the 
Transcript Window, the log file is opened, new information is appended to the end of the file, and 
the file is closed. This process ensures that transcript information is retained in a log file even if the 
program suffers a fatal error. 

To begin recording a transcript to a log file, select Recording > Begin 
from the Transcript Window’s main menu. 

A Windows Save As dialog will appear, prompting you for a location 
to save the log file to.   

To suspend writing transcript information to the log file, select Recording > Suspend from the 
Transcript Window’s main menu. The Suspend option is only enabled when a transcript is being 
logged. 

Once transcript recording has been suspended, a Resume option is enabled. To resume logging a 
transcript session, select Recording > Resume from the Transcript Windows’s main menu. 

Finally, to end logging a transcript session, select Recording > End from the Transcript Window’s 
main menu. 
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Chapter 14 
Configuring the Program for Your Needs 

 
Setting Farm Specific Inputs  
Farm specific inputs would include information for reports on farm name and contact info as well as 
feed library info, especially forage feeds.  We suggest making a template ration for a farm and using 
that ration as the base for making new diets.  Once a ration has been created, it would be best to 
always use that ration as the starting point for any new diet.  Whenever you make a new diet, it is 
reasonable to start by saving it with a new name, such as “High cow 2010-4-25”.   
    
Organizing and Managing Your Data  
The default folder for Spartan 3 data is called Spartan Dairy 3 within My Documents on your 
computer hard drive.  There are many ways to organize files.  One option if you have several farms 
that your work with would be to organize farm specific data files each in a separate folder and then 
to keep some library files that are used across these farms either in the root Spartan Dairy 3 folder 
or in a separate library folder.  Your folder organization could look like the following. 
 
 
 
 
 
 
 
 
 
  
   
 
 
 
 
 
 
 
Using Spartan Dairy to Manage Multiple Farms     
  Best Practices for Managing Multi-Farm Data: Keep data in separate folders as shown above. 
  Sharing Data with Clients: Send files to clients and encourage them to change %DM weekly 

for wet feeds.   
   
Using Spartan Dairy in the Classroom     
You can find resources for using Spartan 3 in teaching on our website.   
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Chapter 15 
Troubleshooting 

 
Although Spartan Dairy 3 has been tested extensively, bugs or problems may still occur.  A few 
minor problems have persisted despite several attempts to fix them.  All known glitches can be 
worked around.  If you experience problems that cannot be resolved, please contact us at 
spdairy@msu.edu or see our website for more information.  We appreciate your patience as we seek 
to improve the program.   
 
Known problems include: 
• Program seems locked when working in spreadsheet.   Occasionally the program seems 

locked.  This usually happens when saving a file or when entering data quickly.  The program 
may be doing work that is not obvious so if you give it a minute, it will eventually allow you to 
work again.  Sometimes just switching to another tab and coming back, or hitting the tab key, 
will allow you to work again.  In more severe situations, blanks may even appear in the column 
cells.  Because the data all exists in database files, the data itself is usually not lost but is not 
appearing correctly.  If the file was recently saved, just close the file or exit the program.  If not, 
try saving the file and reopening it.  The data might be fine.  We apologize that crashes 
occasionally occur and ask your patience—please note that even programs like MS Word or 
Excel occasionally crash.   

 
• Program seems locked when working in animal description dialogs.  Occasionally you may 

have trouble moving from one cell to another to enter new data.  Generally in the animal 
description dialogs, you are better off using the Tab key to move around than the mouse clicker.  
If you have a problem, just try a combination of tab and enter keys and it will usually allow you 
to make your edits.   

 
• The  button does not minimize a mix.  This is a problem that we may have resolved.  If you 

simply click somewhere on the mix row or on another feed row, the mix will minimize.  You 
may need to do this twice.   

 
• Logos and notes do not work in the Report generator and printer.  Although we tried to enable 

you to put your own logo on reports and to write notes in the reports, the database image 
component of the report generator does not function properly.  Whether they work or not is still 
not certain.  We apologize for this.  The only option we can give you is to print on to paper that 
already has the logo in the appropriate place of the report.  

 
• The measurement systems boxes  disappear.  Occasionally you 

may notice these buttons disappear as you work with the program.  Do not be alarmed.  Usually 
just resizing the window will make them appear again.   

 
• The reports generator is not accessible so I can’t print reports.  Although you can work with 

several rations or libraries at one time, the Reports command is not available if more than one 
file is open.  To generate a report, you must first close all ration and library files except the one 
you want to print.   
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• Errors in Printing Batch Reports: You may discover errors in the program when using the 

Batch Report.  If you change the number of animals in a group in the Batch Report Settings 
dialog, the new number may not be updated on the ration worksheet.  Instead you may need to 
change number of cows using the menu command Ration > Group Info.  If you have several wet 
feeds, you may find the Batch Report generates thousands of pages.  This error has been 
difficult for us to track, but it especially seems to occur if you have a ration with several wet 
feeds and make changes to feed dry matter concentrations in the worksheet.  To work around it, 
you may need to delete water as a feed ingredient (if it was included), and you might try 
changing the %DM first in the library.   

 
Problems we believe are resolved include: 
• Column positions become 

uncoupled.  Often when moving 
columns, the column being moved 
will become uncoupled so that its 
placement in the bottom ration 
summary grid is not the same as in 
the main feed composition grid.   
Sometimes selecting another tab 
and coming back will fix the 
problem, although the new order might be that of the summary grid and not that which you 
selected for the main grid  This problem is best remedied by setting up a template file that you 
use for your normal column order and then always starting with that file and just changing the 
cow description and feeds as needed.  To be sure you get the desired column order, select 
columns and move each to the starting position in reverse order.  In other words, start by 
selecting the column you want to see on the right of a screen and move it all the way to the left 
position.  Then select the column you want immediately to its left and move it to the starting 
position.  Continue this and finally, as the last step, select the column you want in the starting 
position.  This works every time.  The favorite column order might look like this:   

  
• Extra blank space appears  in a column.  Occasionally, when clicking on a column heading or 

trying to move columns, an extra column that is blank or extra width will be given to a column.  
If this happens, no data is lost.  Merely clicking on another tab and then coming back to the tab 
in which you were working will fix the problem.  If necessary, you could save the file, close it, 
and then retrieve it.   
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Chapter 16 
Tutorials 

 
All tutorials can be found on our web site and are no longer included in this manual.   
 
These include:    

• Evaluating an existing ration and rebalancing it   
• Creating a Ration from Scratch     
• Creating a Feed Library for Your Farm     
• Using Feed Test Analysis Results 
• Using feed tags to create a new feed        
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